OpenEdge® Development:
Progress Dynamics® Administration
# Contents

<table>
<thead>
<tr>
<th>Preface</th>
<th>Preface–1</th>
</tr>
</thead>
</table>

## 1. Overview of Progress Dynamics Administration

- Tasks for Progress Dynamics administrators .................................................. 1–2
- Tools for Progress Dynamics administration ...................................................... 1–3
  - Application menu .......................................................................................... 1–3
  - Deployment menu .......................................................................................... 1–4
  - Security menu ................................................................................................ 1–5
  - Session menu .................................................................................................. 1–6
  - System menu ..................................................................................................... 1–7
  - Transaction menu ............................................................................................ 1–8

## 2. Defining and Managing Sessions

- Defining a Progress Dynamics session ................................................................. 2–1
- Predefined session types ...................................................................................... 2–2
- Starting a Progress Dynamics session ................................................................... 2–5
  - How sessions start .......................................................................................... 2–6
- Configuring a Progress Dynamics session ............................................................. 2–8
  - Overview of session configuration tasks .......................................................... 2–8
  - Defining session services .................................................................................. 2–9
  - Creating session properties .............................................................................. 2–14
  - Defining managers ........................................................................................... 2–15
  - Creating a new session type ............................................................................. 2–15
  - Generating the configuration file ...................................................................... 2–15
  - Using minimum XML files ................................................................................ 2–25
  - Creating a shortcut icon to start a session ....................................................... 2–26
  - Importing a configuration file .......................................................................... 2–28
- Defining user profile data for a session ............................................................... 2–29
  - Defining user profile data ................................................................................. 2–29
  - How a session uses profile data ........................................................................ 2–29
  - Defining user profiles ....................................................................................... 2–30
3. **Setting Up Basic Security Options** ........................................ 3–1
   Setting global security and management options .................. 3–2
   Choosing a security model: grant or revoke ....................... 3–4
      Revoke model ......................................................... 3–4
      Grant model ......................................................... 3–4
   Setting up user authentication ........................................ 3–6
      Defining user categories ......................................... 3–6
   Defining login companies ............................................. 3–8
   Defining security groups ............................................. 3–10
   Creating and maintaining users ..................................... 3–17
      Setting a user’s password ........................................ 3–19
      Defining a user as a profile user ................................ 3–19
      Linking users and security groups .............................. 3–21

4. **Supporting Built-in Application Features** ............................ 4–1
   Specifying gapless sequences ........................................ 4–2
      Sequence Control window ....................................... 4–2
      Sequence Maintenance window ................................ 4–3
   Defining languages, countries, nationalities, and translations .... 4–4
      Language Control window ....................................... 4–4
      Language Maintenance window ................................ 4–5
      Country Control window ....................................... 4–5
      Country Maintenance window ................................ 4–6
      Nationality Control window ................................... 4–6
      Nationality Maintenance window ................................ 4–7
      Setting translation preferences ................................ 4–7
      Translation Control window .................................... 4–8
      Translation Maintenance window ................................ 4–8
   User run-time translations with the Translate Window ............ 4–9
      Menu translations .................................................. 4–10
      Entity translations ................................................ 4–11
      Testing the new translation ..................................... 4–13
   Adding generic database comments and auditing .................. 4–14
      Generic comments .................................................. 4–14
      Generic auditing .................................................... 4–17
   Specifying multi-media types ....................................... 4–20
      Multi Media Type Control window .............................. 4–20
      Multi Media Type Maintenance window ......................... 4–20
   Defining application categories .................................... 4–22
      Category definition structure .................................. 4–22
      Category Control window ....................................... 4–23
      Category Maintenance window ................................ 4–24
   Maintaining user-defined status information ...................... 4–25
      Progress Dynamics’ status mechanism ......................... 4–25
      Information on adding status tracking ......................... 4–25
      Status Control window .......................................... 4–26
      Status Maintenance window .................................... 4–26
   Exporting data through Print Preview ................................ 4–27
      Setting session properties ....................................... 4–27
      Using Print Preview .............................................. 4–29
5. **Extending the Progress Dynamics Configuration Utility** ................................................. 5–1
   Planning ahead ......................................................................................................................... 5–2
   Progress Dynamics Configuration Utility overview .............................................................. 5–4
   Advantages of the DCU .......................................................................................................... 5–4
   How the DCU differs from a Progress Dynamics session ...................................................... 5–5
   DCU interface .......................................................................................................................... 5–6
   Deployment stages .................................................................................................................. 5–9
   Phase 1 and Phase 2 processing stages .................................................................................. 5–10
   Logging for Phase 1 and Phase 2 ............................................................................................. 5–11
   DCU processing sequence ....................................................................................................... 5–11
   Picking the correct processing stage ....................................................................................... 5–12
   DCU XML files ...................................................................................................................... 5–13
   DCU driver files .................................................................................................................... 5–14
   Upgrade files .......................................................................................................................... 5–20
   DCU API .................................................................................................................................. 5–24
   analyzeCase .......................................................................................................................... 5–24
   analyzeSelf ............................................................................................................................ 5–25
   btnChoose ............................................................................................................................. 5–25
   checkForDB ........................................................................................................................... 5–25
   connectDatabase .................................................................................................................. 5–26
   eventProc .............................................................................................................................. 5–26
   getDBFile .............................................................................................................................. 5–27
   getDirectory .......................................................................................................................... 5–27
   gotoPage ............................................................................................................................... 5–27
   obtainICFSeqVals .................................................................................................................. 5–28
   obtainPatchList ..................................................................................................................... 5–28
   processParams ..................................................................................................................... 5–28
   restoreProperties .................................................................................................................. 5–29
   screenScrape ......................................................................................................................... 5–29
   startUpgradeProcess ............................................................................................................ 5–29
   validateDirectory ................................................................................................................... 5–30
   validateSiteNumber ............................................................................................................... 5–30
   verifyDBVersion .................................................................................................................... 5–30
   Creating a customized DCU deployment ............................................................................... 5–31
   Prepare schema and data files .............................................................................................. 5–31
   Designing upgrade programs ................................................................................................. 5–32
   Upgrade program attributes ................................................................................................. 5–33
   Setting up new databases with the DCU ............................................................................... 5–33
   Upgrading existing databases with the DCU ........................................................................ 5–38
   Tips for customized DCU sessions ....................................................................................... 5–40
   Starting the DCU .................................................................................................................... 5–41
   Running the DCU in batch mode ........................................................................................... 5–42
   Generating the batch-mode data ............................................................................................ 5–42
   Creating a batch-mode DCU script ....................................................................................... 5–43
   Dumping and loading site-specific data .................................................................................. 5–47
   Site Data Dump and Load utilities architecture ................................................................... 5–47
   Setting up the utilities ............................................................................................................ 5–48
   Writing a dump program ....................................................................................................... 5–49
   Writing a load program ......................................................................................................... 5–51
   Creating a dumpconfig.txt file ............................................................................................. 5–53
   Using the GUI ......................................................................................................................... 5–55
   Calling the Utility from the DCU ........................................................................................... 5–56
A. Using OpenEdge DataServers with Progress Dynamics ........................................... A–1
   Overview ............................................................................................................. A–2
      Progress Dynamics support for DataServers .......................................................... A–2
      When to use DataServers with Progress Dynamics ............................................. A–2
      Requirements for DataServers in Progress Dynamics .......................................... A–2
   Connecting the database ....................................................................................... A–3
      Configuring OpenEdge DataServer for MS SQL Server ...................................... A–3
      Configuring OpenEdge DataServer for Oracle ................................................... A–4
      Schema holder database .................................................................................... A–5
      Progress Dynamics configurations with DataServers .......................................... A–5
   Programming considerations ................................................................................. A–6
      Indexes ................................................................................................................ A–6
      Two-phase commit ............................................................................................. A–6
   Other useful documentation ................................................................................. A–7

B. Progress Dynamics Session Properties ............................................................ B–1

C. Inside the Progress Dynamics Configuration File .............................................. C–1
   Session configuration nodes .................................................................................. C–2
      <properties> node ............................................................................................ C–2
      <services> node ............................................................................................... C–3
      <managers> node ............................................................................................. C–4

D. Deployment Notes .............................................................................................. D–1
   Deploying multi-transaction sequences ................................................................ D–2
   Generating static-ABL equivalents of dynamic objects........................................ D–3
      Mechanisms for static object generation ............................................................. D–3
      Saving dynamic objects as static objects ............................................................. D–5
   Generating ABL for dynamic objects as static objects ........................................ D–7
   Generated-ABL object execution and file naming ............................................... D–11
   Deploying generated-ABL static objects .............................................................. D–13
   Development impact using generated-ABL objects ............................................ D–14
   Deploying Repository objects between versions ................................................ D–16
      Cross-version deployment situations ................................................................. D–16
      Support for cross-version deployments ............................................................ D–16
      Recommended procedure for deploying across versions .................................. D–17

E. Performance Notes ............................................................................................. E–1
   Configuring server and client startup options ..................................................... E–3
   Using static-ABL equivalents of dynamic objects ................................................. E–5
   Keeping SmartDataObjects alive on the server ................................................... E–6
      Configuring SDOs to remain alive ..................................................................... E–6
      Using SDOs kept alive on the server ................................................................ E–6
   Progress Dynamics lookup/combo (SmartDataField) cache ................................ E–8
      Cache operation ................................................................................................ E–8
      When the SmartDataField cache is not used ..................................................... E–9
      Enabling and disabling the SmartDataField cache ............................................ E–10
      Clearing the SmartDataField cache ................................................................ E–10
      Disabling cache usage for a specified SDF ....................................................... E–11
   Dynamic lookup mapped fields ......................................................................... E–13
      Benefits and constraints on mapping fields ..................................................... E–13
      Using mapped fields ....................................................................................... E–14
      Linking lookup fields directly to SDO fields on the viewer ............................... E–15
      Mapping lookup fields to SDO fields through viewer widgets ......................... E–17
      When Dynamics does not use mapped fields ................................................. E–20
Tables
Table 2–1: Predefined session types .............................. 2–3
Table 2–2: Logical service properties .............................. 2–11
Table 2–3: Qualifiers for the -icfparam startup parameter ........ 2–26
Table 4–1: Print Preview session properties ........................ 4–27
Table 5–1: DCU standard pages and their objects .................. 5–7
Table 5–2: DCU deployment stages ................................ 5–10
Table 5–3: Operators for conditional expressions ................... 5–17
Table 5–4: DCU procedure files .................................. 5–24
Table 5–5: DCU session properties ................................ 5–31
Table 5–6: Standard program properties ............................ 5–33
Table 5–7: Site Data Dump and Load installed files ................. 5–48
Table 5–8: Field options for creating the dumpconfig.txt file .. 5–53
Table B–1: Progress Dynamics session properties .................. B–1
Table C–1: Physical session types ................................ C–3
Table C–2: Manager static handle codes ............................ C–5
Table D–1: Determining the generated filename for a generated-ABL object .. D–12
Table D–2: Minimum files to deploy for generated-ABL static objects .. D–13
Table D–3: APIs for running generated-ABL static objects .......... D–15
Table E–1: Optimal settings for server or client startup parameters .... E–3
Table E–2: Column values for lookup field mapping directly to SDO ........ E–16
Figures

Figure 1–1: Administration main window ........................................ 1–3
Figure 1–2: Application menu ..................................................... 1–3
Figure 1–3: Deployment menu ..................................................... 1–4
Figure 1–4: Session menu options .............................................. 1–6
Figure 1–5: System menu .......................................................... 1–7
Figure 2–1: Session type inheritance .......................................... 2–3
Figure 2–2: Required Manager inheritance .................................. 2–18
Figure 2–3: Session property inheritance .................................... 2–20
Figure 2–4: Session services inheritance ..................................... 2–21
Figure 3–1: Security Control window ........................................... 3–2
Figure 3–2: Revoke model example ............................................ 3–11
Figure 3–3: Grant model example .............................................. 3–12
Figure 4–1: Sequence Control window ........................................ 4–2
Figure 4–2: Sequence Maintenance window ................................ 4–3
Figure 4–3: Language Control window ........................................ 4–4
Figure 4–4: Language Maintenance - New window ......................... 4–5
Figure 4–5: Country Control window .......................................... 4–5
Figure 4–6: Country Maintenance window ................................... 4–6
Figure 4–7: Nationality Control window ...................................... 4–6
Figure 4–8: Nationality Maintenance window ................................ 4–7
Figure 4–9: Dynamics Preferences .............................................. 4–7
Figure 4–10: Translation Control window ..................................... 4–8
Figure 4–11: Translation Maintenance - Administration window .......... 4–8
Figure 4–12: Translate Window for user run-time translations ............ 4–9
Figure 4–13: Translate Window with new translation ................. 4–9
Figure 4–14: Administration window with run-time translation ....... 4–10
Figure 4–15: Multi Media Type Control window ......................... 4–20
Figure 4–16: Multi Media Type Maintenance window ..................... 4–20
Figure 4–17: Multi Media Type Control window with new media type 4–21
Figure 4–18: Category Control window ........................................ 4–23
Figure 4–19: Category Maintenance window ................................. 4–24
Figure 4–20: Status Control window ........................................... 4–26
Figure 4–21: Status Maintenance window .................................... 4–26
Figure 4–22: Default Print Preview settings .................................. 4–28
Figure 4–23: Overriding Print Preview settings .............................. 4–28
Figure 5–1: Application design cycle .......................................... 5–2
Figure 5–2: DCU interface ........................................................ 5–6
Figure 5–3: Stand-alone GUI for Site Data Dump and Load utilities .... 5–55
Figure E–1: Disabling the cache for a specified SDF ....................... E–12
Figure E–2: PicClip file, toolclip.bmp .......................................... E–26
Contents

Procedures

icfsetup.xml ................................................................. 5–13
setup1000B.xml ............................................................ 5–14
Page example from setup1000B.xml .................................. 5–15
Cancel button from setup1000B.xml .................................. 5–15
Action linked to a page from setup1000B.xml ..................... 5–16
Back button from setup1000B.xml ..................................... 5–16
IF . . . THEN . . . ELSE conditional expression .................. 5–17
CASE conditional expression ....................................... 5–17
Fill-in field from setup1000B.xml .................................... 5–18
Database example from setup1000B.xml .......................... 5–19
icfdbbuild.xml ............................................................. 5–21
icfadb100002adolist.xml ............................................... 5–22
icfadb020026patch.xml ............................................... 5–23
Sample batch-mode DCU script ...................................... 5–46
gsmout.p sample using the default code ......................... 5–49
gsmout.p sample using customized code ....................... 5–50
gsmitin.p sample with user-supplied code for referential integrity .... 5–51
gsmitin.p sample with completely customized code ............ 5–52
dumpconfig.txt .......................................................... 5–53
This Preface contains the following sections:

- Purpose
- Audience
- Organization
- Using this manual
- Typographical conventions
- OpenEdge messages
- Third party acknowledgements
Purpose

This manual describes how to configure and manage Progress Dynamics®. It also describes a common set of administrative procedures that you might need to perform to support all of the applications that you develop using Progress Dynamics.

Audience

This manual is designed for Progress Dynamics programmers who have some familiarity with the OpenEdge® ADM.

Organization

Chapter 1, “Overview of Progress Dynamics Administration”

Describes the basic administrative tasks and tools.

Chapter 2, “Defining and Managing Sessions”

Describes how to create and configure Progress Dynamics sessions, which are runtime and development environments for applications.

Chapter 3, “Setting Up Basic Security Options”

Shows the requirements and how to install Progress Dynamics on your system and configure it for basic operation.

Chapter 4, “Supporting Built-in Application Features”

Describes how to prepare several application features that are partly or completely built into Progress Dynamics that you can set up to work in your own applications.

Chapter 5, “Extending the Progress Dynamics Configuration Utility”

Describes how to extend the Dynamics Configuration Utility (DCU) in order to deploy your own Progress Dynamics® applications, including information on running the DCU in batch mode and saving site-specific data during an application installation or upgrade.

Appendix A, “Using OpenEdge DataServers with Progress Dynamics”

Describes some of the factors you should consider when using a OpenEdge® DataServer™ in the Progress Dynamics environment.

Appendix B, “Progress Dynamics Session Properties”

Describes describes the Progress Dynamics session properties.

Appendix C, “Inside the Progress Dynamics Configuration File”

Describes the contents of the default configuration file to help you gain an understanding of what this XML file does.
Appendix D, “Deployment Notes”

Describes deployment features that supplement the features described in the deployment white paper posted on the Progress Software Developers Network® (PSDN) Web site (http://psdn.progress.com).

Appendix E, “Performance Notes”

Describes features that enable you to improve Progress Dynamics application performance, depending on your application design and deployment requirements.

Using this manual

OpenEdge provides a special purpose programming language for building business applications. In the documentation, the formal name for this language is ABL (Advanced Business Language). With few exceptions, all keywords of the language appear in all UPPERCASE, using a font that is appropriate to the context. All other alphabetic language content appears in mixed case.

For the latest documentation updates see the OpenEdge Product Documentation category on PSDN http://www.psdn.com/library/kbcategory.jspa?categoryID=129.

References to ABL compiler and run-time features

ABL is both a compiled and interpreted language that executes in a run-time engine that the documentation refers to as the ABL Virtual Machine (AVM). When documentation refers to ABL source code compilation, it specifies ABL or the compiler as the actor that manages compile-time features of the language. When documentation refers to run-time behavior in an executing ABL program, it specifies the AVM as the actor that manages the specified run-time behavior in the program.

For example, these sentences refer to the ABL compiler’s allowance for parameter passing and the AVM’s possible response to that parameter passing at run time: “ABL allows you to pass a dynamic temp-table handle as a static temp-table parameter of a method. However, if at run time the passed dynamic temp-table schema does not match the schema of the static temp-table parameter, the AVM raises an error.” The following sentence refers to run-time actions that the AVM can perform using a particular ABL feature: “The ABL socket object handle allows the AVM to connect with other ABL and non-ABL sessions using TCP/IP sockets.”

References to ABL data types

ABL provides built-in data types, pre-defined class data types, and user-defined class data types. References to built-in data types follow these rules:

- Like most other keywords, references to specific built-in data types appear in all UPPERCASE, using a font that is appropriate to the context. No uppercase reference ever includes or implies any data type other than itself.

- Wherever integer appears, this is a reference to the INTEGER or INT64 data type.
• Wherever decimal appears, this is a reference to the DECIMAL data type.

• Wherever numeric appears, this is a reference to the INTEGER, INT64, or DECIMAL data type.

References to pre-defined class data types appear in mixed case with initial caps, for example, Progress.Lang.Object. References to user-defined class data types appear in mixed case, as specified for a given application example.

Typographical conventions

This manual uses the following typographical conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Bold typeface indicates commands or characters the user types, provides emphasis, or the names of user interface elements.</td>
</tr>
<tr>
<td><em>Italic</em></td>
<td>Italic typeface indicates the title of a document, or signifies new terms.</td>
</tr>
<tr>
<td>SMALL, BOLD CAPITAL LETTERS</td>
<td>Small, bold capital letters indicate OpenEdge key functions and generic keyboard keys; for example, GET and <strong>CTRL</strong>.</td>
</tr>
<tr>
<td>KEY1+KEY2</td>
<td>A plus sign between key names indicates a simultaneous key sequence: you press and hold down the first key while pressing the second key. For example, <strong>CTRL+X</strong>.</td>
</tr>
<tr>
<td>KEY1 KEY2</td>
<td>A space between key names indicates a sequential key sequence: you press and release the first key, then press another key. For example, ESCAPE <strong>H</strong>.</td>
</tr>
</tbody>
</table>

**Syntax:**

| Fixed width               | A fixed-width font is used in syntax statements, code examples, system output, and filenames. |
| Fixed-width italics       | Fixed-width italics indicate variables in syntax statements. |
| Fixed-width bold          | Fixed-width bold indicates variables with special emphasis. |
| UPPERCASE fixed width     | Uppercase words are **ABL** keywords. Although these are always shown in uppercase, you can type them in either uppercase or lowercase in a procedure. |

This icon (three arrows) introduces a multi-step procedure.

This icon (one arrow) introduces a single-step procedure.
OpenEdge displays several types of messages to inform you of routine and unusual occurrences:

- **Execution messages** inform you of errors encountered while OpenEdge is running a procedure; for example, if OpenEdge cannot find a record with a specified index field value.

- **Compile messages** inform you of errors found while OpenEdge is reading and analyzing a procedure before running it; for example, if a procedure references a table name that is not defined in the database.

- **Startup messages** inform you of unusual conditions detected while OpenEdge is getting ready to execute; for example, if you entered an invalid startup parameter.

After displaying a message, OpenEdge proceeds in one of several ways:

- Continues execution, subject to the error-processing actions that you specify or that are assumed as part of the procedure. This is the most common action taken after execution messages.

- Returns to the Procedure Editor, so you can correct an error in a procedure. This is the usual action taken after compiler messages.

- Halts processing of a procedure and returns immediately to the Procedure Editor. This does not happen often.

- Terminates the current session.

OpenEdge messages end with a message number in parentheses. In this example, the message number is 200:

```
** Unknown table name table. (200)
```

If you encounter an error that terminates OpenEdge, note the message number before restarting.

## Obtaining more information about OpenEdge messages

In Windows platforms, use OpenEdge online help to obtain more information about OpenEdge messages. Many OpenEdge tools include the following Help menu options to provide information about messages:

- Choose **Help → Recent Messages** to display detailed descriptions of the most recent OpenEdge message and all other messages returned in the current session.

- Choose **Help → Messages** and then type the message number to display a description of a specific OpenEdge message.

- In the Progress Procedure Editor, press the HELP key or F1.
On UNIX platforms, use the OpenEdge pro command to start a single-user mode character OpenEdge client session and view a brief description of a message by providing its number.

To use the pro command to obtain a message description by message number:

1. Start the Procedure Editor:

```
OpenEdge-install-dir/bin/pro
```

2. Press F3 to access the menu bar, then choose Help → Messages.

3. Type the message number and press ENTER. Details about that message number appear.

4. Press F4 to close the message, press F3 to access the Procedure Editor menu, and choose File → Exit.

Third party acknowledgements

OpenEdge includes AdventNet - Agent Toolkit licensed from AdventNet, Inc. [http://www.adventnet.com](http://www.adventnet.com). All rights to such copyright material rest with AdventNet.

OpenEdge includes ANTLR (Another Tool for Language Recognition) software Copyright © 2003-2006, Terence Parr All rights reserved. Neither the name of the author nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. Software distributed on an “AS IS” basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product.

OpenEdge includes software developed by the Apache Software Foundation ([http://www.apache.org/](http://www.apache.org/)). Copyright © 1999 The Apache Software Foundation. All rights reserved (Xerces C++ Parser (XML) and Xerces2 Java Parser (XML)); Copyright © 1999-2002 The Apache Software Foundation. All rights reserved (Xerces Parser (XML)); and Copyright © 2000-2003 The Apache Software Foundation. All rights reserved (Ant). The names “Apache,” “Xerces,” “ANT,” and “Apache Software Foundation” must not be used to endorse or promote products derived from this software without prior written permission. Products derived from this software may not be called “Apache”, nor may “Apache” appear in their name, without prior written permission of the Apache Software Foundation. For written permission, please contact apache@apache.org. Software distributed on an “AS IS” basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product.

OpenEdge includes Concurrent Java software Copyright 1994-2000 Sun Microsystems, Inc. All Rights Reserved. -Neither the name of or trademarks of Sun may be used to endorse or promote products including or derived from the Java Software technology without specific prior written permission; and Redistributions of source or binary code must contain the above copyright notice, this notice and the following disclaimers: This software is provided "AS IS," without a warranty of any kind. ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN MICROSYSTEMS, INC. AND ITS LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY LICENSEE AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THE SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL SUN MICROSYSTEMS, INC. OR ITS LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE SOFTWARE, EVEN IF SUN MICROSYSTEMS, INC. HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

OpenEdge includes DataDirect software Copyright © 1991-2007 Progress Software Corporation and/or its subsidiaries or affiliates. All Rights Reserved. (DataDirect Connect for JDBC Type 4 driver); Copyright © 1993-2009 Progress Software Corporation and/or its subsidiaries or affiliates. All Rights Reserved. (DataDirect Connect for JDBC); Copyright © 1988-2007 Progress Software Corporation and/or its subsidiaries or affiliates. All Rights Reserved. (DataDirect Connect for ODBC); and Copyright © 1988-2007 Progress Software Corporation and/or its subsidiaries or affiliates. All Rights Reserved. (DataDirect Connect64 for ODBC).

OpenEdge includes DataDirect Connect for ODBC and DataDirect Connect64 for ODBC software, which include ICU software 1.8 and later - Copyright © 1995-2003 International Business Machines Corporation and others All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation.

OpenEdge includes DataDirect Connect for ODBC and DataDirect Connect64 for ODBC software, which include software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/). Copyright © 1998-2006 The OpenSSL Project. All rights reserved. And Copyright © 1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

OpenEdge includes DataDirect products for the Microsoft SQL Server database which contain a licensed implementation of the Microsoft TDS Protocol.

OpenEdge includes software authored by David M. Gay. Copyright © 1991, 2000, 2001 by Lucent Technologies (dtoa.c); Copyright © 1991, 1996 by Lucent Technologies (g_fmt.c); and Copyright © 1991 by Lucent Technologies (rnd_prod.s). Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software. THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR LUCENT MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

OpenEdge includes software authored by David M. Gay. Copyright © 1998-2001 by Lucent Technologies All Rights Reserved (decstrtod.c; strtodg.c); Copyright © 1998, 2000 by Lucent Technologies All Rights Reserved (decstrtof.c; strtord.c); Copyright © 1998 by Lucent Technologies.
OpenEdge includes http package software developed by the World Wide Web Consortium. Copyright © 1994-2002 World Wide Web Consortium, (Massachusetts Institute of Technology, European Research Consortium for Informatics and Mathematics, Keio University). All rights reserved. This work is distributed under the W3C® Software License [http://www.w3.org/Consortium/Legal/2002/copy ri ght-software-20021231] in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.

OpenEdge includes ICU software 1.8 and later - Copyright © 1995-2003 International Business Machines Corporation and others All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation.


OpenEdge includes Infragistics NetAdvantage for .NET v2009 Vol 2 Copyright © 1996-2009 Infragistics, Inc. All rights reserved.

OpenEdge includes JSTL software Copyright 1994-2006 Sun Microsystems, Inc. All Rights Reserved. Software distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product.

OpenEdge includes OpenSSL software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/). Copyright © 1998-2007 The OpenSSL Project. All rights reserved. This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software written by Tim Hudson (tjh@cryptsoft.com). Copyright © 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without prior written permission. For written
permission, please contact openssl-core@openssl.org. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written permission of the OpenSSL Project. Software distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product.

OpenEdge includes Quartz Enterprise Job Scheduler software Copyright © 2001-2003 James House. All rights reserved. Software distributed on an “AS IS” basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product. This product uses and includes within its distribution, software developed by the Apache Software Foundation (http://www.apache.org/).

OpenEdge includes code licensed from RSA Security, Inc. Some portions licensed from IBM are available at http://oss.software.ibm.com/icu4j/.

OpenEdge includes the RSA Data Security, Inc. MD5 Message-Digest Algorithm. Copyright ©1991-2, RSA Data Security, Inc. Created 1991. All rights reserved.

OpenEdge includes Sonic software, which includes software developed by Apache Software Foundation (http://www.apache.org/). Copyright © 1999-2000 The Apache Software Foundation. All rights reserved. The names “Ant”, “Axis”, “Xalan,” “FOP,” “The Jakarta Project”, “Tomcat”, “Xerces” and/or “Apache Software Foundation” must not be used to endorse or promote products derived from the Product without prior written permission. Any product derived from the Product may not be called “Apache”, nor may “Apache” appear in their name, without prior written permission. For written permission, please contact apache@apache.org.

OpenEdge includes Sonic software, which includes software Copyright © 1999 CERN - European Organization for Nuclear Research. Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. CERN makes no representations about the suitability of this software for any purpose. It is provided "as is" without expressed or implied warranty.

OpenEdge includes Sonic software, which includes software developed by ExoLab Project (http://www.exolab.org/). Copyright © 2000 Intalio Inc. All rights reserved. The names “Castor” and/or “ExoLab” must not be used to endorse or promote products derived from the Products without prior written permission. For written permission, please contact info@exolab.org. Exolab, Castor and Intalio are trademarks of Intalio Inc.

OpenEdge includes Sonic software, which includes software developed by IBM. Copyright © 1995-2003 International Business Machines Corporation and others. All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation. Software distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the
product. Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder.

OpenEdge includes Sonic software, which includes the JMX Technology from Sun Microsystems, Inc. Use and Distribution is subject to the Sun Community Source License available at http://sun.com/software/communitysource.

OpenEdge includes Sonic software, which includes software developed by the ModelObjects Group (http://www.modelobjects.com). Copyright © 2000-2001 ModelObjects Group. All rights reserved. The name “ModelObjects” must not be used to endorse or promote products derived from this software without prior written permission. Products derived from this software may not be called “ModelObjects”, nor may “ModelObjects” appear in their name, without prior written permission. For written permission, please contact djacobs@modelobjects.com.

OpenEdge includes Sonic software, which includes code licensed from Mort Bay Consulting Pty. Ltd. The Jetty Package is Copyright © 1998 Mort Bay Consulting Pty. Ltd. (Australia) and others.

OpenEdge includes Sonic software, which includes files that are subject to the Netscape Public License Version 1.1 (the “License”); you may not use this file except in compliance with the License. You may obtain a copy of the License at http://www.mozilla.org/NPL/. Software distributed under the License is distributed on an “AS IS” basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License. The Original Code is Mozilla Communicator client code, released March 31, 1998. The Initial Developer of the Original Code is Netscape Communications Corporation. Portions created by Netscape are Copyright 1998-1999 Netscape Communications Corporation. All Rights Reserved.

OpenEdge includes Sonic software, which includes software developed by the University Corporation for Advanced Internet Development http://www.ucaid.edu Internet2 Project. Copyright © 2002 University Corporation for Advanced Internet Development, Inc. All rights reserved. Neither the name of OpenSAML nor the names of its contributors, nor Internet2, nor the University Corporation for Advanced Internet Development, Inc., nor UCAID may be used to endorse or promote products derived from this software and products derived from this software may not be called OpenSAML, Internet2, UCAID, or the University Corporation for Advanced Internet Development, nor may OpenSAML appear in their name without prior written permission of the University Corporation for Advanced Internet Development. For written permission, please contact opensaml@opensaml.org.

OpenEdge includes the UnixWare platform of Perl Runtime authored by Kiem-Phong Vo and David Korn. Copyright © 1991, 1996 by AT&T Labs. Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software. THIS SOFTWARE IS BEING PROVIDED “AS IS”, WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHORS NOR AT&T LABS MAKE ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

OpenEdge includes Vermont Views Terminal Handling Package software developed by Vermont Creative Software. Copyright © 1988-1991 by Vermont Creative Software.
OpenEdge includes XML Tools, which includes versions 8.9 of the Saxon XSLT and XQuery Processor from Saxonica Limited (http://www.saxonica.com/) which are available from SourceForge (http://sourceforge.net/projects/saxon/). The Original Code of Saxon comprises all those components which are not explicitly attributed to other parties. The Initial Developer of the Original Code is Michael Kay. Until February 2001 Michael Kay was an employee of International Computers Limited (now part of Fujitsu Limited), and original code developed during that time was released under this license by permission from International Computers Limited. From February 2001 until February 2004 Michael Kay was an employee of Software AG, and code developed during that time was released under this license by permission from Software AG, acting as a "Contributor". Subsequent code has been developed by Saxonica Limited, of which Michael Kay is a Director, again acting as a "Contributor". A small number of modules, or enhancements to modules, have been developed by other individuals (either written especially for Saxon, or incorporated into Saxon having initially been released as part of another open source product). Such contributions are acknowledged individually in comments attached to the relevant code modules. All Rights Reserved. The contents of the Saxon files are subject to the Mozilla Public License Version 1.0 (the "License"); you may not use these files except in compliance with the License. You may obtain a copy of the License at http://www.mozilla.org/MPL/ and a copy of the license can also be found in the installation directory, in the c:/OpenEdge/licenses folder. Software distributed under the License is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License.

OpenEdge includes XML Tools, which includes Xs3P v1.1.3. The contents of this file are subject to the DSTC Public License (DPL) Version 1.1 (the "License"); you may not use this file except in compliance with the License. A copy of the license can be found in the installation directory, in the c:/OpenEdge/licenses folder. Software distributed under the License is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License. The Original Code is xs3p. The Initial Developer of the Original Code is DSTC. Portions created by DSTC are Copyright © 2001, 2002 DSTC Pty Ltd. All rights reserved.

OpenEdge includes YAJL software Copyright 2007, Lloyd Hilaiel. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. Neither the name of Lloyd Hilaiel nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE AUTHOR `\` AS IS\` AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Overview of Progress Dynamics Administration

This chapter provides an overview of Progress Dynamics® administration and includes descriptions of:

- Tasks for Progress Dynamics administrators
- Tools for Progress Dynamics administration
Overview of Progress Dynamics Administration

Tasks for Progress Dynamics administrators

The tasks described in this manual cover the following topics:

- **Defining and managing Progress Dynamics sessions** — How to use the flexible mechanism for configuring Progress Dynamics environments to run applications in different application client, application server, database, and hardware configurations with little or no change to application data and code.

- **Setting up basic management and security options** — How to use Progress Dynamics tools to set up an environment that is structurally sound and secure.

- **Supporting application features** — How to include information on using a variety of application functions that are partly or completely built into the Progress Dynamics framework, such as generic database comments and auditing, localization, and access to multi-media files.

For information about source control management, application deployment, and upgrading Progress Dynamics, go to the following Web site:


*OpenEdge Getting Started: Installation and Configuration* also contains information about using the Progress Dynamics Configuration Utility to upgrade Progress Dynamics from one release to another, while ensuring database integrity.
Tools for Progress Dynamics administration

Figure 1–1 shows the Administration main window that you use for most Progress Dynamics administration tasks. You can start the Administration main window from the AppBuilder Tools menu. You can also open it from the Links menu on the Dynamics Development window.

The following sections describe the tools available from the Administration main window, and where to find more information about them.

Application menu

Figure 1–2 shows the Application menu. This manual covers only some of the functions available, namely, those that have the most impact on supporting general application development functions.

The Application menu contains the following functions:

- **Product Control** — Defines details about the installed products and product modules.
- **Instance Attribute Control** — Defines the unique, instance-specific characteristics of generic objects, customized to suit a particular application of it.
- **Toolbar and Menu Designer** — Allows for the creation of items, bands, band structures, toolbar/menu structures, and object/band association structures.
- **Country Control** — Defines countries for application localization.
- **Nationality Control** — Defines nationalities for application localization.
- **Language Control** — Defines languages for application localization.
- **Translation Control** — Defines translations for application text objects for any defined language. This includes information on the run-time Translate Window function that allows users to translate text objects in any application window they are using while they use it.
• **Category Control** — Defines criteria for data categorization that can be applied to any table, using a one-level to three-level category typing scheme. This facility is critical to implementing several other Progress Dynamics-supported application features, including generic database comments and progressive status tracking, among others. You can use it wherever you need a way to add a degree of logical structure to the flat data of a table, or even to define valid lists of values.

• **Custom Procedure Control** — Defines logical names and descriptions for custom procedures that you want to access in the framework.

• **Multi Media Type Control** — Defines the file types and instantiating program for virtually any type of file format, including sound, audio-visual, video, or word-processing files. This allows such files to be linked to and referenced from Progress Dynamics entities.

• **Multi Media Image Control** — Maintains images being added to the Multi Media table. This was mainly added to allow the addition of images for the dynamic TreeView nodes but does not limit it to that.

• **Status Control** — Defines progressive status codes that you can use to maintain states of change and thresholds in your application data, including status histories of any extent. This is to support the internal workings of a status tracking system that you design and implement as part of your application.

• **Currency Control** — Defines currencies for application localization.

For more information on these controls, see Chapter 4, “Supporting Built-in Application Features.” This also includes a description of how to use the **Generic Database Commenting and Auditing** features that are built into the Progress Dynamics UI and data management infrastructure.

### Deployment menu

*Figure 1–3* shows the **Deployment** menu, which provides the tools for deploying Progress Dynamics applications from one Progress Dynamics site to another.

![Deployment menu](image)
The following tools are on the **Deployment** menu:

- **Deployment Dataset Control** — Defines the contents of datasets that you can use to deploy related tables from the Progress Dynamics Repository or application databases. The **Site Control** on the **System** menu is also essential to this process (see the “**System menu**” section on page 1–7).

- **Release Version Control** — Allows you to specify release milestones that you can use to specify objects for deployment that have changed since a prior release milestone.

- **Dataset Export** — Filters the records to include in a deployment dataset and exports the dataset in a format ready for import at another Progress Dynamics site.

- **Dataset Import** — Imports a deployment dataset generated with the **Dataset Export** tool at another Progress Dynamics site.

- **Reset Data Modified Status** — Resets the **Data Modified Status** of all the data in the Repository so that the data is listed as **Not Modified**.

- **Deployment Destinations** — Specifies deployment destinations for one or more static objects.

- **Deploy Static Objects** — Creates deployment packages containing precompiled static objects for an individual deployment destination.

- **Redundant ADO Listings** — Generates a list of the ADO files that no longer exist in the Repository. You can then use this list to remove the redundant ADOs from the Repository.

- **Generate Client Cache** — Creates a cache of application objects and entities used by the client. Caching can improve performance by reducing the number of calls to the Repository.

- **4GL Generator** — Generates static ABL equivalents of dynamic objects that are optimized for performance. You can then deploy these static ABL equivalents as the run-time versions of the dynamic objects that you otherwise deploy and maintain in the design-time Repository.

For more information on the Generate Client Cache tool, see the information on the class and entity cache in Chapter E, “Performance Notes.” For more information on the 4GL Generator tool, see the sections on generating ABL equivalents of dynamic objects in Chapter D, “Deployment Notes.”

For more information on these Progress Dynamics deployment tools and release versioning, see the product release notes and related white papers posted on the Progress Software Developers Network® (PSDN) Web site:

http://psdn.progress.com/library/white_papers/dynamicswp/index.ssp

### Security menu

The **Security** menu contains a single function, **Security Control**. You use this function for adding basic security and for creating security restrictions on virtually any object that requires security in an application.
This manual covers only basic security, including the following functions in the Security Control:

- **Security Maintenance** — Sets global security and functional options for your Progress Dynamics installation.

- **Login Companies** — Defines organizations (login companies) that you can use to group users and application functionality, perhaps based on a company product line or a group expertise.

- **Groups** — Defines users, their login names, passwords, privileges, and all the other criteria used to authenticate users so they can login and work with the appropriate application function.

- **User Categories** — Defines categories of users irrespective of location or affiliation, perhaps as a means to distinguish, for example, novice from expert users.

- **Users** — Defines users, their login names, passwords, privileges, and all the other criteria used to authenticate users so they can login and work with the appropriate application functions.

For more information on using these security functions, see Chapter 3, “Setting Up Basic Security Options.” For more information on advanced security options, including the remaining functions on the Security Control window, see *OpenEdge Development: Progress Dynamics Basic Development*.

**Session menu**

Figure 1–4 shows the options in the Session menu. You use this menu to configure Progress Dynamics sessions with OpenEdge® and system resources, and to set up options for session operations that are independent of the application that is running.

![Session menu options](image)

**Figure 1–4: Session menu options**

The Session menu contains the following functions:

- **Session Type Control** — Defines the different types of sessions in which applications can run. For example, sessions configured for development, application run time, WebClient™ n-tier operation, and so on.

- **Generate Configuration File** — Generates a configuration XML file that contains the startup configuration for any selection of session types that you have defined in the Repository.
• **Configuration File Import** — Allows you to import a configuration XML file that you might have modified manually, allowing you to synchronize it with the Repository.

• **Session Type Control Data** — Defines what session types are allowed to run in a Progress Dynamics installation. It specifies how to handle session types that are connected by a client and are not registered in the Repository or that are configured without a clear indication of where, between the Repository and the configuration XML file, to resolve their settings.

• **Session Property Control** — Defines the run-time options that traditionally apply to the SESSION handle, but also additional options that Progress Dynamics requires or you find helpful in defining the run-time environment for a session.

• **Service Type Control** — Defines the basic types of services that make up a session type and thus become session services, such as database and Progress® AppServer™ services.

• **Logical Service Control** — Defines a component of session services that specifies the more abstract characteristics of a service type, providing greater flexibility in service definition to handle various local and remote configurations of the same physical services.

• **Physical Service Control** — Defines the connection parameters that establish connections between a client and a specific physical database, AppServer, or other service.

• **Manager Type Control** — Specifies standard or custom session managers, the persistent procedures that, along with the Repository, provide the core of Progress Dynamics functionality.

• **Profile Control** — Defines operational options that a user can enable or disable for a current session or to apply more permanently across multiple sessions, such as maintaining window sizes and positions, default SmartDataObject™ preferences, and so on.

• **Global Control** — Defines system control defaults. These are parameters that determine the system operation, such as date format and currency.

For more information on using these session management functions, see Chapter 2, “Defining and Managing Sessions” and the session management white paper posted on the following PSDN Web site:
http://psdn.progress.com/library/white_papers/dynamicswp/index.ssp

**System menu**

Figure 1–5 shows the **System** menu. This manual covers only some of the functions available, namely, those that have the most impact on installation configuration and administration.
The **System** menu contains the following functions:

- **Set Site Number** — Sets a unique site identification number for a registered Progress Dynamics site in the Progress Dynamics Repository database (ICFDB).

- **Context Help Control** — Displays the online help context number mappings for application user interface containers, objects, and fields.

- **Message Control** — Displays the messages you can use in your application. Also allows you to add translations for existing messages by adding a language code and appropriate text.

- **Sequence Control** — Displays the available sequences.

- **Entity Control** — Displays the entities in all or one of the connected databases from which you have already imported entities.

- **Entity Import** — Imports entity mnemonic records for one or more application database tables.

- **Filter Set Maintenance** — Defines and names groups of rules for including or excluding data from queries during a particular session.

For more information on sequences and generic database auditing, see Chapter 4, “Supporting Built-in Application Features.”

*OpenEdge Development: Progress Dynamics Basic Development* describes how to use the **Entity Import** and **Entity Control** tools.

### Transaction menu

The **Transaction** menu contains a single function, **Audit Control**. This function provides a means to access all audit records that have been generated from tables that have **Generic Auditing** turned on. It works very much like the **Audit** button that allows users to access audit records generated on the data with which they are working. However, this control allows you to review the audit records for an entire Progress Dynamics installation. For more information on **Generic Auditing** and reviewing audit records, see Chapter 4, “Supporting Built-in Application Features.”
This chapter provides the information you need to work with Progress Dynamics sessions. It includes the following sections:

- Defining a Progress Dynamics session
- Starting a Progress Dynamics session
- Configuring a Progress Dynamics session
- Defining user profile data for a session
Defining a Progress Dynamics session

A session is the context in which Progress Dynamics itself and Progress Dynamics applications run. This context includes:

- **Required Managers** — Each session type requires a set of persistent procedures referred to as managers. The managers implement the core functionality of the Progress Dynamics framework. Each session type has different requirements regarding which managers it needs to run. For example, the session type used to run applications in Web browsers (ICFWS) requires a User Interface Manager to receive data from a Web stream. In an application development session (ICFDev), the User Interface Manager is not required.

- **Session Properties** — Session properties are a list of startup parameters and environment variables for the session. Sessions can be defined with a wide range of properties including PROPATH settings, startup procedures, date/time formats, user login requirements, and so on.

- **Session Services** — Session services are the physical and logical resources that the session type must connect to. For example, the session type that you use to run an application would include the Repository (ICFDB) and an application database as session services.

You can view the managers, properties, and services defined for each session by starting the Session Type Maintenance tool. To start the Session Type Maintenance tool, choose Session → Session Type Control from the Administration tool menu bar.

When you start a Progress Dynamics session, the Configuration File Manager reads the definition of the session from an XML configuration file. You can generate configuration files for a single session type or that contain several session types. You can access the Generate Configuration File tool from either the Administration window’s Session menu or from the Session Type Maintenance tool’s Option menu.

The session information in the configuration file allows Progress Dynamics applications to run in different session types with little or no manual reconfiguration. You simply include the session type and location of the XML configuration file as arguments to the -icfparm startup parameter for the application. For example, the following fragment of a startup command specifies ICFDev as session type, that ICFDev is defined in the configuration file located in the DynamicsWRK folder (the work folder specified during Progress Dynamics installation):

```
... -icfparam ICFSESTYPE=ICFDev, ICFCONFIG="C:\DynamicsWRK\icfconfig.xml"
```

A session begins when you start Progress Dynamics or a Progress Dynamics application. The session ends when you stop Progress Dynamics or an application. You can also define the session to stop when it times out due to inactivity.

**Predefined session types**

Session types are defined in a hierarchy where basic session types are extended to create more complex session types. A session type that extends another session type inherits the properties of that other session type. You can then override existing properties with new values and add additional properties to create a different environment.

Several session types are predefined and shipped with the Progress Dynamics software to give you a place to start. These session types represent guidelines for creating your own session types. Figure 2–1 shows the inheritance between the standard session types.
Table 2–1 describes the session types that ship with Progress Dynamics.

Table 2–1: Predefined session types

<table>
<thead>
<tr>
<th>Session type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td>The starting point for all session types. It supplies common connection information for starting the framework.</td>
</tr>
<tr>
<td>DCU</td>
<td>The basic Progress Dynamics Configuration Utility (DCU) session type. The DCU runs in a specialized session that does not include all the managers of a Progress Dynamics session. This session type supplies common information for all DCU sessions.</td>
</tr>
<tr>
<td>ProgressSetup</td>
<td>The standard DCU session type. You can extend this session type to create a session type for your custom DCU deployments.</td>
</tr>
<tr>
<td>dcuphase1</td>
<td>The session type for Phase 1 of the DCU when it runs in batch mode.</td>
</tr>
<tr>
<td>Dynamics</td>
<td>The basic session type for session that use the full framework.</td>
</tr>
<tr>
<td>DynASClient</td>
<td>The basic session type for Progress Dynamics applications running across the AppServer.</td>
</tr>
<tr>
<td>ICFRuntime</td>
<td>The standard AppServer run-time client session type.</td>
</tr>
</tbody>
</table>
### Table 2–1: Predefined session types

<table>
<thead>
<tr>
<th>Session type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DynRTB</td>
<td>The basic session type for sessions that use Roundtable. You would extend this session type for each particular Roundtable environment.</td>
</tr>
<tr>
<td>DynDBBound</td>
<td>The basic session type for sessions that run with a direct connection to the Repository.</td>
</tr>
<tr>
<td>dcuphase2</td>
<td>The session type for Phase 2 of the DCU when it runs in batch mode.</td>
</tr>
<tr>
<td>DynAppServer</td>
<td>The standard session type for database-bound sessions that run with the AppServer. This session is extended to create development and run-time session types.</td>
</tr>
<tr>
<td>DynCS</td>
<td>The standard session type for database-bound sessions that run client/server. This session is extended to create development and run-time (default) session types.</td>
</tr>
<tr>
<td>DynWeb</td>
<td>The standard session type for database-bound sessions that run over the Web. This session is extended to create the default Web session (ICFWS).</td>
</tr>
</tbody>
</table>
# Starting a Progress Dynamics session

Before you start a Progress Dynamics session, you must start the Repository database, ICFDB. You must connect to ICFDB to access the Progress Dynamics tools in the AppBuilder. You also must start the ICFDB database in multi-user mode so that you can make client, AppServer, and/or Web Server connections as needed.

When you installed Progress Dynamics, the Progress Dynamics Configuration Utility (DCU) created shortcuts to batch files that start (in multi-user mode) and stop the ICFDB Repository.

### To start a Progress Dynamics session:

1. To start the Repository, choose **Start → OpenEdge → Progress Dynamics → Start Dynamics DB Servers**.

   You might see the batch file run briefly in a command window. The command window will close once the batch file completes running.

2. Start your application databases.

   You can use a database shortcut and create a new startup icon that starts your application databases for you. See *OpenEdge Development: Progress Dynamics Getting Started* for more information on creating database startup shortcuts.

3. To start a Progress Dynamics development session, choose **Start → OpenEdge → Progress Dynamics → Dynamics Development**.

   By default, this starts the client/server development (ICFdev) session. After you start the framework, the first screen you see is the **Application Login** dialog box, as shown:

   ![Application Login Dialog Box](image)

   **Note:** The processing date on the login screen comes from the startup parameters in the configuration file. For more information on the configuration file, see the “Generating the configuration file” section on page 2–23.

   The login program provides for application security and language control. For more information about setting up and using basic security features, see Chapter 3, “Setting Up Basic Security Options.”

4. **Type a Login Name** (the default is admin). The AppBuilder, along with the PRO*Tools and **Object Palette**, appear.

   For more information about setting up your own login name, see the “Defining session services” section on page 2–9.
5. Verify that your Repository and application databases are connected. Choose **Tools**→**Database Connections** from the AppBuilder main menu.

The following figure shows that the ICFDB Repository and the DynSports sample application database are connected to the session:

![Database Connections](image)

**Note:** The application database is not connected unless you modified the default ICFDev session type to include it as a service. (See the “Configuring a Progress Dynamics session” section on page 2–8.) However, if the application database is running, you can add it at this point by clicking **Connect** and connecting in multi-user mode.

6. To stop the Progress Dynamics Repository database at the end of a session, choose **Start**→**OpenEdge**→**Progress Dynamics**→**Stop Dynamics DB Servers**.

### How sessions start

When you start a Progress Dynamics session the following happens:

1. The Configuration File Manager is launched and initializes the session. The Configuration File Manager is a persistent procedure that determines and establishes the startup environment. It gets its session startup information from the Progress Dynamics configuration file (by default, `icfconfig.xml`).

**Note:** The Progress Dynamics upgrade process can overwrite the default file, `icfconfig.xml`. You should save a copy of your file before upgrading.

The `icfconfig.xml` file defines the environment in which Progress Dynamics can run. The definition of each session type includes the following startup information:

- Its logical and physical resources (session services)
- Its startup parameters (session properties)
- The management procedures (Progress Dynamics managers) with which it runs

**Note:** The Progress Dynamics configuration file can reside at a central source, anywhere on a network that can host an XML file, on behalf of all Progress Dynamics installations that rely on it. You can also import any manual changes that you make to the configuration file so all of its startup information is synchronized with and secure in the Repository. For more information, see the “Importing a configuration file” section on page 2–28.
Starting a Progress Dynamics session

For more information about the configuration file, see Appendix C, "Inside the Progress Dynamics Configuration File."

2. The Connection Manager launches to manage the connections to required services, including databases, AppServer, Web services, and JMS Server (for SonicMQ connections only).

   The Connection Manager calls a Service Type Manager that manages the physical connections for all session services of the same service type. Each service type has its own Service Type Manager. All Service Type Managers are built with a common starting API to the Connection Manager, allowing it the flexibility to handle any device or service that can be manipulated through that common API.

3. The Session Manager controls the operation of the application.

4. The Progress Dynamics session runs until you shut it down, or until it times out (if the session has a time-out setting specified for it). The Session Manager handles the termination of the session. First, it shuts down all persistent procedures that are running, then it shuts itself down.
Defining and Managing Sessions

Configuring a Progress Dynamics session

This section describes how to configure different kinds of sessions, change your existing session configurations, and set up a new configuration.

The following sections provide an overview of the tasks, plus step-by-step instructions:

- Overview of session configuration tasks
- Defining session services
- Creating session properties
- Defining managers
- Creating a new session type
- Generating the configuration file
- Using minimum XML files
- Creating a shortcut icon to start a session
- Importing a configuration file

Overview of session configuration tasks

When you create a new session type or extend an existing session type, you specify the following:

- The Progress Dynamics managers that need to run for the session type.
- Any session properties for the session type.
- Any required session services. (Session services for running applications typically include a Repository and an application databases referenced as physical and logical services.)

To configure a new session:

1. Create logical and physical service records in the Repository for any new session services, such as databases or Web services.
2. Create records in the Repository for any new session properties.
3. Create records in the Repository for any new managers.
4. Create a new session type in the Repository.
5. Generate or regenerate your configuration XML file.
6. Create a shortcut icon that uses your configuration XML file and that points to the configuration information you specified for the session type.
7. You might later import your generated configuration XML file after making any manual changes to it that you want synchronized with the Repository.
Defining session services

A session service is made up of a logical and a physical service, both of which have the same service type. A service type is a named object with associated management objects that control all services of a particular type. For example, a session service for database access would have the logical and the physical services defined with the database service type. Each service type has its own Service Type Manager that the Connection Manager calls for services of that type.

A logical service lets you define the more abstract characteristics of a service type, which provides greater flexibility in service definition to handle various local and remote configurations of the same physical services. A logical service is a separate process that runs locally or remotely and requires connection parameters to establish communication between a session and a service. Logical service names must be unique so that connection to the service can be completely abstracted from the developer. The logical service and session type combination determines which physical service will be used.

The physical service determines the actual connection parameters. For example, consider an application deployed to several sites. The application has a single logical service for its application database. But, there is a different physical service for each site that describes how to connect to the application database on that site’s network. To configure the session type on each site, you only need to change which physical service is listed in the session type’s description.

Service types

You can view the service types that are registered in the Repository from the Service Type Control window.

To view and edit service types:

1. From the Administration window, choose Session→Service Type Control. The Service Type Control window appears. You can see the predefined service types (AppServer partition, Database, Web service, and JMS Partition) and their associated manager and maintenance files, as shown:
2. To edit a service type, double-click it in the browse. The **Service Type Maintenance** window appears, as shown:

You can build and define your own service types by creating Service Type Managers that adhere to Progress Dynamics requirements. For more information on creating managers, see *OpenEdge Development: Progress Dynamics Advanced Development*.

**Creating a logical service**

By defining a logical service, you can change the physical service when you deploy an application without changing any code. For example, your code can reference the logical service called DynSports. The physical service name can be dypsportsn for a network service. If you change the physical service to dypsportsl for a local connection to the database, you do not have to change your code because the logical service name remains DynSports.

To create a logical service:

1. From the **Administration** window, choose **Session → Logical Service Control**. The **Logical Service Control** window appears, as shown:
2. Click Add record[17]. The Logical Service Maintenance window appears, as shown:

3. Type a Logical service code. For example, DynSports.

Note: In the case of the AppServer, this code replaces the partition name that is used by ADM code written or generated outside of Progress Dynamics. If an application makes use of ADM code that has the partition name coded into the container objects, you must specify these partition names as Logical service code values. Also note that if you alter the Logical service code value after you create it, you might render the earlier ADM code unusable.

4. Type a value for Logical service description field. For example, DynSports application database.

5. Select a Service type value. In this example, it is Database.

6. Specify the appropriate values for the remaining properties by selecting or clearing the toggle boxes. Table 2–2 describes the remaining properties.

Table 2–2: Logical service properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can run locally</td>
<td>Specifies if the service can run locally. If it cannot run locally (unselected), you must have an entry in the session service table to use the partition.</td>
</tr>
</tbody>
</table>
| System owned          | Specifies if the service is system owned. System owned services cannot be modified unless you have the appropriate permissions.  
                        | Note: The framework does not enable this feature automatically. To fully implement this feature, you must provide code in the trigger for the table, or in the SDO linked to the table containing the system owned field. |
| Write to config       | Specifies if the service, and its associated physical service, should be included in generated configuration files. |
| Connect at startup    | Specifies if the framework should connect to the service at startup. Web services, especially, can slow the start of an application. You might get better performance by having them connected the first time they are needed, instead of at startup. |
7. Click Save to save the new logical service to the database.

**Note:** The Logical Service Maintenance window contains two additional tab folders: **Session Services** and **Service**. The Session Services tab displays the session services for the selected logical service, after you associate the new logical service with one or more session services. The Service tab lets you define a session service for the selected logical service.

---

**Creating a physical service**

A physical service provides the specific connection parameters that are required to connect a physical device or service to a session.

**To create a physical service:**

1. From the Administration window, choose Session→ Physical Service Control. The Physical Service Control window appears, as shown:
2. Click Add record. The Physical Service Maintenance window appears, as shown:

3. Type a Physical service code value. For example, dynsports.

4. Type a value for the Physical service description field. For example, DynSports application database.

5. Select a Service type value. In this example, it is Database.

6. Specify the appropriate Connection parameters values.

   Depending on the service type you selected, a different set of connection parameters is displayed. For more information on connection parameters, see the online help and/or OpenEdge Deployment: Startup Command and Parameter Reference.

7. Click Save.
Creating session properties

For each session type, you can set multiple session properties. For example, there is a session property that specifies the startup procedure for Progress Dynamics. For a list of all the default session properties, see Appendix B, “Progress Dynamics Session Properties.”

To view and create session properties:

1. From the Administration window, choose Session → Session Property Control. The Session Property Control window appears, as shown:

2. Click Add record. The Session Property Maintenance - New window appears, as shown:

3. Type a Session property name value.
4. Type a value for the Session property description field.
5. Specify the Default property value.
6. Select the System owned toggle box to restrict who can alter the session property.
7. Select the Always used toggle box to have the session property written to the configuration file whether or not there is a session type that uses it.
8. Click Save.
Defining managers

In addition to session properties and session services, you must specify any managers that are used by a session type. A predefined set of managers is included with the Progress Dynamics installation. A manager is a persistent procedure that directly affects the core functionality of the framework. For example, the Session Manager lets you start other code, the Security Manager lets you define user authentication, and so on. If you create any custom managers that similarly affect the framework, you must register them in the Repository to use them with the framework.

To view the managers registered in the Repository, choose Session→Manager Type Control. The Manager Type Control window appears, as shown:

![Manager Type Control window](image)

Note: The Configuration File Manager does not appear in the list of configurable manager types in the Manager Type Control window. This management procedure is at the core of session management, but because it is the manager responsible for initiating the process of starting the managers on this list, its configuration is built into the framework and you should never change it.

For details about how to use the existing managers as well as how to create a new manager, see OpenEdge Development: Progress Dynamics Advanced Development. For more information about the application programming interfaces (APIs) of these managers, see OpenEdge Development: Progress Dynamics Managers API Reference.

Creating a new session type

Because session types are designed to inherit settings from other session types, the preferred method for creating new session types is to extend an existing session type. When you create a new session type in this way, you only have to specify the new items or changed values rather than everything that the session needs to run.
As an example, you will create a session type for the DynSports sample application by extending the Default session type.

To create a new session type:

1. From the Administration window, choose Session→ Session Type Control.

The Session Type Maintenance window appears, as shown:

Note the hierarchy of the session types. The standard development session (ICFDev) inherits from DynDevelopment, which inherits from DynCS, which inherits from DynDBBound, which inherits from Dynamics, which inherits from the Basic session type.
2. Right-click on the Basic → Dynamics → DynDBBound → DynCS → Default node, and choose the Add Session Type pop-up option. The Session Type Maintenance window appears in the right frame, as shown:

3. Type DynSports as the Session type code value.

4. Type DynSports application session in the Session type description field.

5. Clear the Automatic reconnect toggle box, if necessary. You set this option when you want the framework to automatically attempt to reconnect a dropped AppServer connection and restore the session context.

6. Select the WIN32 option in the Valid operating systems choices.

7. Select Never for the Inactivity timeout options. The session will keep running until the user actively shuts it down.

8. Add the GUI Client session type, if necessary.

9. Click Save. The new session type appears under the Default node, as shown:
Defining managers for a session type

Now that you have a new session type, you must modify it to suit your needs. Under each session type, there are three nodes that enable you to configure the session. The first node is the **Required Managers** node. If your new session type requires a manager that is not defined in one of the session types from which it inherits, you must add it through the **Required Managers** node.

**Figure 2–2** shows the managers that the example session type, DynSports, inherits.
Suppose you want to turn the DynSports session type into a development session. You must add the Repository Design Manager to it.

To define a manager for a session type:

1. Expand the DynSports session type node.

2. Right-click on the Required Managers node, then choose the Add Required Manager pop-up option. The Required Manager Maintenance window appears in the right frame, as shown:

3. Select Repository Design Manager from the Manager type list.

4. Type 11 for the Startup order value. This is the order in which the Connection Manager starts the necessary managers.

5. Unselect the System owned toggle box, if necessary. You set this option when the manager can only be modified by users with appropriate privileges.

6. Click Save.

For more information on Progress Dynamics managers, see the “Defining managers” section on page 2–15.

Defining properties for a session type

The second node that enables you to configure a session type is the Session properties node. If your new session type requires properties that are not defined in one of the session types from which it inherits, you must add it through the Session properties node. You might also want to override the value of an inherited property. You do this by adding the property to the new session type and assigning it a new value.
Figure 2–3 shows the session properties that the example session type, DynSports, inherits.

![Session property inheritance diagram]

**Figure 2–3:** Session property inheritance

Continue with the example of turning the DynSports session type into a development session. There are several session properties that are set for development sessions. You can look at the session properties for the DynDevelopment session type to see them all. You will set one of them for DynSports.

To define session properties for a session type:

1. Expand the DynSports session type node.

2. Right-click on Session Properties, then choose the Add Session Property pop-up option. The Session Property Maintenance window appears in the right frame, as shown:

![Session Property Maintenance window]
3. Click **Lookup** for **Property name**. The **Lookup Session Properties** window appears, as shown:

![Lookup Session Properties](image)

4. Scroll to and double-click **IDEPalette** in the **Session property name** column.

5. Type **PaletteDynamics** for the **Property value**.

6. Click **Save**.

For more information on Progress Dynamics session properties, see the “Creating session properties” section on page 2–14.

**Defining services for a session type**

The third node that enables you to configure a session type is the **Session services** node. If your new session type requires a session service that is not defined in one of the session types from which it inherits, you must add it through the **Session properties** node. You might also want to override the value of an inherited service. You do this by adding the service to the new session type and assigning it a new value.

Figure 2–4 shows the session services that the example session type, DynSports, inherits.

![Session services inheritance](image)
Defining and Managing Sessions

As shown in Figure 2–4, the DynSports session type inherits only two services, the default AppServer partition (ICFDevAS) and a network Repository connection (ICFDBn). To run the sample application, the DynSports session type needs a connection to the DynSports database. You can create that connection using the logical and physical services that you created in the “Creating a logical service” section on page 2–10 and the “Creating a physical service” section on page 2–12.

To define session services for a session type:

1. Expand the DynSports session type node.

2. Right-click the Session Services node, then choose the Add Session Service pop-up option. The Session Service Maintenance window appears in the right frame, as shown:

3. Click Lookup for the Physical service code. The Lookup Physical Services dialog box appears, as shown:

4. In the Physical service code column, double-click dynsports.
5. Click **Lookup** for the **Logical service code**. The **Lookup Logical Services** window appears, as shown:

![Lookup Logical Services Window](image)

6. In the **Logical service code** column, double-click **dynsports**.

7. Click **Save**.

For more information on Progress Dynamics services, see the “Defining session services” section on page 2–9.

### Generating the configuration file

The configuration file defines the environment in which a Progress Dynamics installation can run. The definition of each session type includes the following startup information:

- All of its required startup parameters (session properties).
- Its logical and physical resources (session services).
- The management procedures (Progress Dynamics managers) with which it runs.

The configuration file is used solely by the Configuration File Manager. The main purpose of the configuration file is to allow a centralized point where you can place various different sessions’ configuration parameters so that they are accessible anywhere on the network. Multiple clients can use the same configuration file. The configuration file is an XML file that can be read across the network because of built-in features of the XML Document Object Model (DOM).

When you install Progress Dynamics, the Progress Dynamics Configuration Utility (DCU) places a default configuration file called `icfconfig.xml` in `OpenEdge-Install-Dir/src/dynamics`. (For a detailed description of the contents of the default `icfconfig.xml`, see Appendix C, “Inside the Progress Dynamics Configuration File.”) This default configuration file lets you initially start Progress Dynamics so you can access the Progress Dynamics tools to define your own sessions and create your own configuration file.
When you start Progress Dynamics for the first time, you should create a new configuration file in your working directory. In general, you should not edit your configuration XML file manually (in an XML or text editor). You should instead use the framework’s administration tools to generate the files. The tools allow you to include only the session types you want in a given configuration file.

When you save the information that you add or change in the **Session Type Control** window, that information is saved into the Repository. To place those settings into the configuration file, you must generate (or regenerate) the XML file.

To complete the example, you can generate a configuration file for the *DynSports* session type.

**To generate (or regenerate) your configuration XML file:**

1. From the **Administration** window, choose **Session** → **Generate Configuration file**. The **Generate Configuration XML file** window appears, as shown:

2. Select **Local File**. Because the configuration file is in XML format, you can deploy it on a local disk or remotely, on a Universal Naming Convention (UNC) share or on a Web server. Generating it for remote use allows you to centralize the administration and set up of your application environment and reduces deployment issues.

3. Type *DynSportsConfig.xml* for the **File Name**. If you want the file to be stored somewhere other than in the `OpenEdge-Install-Dir/src/dynamics` directory, use the **Browse** button to set the appropriate path. The directory should be listed in your PROPATH.

4. Clear the **Minimum XML** toggle box, if necessary. The **Minimum XML** setting is a security measure. For more information, see the “Using minimum XML files” section on page 2–25.

5. Select *DynSports* in the **Available Session Types** list, then click **ADD** in order to move it to the **Selected Session Types** list.
6. Click **Generate**. Progress Dynamics only selects the session types in the **Selected Session Types** list to include in the generated configuration file.

7. When the message appears stating that the configuration file was successfully saved, click **OK** to dismiss the message dialog box.

### Using minimum XML files

A *minimum XML file* is a generated configuration XML file that contains the minimum data required to make the connection to the Repository. The rest of the configuration data for the session is read from the Repository when the session starts.

To generate these minimum XML files, select the Minimum XML toggle box in the **Generate Configuration File** tool. For more information, see the “Generating the configuration file” section on page 2–23.

By requiring the session to get most of its configuration data from a secure Repository, unauthorized users cannot easily start up and gain access to or make unauthorized modifications to the session by modifying the configuration file alone. Note that generating a minimum XML file requires the session data to be configured so it can be retrieved from the Repository. In other words, you must configure each of the session types that have a minimum XML file using one of the following configuration settings:

- **A configuration_source session property setting** that allows retrieval of the session data from the Repository.

- **Appropriate settings for the Session Type Control Data window** accessed from the Session menu of the Administration tool.

Specifying a minimum XML file significantly reduces the amount of information that is written to a generated configuration XML file. The information generated to a minimum XML file includes:

- **Session properties** — A list of essential session properties that is hard-coded into the configuration file generation procedure.

- **Required managers** — Only those managers where the Write to config toggle box in the Manager Type Control window has been selected.

- **Session services** — Only those services where the Write to config toggle box in the Logical Service Control window has been selected.

The default session types installed with Progress Dynamics only generate a manager entry for the Connection Manager and only generate services for ICFDB and Astra.

For more information on specifying and configuring sessions types to use minimum XML files, see the session management white papers posted on the following PSDN Web site: [http://psdn.progress.com/library/white_papers/dynamicswp/index.ssp](http://psdn.progress.com/library/white_papers/dynamicswp/index.ssp).
Creating a shortcut icon to start a session

To create a shortcut icon to start Progress Dynamics, you must specify startup parameters and properties that:

- Specify the session type
- Specify the location of your configuration XML file

Use the `-icfparam` startup parameter with the qualifiers described in Table 2–3.

<table>
<thead>
<tr>
<th>Qualifier</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICFCONFIG</td>
<td>Specifies the XML file to use for startup.</td>
<td><code>icfconfig.xml</code> in your PROPATH.</td>
</tr>
<tr>
<td>ICFSESSTYPE</td>
<td>Specifies the session type.</td>
<td>Default session type.</td>
</tr>
</tbody>
</table>

Copying a shortcut

Use the Progress Dynamics shortcut icons as a starting point.

To copy shortcut icons:

1. Right-click the Dynamics Runtime icon from the Windows Start menu, then choose Copy from the pop-up menu.
2. Paste the copy of the icon on your desktop or wherever you want to create your new shortcut.
3. Right-click on the icon and choose the Rename pop-up menu option.

Setting up shortcuts that use a local configuration file

Once you have made a copy of a Progress Dynamics shortcut, you must edit the properties to specify the appropriate session type and configuration file. This is an example using a configuration file named dynconfig.xml, which was locally generated in your working directory.

To edit the properties of the shortcut:

1. Right-click and choose the Properties pop-up menu option.
2. In the Properties dialog box’s Target field, edit the values of the `-icfparam` startup parameter qualifiers. For example, if the session type you want to use is called MyApp and your configuration file is called dynconfig.xml, use the following values:

   ```
   -icfparam ICFSESSTYPE=MyAPP ICFCONFIG=dynconfig.xml
   ```
3. Edit the **Start in** field, if needed, as shown:

   ![Image of shortcut properties]

   

4. Click **OK**.

5. To test to make sure your session configuration works, start the Repository database and your application database.

6. Double-click on your new shortcut.

**Setting up shortcuts that use a remote configuration file**

You can have shortcuts that access configuration files on remote machines as long as it is possible to use the Universal Naming Convention (UNC) to access resources on the remote machine.

**To create a shortcut that uses a remote configuration file:**

1. Copy your configuration file to the location on the network where you want to make it available.

2. Right-click and choose the **Properties** pop-up menu option for your shortcut.

3. In the **Properties** dialog box for the shortcut, edit the `-icfparam` startup parameter setting for `dynconfig.xml` to the full UNC path to the file on the network.

   For example, if you copy the `ICFCONFIG` to a server called `myserver` on a share name called `configurations` in a directory called `dynamics`, the UNC share name is:

   ```
   //myserver/configurations/dynamics/dynconfig.xml
   ```
Defining and Managing Sessions

You set the ICFCONFIG attribute of the -icfparam startup parameter to:

ICFCONFIG=//myserver/configurations/dynamics/dynconfig.xml

If you deploy the icfconfig.xml on the same server while the server is acting as the Web server, set the ICFCONFIG attribute to:

ICFCONFIG=http://myserver/configurations/dynamics/dynconfig.xml

**Importing a configuration file**

You can import the Progress Dynamics configuration XML (icfconfig.xml) file into the Progress Dynamics Repository using the Configuration File Import tool (Session → Configuration File Import from the Administration tool). This enables the Repository to completely define the session startup environment without the need to maintain a separate configuration file. If you make manual changes to your configuration file, you can easily synchronize them with the Repository by importing the file using this tool. For more information on using the Configuration File Import tool to import your session startup information, see the session management white paper that is posted on the following PSDN Web site:

http://psdn.progress.com/library/white_papers/dynamicswp/index.ssp

**Caution:** Using the Configuration File Import tool can alter the data for a session in the Repository so that the session data is unusable. Before using this tool, be sure to review the documentation in the Session Management white paper for this release.
Defining user profile data for a session

While session management is primarily concerned with the definition and configuration of Progress Dynamics sessions and the resources that they use, this section describes session data that affect how sessions run based on user run-time settings and actions. These settings depend on profile data that you define using Progress Dynamics and handle in your application code, as well as on profile data that is predefined and that Progress Dynamics can handle automatically for all applications that you build with it. Settings that Progress Dynamics handles automatically from predefined data include common application functions that users might want to change, such as window sizes and positions. In all cases, these settings are based on user profile data that you can modify using the Administration tool.

Defining user profile data

User profile data consists of a two-level definition that includes profile types and profile codes that indicate the exact application function that you allow users to affect. A profile type is a large category of profile data that you treat as a group, such as Window. A profile code is a subcategory of profile data, such as SaveSizPos, which is a subcategory of Window.

You can also specify options in your profile definitions that determine if a profile type applies to client sessions only or also to server sessions, and whether the profile type is enabled (active) or disabled for an entire Progress Dynamics installation.

Note: Other than distinguishing between client and server sessions, you cannot restrict or assign profile types to specific session types that you define. That is, there is no relation between Progress Dynamics profile types and session types. The primary relation with Progress Dynamics profile types is a Progress Dynamics registered user. Progress Dynamics thus saves profile data for a Progress Dynamics user across all session types in which the user runs an application on the same Progress Dynamics installation.

How a session uses profile data

The Profile Manager provides the program interface for profile data between the Repository and your application. It provides you with the option to store selected profile data for the duration of a single session or permanently between sessions, which you can have an application user decide. The Profile Manager stores values, by user, for each affected profile code in the Repository. At initial application startup, a default value is used for each setting until the user performs an application function that changes the value, such as changing the size of a window. You can also provide options that let the user decide whether certain profile types and codes affect application behavior.
For an example of user profile data in an application, review the **Preferences** function that is, by default, built into the **Administration** and **Development** windows. You can see how it works for the user by changing these settings in the **Administration** tool or the **Development** tool. You can provide additional user profile options in your own applications by defining the profile types and codes, as described in this section, and by referencing and updating their values at run time using the Profile Manager API.

**Note:** User profiles are not directly linked to Progress Dynamics security. Instead, Progress Dynamics uses a group-based security model. For more information on how to set up security in Progress Dynamics, see Chapter 3, “Setting Up Basic Security Options.”

---

**Defining user profiles**

You can define user profile types and codes using the **Administration** tool.

To define user profile types and codes, from the Administration window:

1. Choose **Session** → **Profile Control**. The **Profile Control** window appears, as shown:

   ![Profile Control Window](image)

   This window displays information about the existing profile types.

2. To view the details of a particular profile, double-click on it. The **Profile Maintenance** window appears, as shown:

   ![Profile Maintenance Window](image)

   For information about each of the tab folders and the objects in them, see the online help.

3. To create a new profile, click **Add record** from the toolbar.

   For information about creating users, see Chapter 3, “Setting Up Basic Security Options.”
The Progress Dynamics security feature is powerful and flexible. It lets you set security on many types of objects and levels, such as objects, menus, fields, data ranges, actions, and data. You can set up security for specific users or all users, specific companies or all companies, and any combination of the above. In addition to this, you can define restrictions globally or for a specific product module, for a specific object, or for an instance of an object. Your application’s security policy can be as simple or as complex as you choose.

This chapter provides an overview of security and describes the basic options for managing and securing your Progress Dynamics installation. It includes the following sections:

- Setting global security and management options
- Choosing a security model: grant or revoke
- Setting up user authentication
- Defining login companies
- Defining security groups
- Creating and maintaining users

For information on security allocations, action security, field security, and data range security, see the chapter on defining security in *OpenEdge Development: Progress Dynamics Basic Development*. 
Setting global security and management options

When you first start up Progress Dynamics, you might want to set some general options that govern the operation of sessions that run there. A table in the Progress Dynamics Repository (gsc_security_control, entity mnemonic GSCSC) maintains settings in a single record used to control an entire session. These settings include basic options for managing the user interface and security control.

Notes:  Progress Dynamics only secures objects in the application. If you want to secure database access or files in the operating system, see OpenEdge Data Management: Database Administration. For a broader discussion of securing applications, see OpenEdge Getting Started: Core Business Services.

All session data, including data used for session startup and security, is typically stored in the Progress Dynamics configuration XML file (icfconfig.xml). You can make this startup and security data more secure, especially if you maintain it outside the Repository, by importing any changes to the configuration file into the secured Repository. For more information, see the sections on importing the configuration file in Chapter 2, “Defining and Managing Sessions.”

To access the global options for Progress Dynamics session security and management, choose Security→Security Control from the Administration window.

Progress Dynamics displays the Security Control window, as shown in Figure 3–1.

Figure 3–1: Security Control window

Note:  Progress Dynamics allows only one record in the gsc_security_control table. So, the Add record button is disabled in the toolbar. However, you can modify the existing record, which enables you to save any changes you make in this window.
For security, the important settings include:

- **Security Model** — Lets you define whether you want to use a revoke or a grant security model for your entire application. For more information on this option, see the “Choosing a security model: grant or revoke” section on page 3–4.

- **Login filename** — The name of the login program to run. By default, this is `af/cod/gsmus1ognw.w`, and it displays the default login window, as shown:

![Login Window](image)

- **Password max. retries** — The maximum number of times a user can enter a password incorrectly before the user’s account is disabled.

- **Password history life time** — The number of days to keep and check the password history. The default value is 365 (one year). The password history is a log of when and who changed a user’s password. To see the password history for a user, choose Security Maintenance → Users, then choose the Password History tab.

- **Security enabled** — Specifies for Progress Dynamics to perform security checks.

- **Force unique password** — Specifies that the password for every user must be different from the passwords used by all other users. This option allows Progress Dynamics to locate a user’s record with just a password.

- **Program access check** — Specifies that the system checks whether a program is already running for a user. This restricts the user to running only a single session of a program.

- **Multi user check** — Specifies that the system should ensure that a user does not log in more than once. A user can only log in once per user id.
Choosing a security model: grant or revoke

Your first step in setting up security for your application is to decide whether to implement a grant or revoke model. As a general rule, if you want to hide a large part of your application system from most of your users, use a grant model. Conversely, if most of your users must see most of your application, use a revoke model (the default). However, as each application differs, you must decide what makes sense for your particular application. Consider the following implications of your decision:

- Once you have set up security against a model, you cannot change the model unless you first delete the existing security setup (by clearing all security allocations in your application). Make sure you decide on the correct model before you start to implement security.

- The security model you choose applies to your entire application. As administrator, you can implement either a grant strategy or a revoke strategy for your application, but you cannot combine both in the same application.

The following sections provide more details about each type of security model.

Revoke model

The default security model is the revoke model. Users have access to all functions by default, and you revoke access as necessary.

In a revoke model, you must revoke access in every security group to which the users are linked. If you do not revoke access in all security groups to which the users are linked, they will have access. If you revoke access differently in different groups, the users get the least restrictive access.

For an example of how the revoke model relates to security groups, see the “Security groups and the revoke security model” section on page 3–11.

Grant model

By default, in a grant model users have no access, unless you define specifically how they have access.

In a grant model, users gain access if you have granted them access to any of the groups to which they are linked. If you have granted access in more than one group, the users get the least restrictive access.

In applications where only a small part of the application is visible to the user, the grant security model reduces the effort in setting up security for a new user. Instead of revoking security rights to most of the options in the application, it will only be necessary to grant rights to a small part of the application.

Field security and action security have the potential to create huge numbers of records in the database if you use a grant strategy, as you will need to grant access to every single field and action in the system. To prevent field and action security from becoming unusable, Progress Dynamics only checks them if you have set the applicable security field or action in the database. For example, in the grant model, if you have not set security on a particular field in the database, all users will be able to access that field. As soon as you set up security for the field, you will have to grant access to all users who need to access it. The same rule applies to action security.
In a grant model, keep in mind that you might have to grant access to more than one object to allow a user to access certain functionality. For instance, for a menu item, the user needs access to the parent menu structure, the menu item itself, and the object that is launched by the menu item. If you do not grant access to all of these objects, the user will not have access to the menu item.

For an example of how the grant model relates to security groups, see the “Security groups and the grant security model” section on page 3–12.

**Specifying a security model**

Make sure to make all the design decisions necessary so that you have the right security model at the beginning of your development cycle.

To specify the security model for your application:

1. If you are changing your existing security model, make a backup of your application database.

2. Open the Security Control window, as shown:

3. If you are changing your existing security model, click **Clear Security Allocations**. An alert box appears, warning you about the implications of choosing this action.

4. Click **Yes** in the alert box.

5. Select either **Revoke** or **Grant** from the **Security Model** radio set, then click **Save**.
Setting up user authentication

User authentication establishes the requirements for users to login and run your application. You generally set up user authentication by registering and maintaining users in the gsm_user table (entity mnemonic, GSMUS). Registering a user includes specifying all the security information that is associated with a user of your application, including such items as login name, password, default login company, and user category.

A user always belongs to some user category (if user categories are defined) and can be a default member of a login company. You must create any user categories and login companies before you use them to register a user. Both of these settings originate from values stored in corresponding Repository tables, as described in this section.

You can also define user profiles by specifying certain types of data to be associated with users of your application in some way. While not strictly a security feature, user profile data are part of the criteria that define a Progress Dynamics user. Thus, this section describes user profile data as part of the user definition process.

When you register users of your application, you might need to perform some or all of these tasks:

- Define user profile data types that your application can use to associate certain session settings with each user.
- Define user categories.
- Define companies.
- Define security groups.
- Create and maintain users.

The rest of this section describes these tasks.

Defining user categories

A user category is a value that you define for your application and that you assign to users. If you define any user category values, you must assign one of these values to each user that you register. Your application can use this value for any purpose that it finds useful. Because all users are assigned one of the defined values, your application can respond to all users assigned the same value in the same way. For example, the application might respond in one way for expert users and another way for novice users. You can also have Progress Dynamics restrict all access to users based on their user category.
User categories are stored in the `gsm_user_category` table (entity mnemonic `GSMUC`) and keyed from the `gsm_user` table by `user_category_obj`.

To define or review user categories:

1. In the Security Control window, choose **Security control** → **Security maintenance** → **User categories**. The User Category Control window appears in the right frame, as shown:

2. You can select and modify an existing user category or click **Add record** from the toolbar to create a new one.

3. Click **Save record** to save your changes.
Defining login companies

Login companies are organizations in which the user might be a member. When you set up object access restrictions, you can define access restrictions based on the user, the login company, or both in association. Progress Dynamics also uses login company information as part of its automatic reference number (sequence) generation. An example of login company security usage is in managing application access for different corporate clients of an Application Service Provider (ASP). Another example might be in managing users logging into the same corporate financial application on behalf of different subsidiaries.

You can register a user to be associated optionally with a specific company by default. Using the standard login dialog box, the user can also choose an association from the available companies during log in. Based on the login company field, you can customize your application’s appearance and security according to the company the user specifies. Progress Dynamics checks login company security automatically when a user logs into the system. The existence of a security allocation record indicates whether access to the allocated login company is granted.

When you link users to security groups, you can specify the login company to which the security group applies for that user. So even though a security group is valid for all companies, if it is applicable only in a certain company for a certain user, Progress Dynamics only applies security when the user logs into the specified company. If other users are linked to the security group, security is still applied for them for all companies.

Login companies are stored in the gsm_login_company table (entity mnemonic GSMLG) and keyed from the gsm_user table by default_login_company_obj. The information stored in this table is the minimum to identify a company in the Progress Dynamics environment. Typically, an application stores additional company information, such as address and other contact information, in a database external to the framework. When you integrate such an application with Progress Dynamics, you typically define gsm_login_company fields that you can use to key into your application database to access the corresponding company information.
To define or review login companies:

1. Choose **Security Control**→ **Security Maintenance**→ **Login Company**. The **Login Company Maintenance** frame appears, as shown:

![Login Company Maintenance Frame](image1.png)

2. Click **Add record** to add a new login company (for example, Nutrition Support Systems, Inc.). The fields in the **Details** tab become enabled.

3. Click **Save record**. The browse displays the new login company, as shown:

![Login Company Details](image2.png)
Defining security groups

Progress Dynamics implements security groups. Security groups allow you great flexibility, permitting you to set up any security structure. You can assign users to multiple security groups, and in turn you can link a security group to one or more other security groups. User permissions are accumulated from all groups a user belongs to, and from all groups to which those groups, in turn, belong.

**Note:** Progress Dynamics does not use security hierarchies. In a security hierarchy, you cannot consolidate security groups in different levels in the hierarchy, and you can only assign groups at the bottom of the hierarchy to users. As you must assign each security group to the user individually, a hierarchical approach results in increased administration. A security hierarchy incurs a high performance overhead, as the hierarchy must be navigated every time security rights need to be determined.

**Consolidated groups**

Consolidated groups are security groups that exist only to group other security groups. You can then assign these consolidated security groups to users. These consolidated groups do not have any security allocations against them directly. Use consolidated groups to simplify security administration. You do not need to flag them in any way. Progress Dynamics assumes that a security group is a consolidated group if it is linked to one or more other security groups but does not have security allocated specifically against it. For example, instead of having to allocate several groups to every user, you can create a consolidated group and link the allocated groups to it. You can then assign just this one consolidated group to every user.

**Note:** Progress Dynamics assumes that security groups with no security allocated against them exist only to consolidate other security groups into one security group. Progress Dynamics does not look at consolidated groups (that is, any group that has no security allocated against it) when it checks security.

**Least restrictive rule**

Users belonging to multiple security groups must perform all the actions required in each group. If one group grants less access than another, or revokes access granted in another, the users will not be able to perform all the actions necessary for one of their roles. For this reason, the least restrictive security option always takes precedence, giving users all access necessary to perform their roles.

If security allocations from different security groups contradict each other, Progress Dynamics uses the least restrictive security allocation. For example, if you have secured a field as Full Access in one security group, and Read Only in another security group, Progress Dynamics will grant Full Access.

In a grant model, the users gain access if they have been granted access in any of the groups they are linked to. If they have been granted access in more than one group, they get the least restrictive access.

In a revoke model, you must revoke access in every group to which the users are linked. If access has not been revoked in all security groups the users are linked to, they will gain access. If access has been revoked differently in different groups, they get the least restrictive access.
Defining security groups

Security override rule

Security that you set up at the user-level always overrides security set up at the group-level. This rule lets you set up user-specific exceptions. This rule means that if you allocate any security against the user directly, the system will use that security immediately. The system will not do any further checks against the security groups to which the user belongs.

Where you specify security at the user level, Progress Dynamics ignores the security specified at the security group level.

Security groups and the revoke security model

Figure 3–2 provides an illustration of how security groups work in the Revoke security model.

![Figure 3–2: Revoke model example](image)

In this revoke model example, Groups A and C are consolidated into Group AC. Groups AC and B are consolidated into Group ACB.

The following scenarios describe how this example revoke security model works:

- A user belonging to Group B has full access to field `user_login_name`, but does **not** have access to the `Modify` and `Details` actions.
- A user belonging to Group AC has read-only access to the `user_login_name` field. Because of the least-restrictive rule, the user does **not** have access to the `Add` action, but does have access to the `Details` and `Modify` actions. (Access to an action would have to be revoked in both A and C for it to be revoked in AC.)
- A user belonging to Group ACB, has full access to the `user_login_name` field. Because of the least-restrictive rule, the user has access to the `Add`, `Modify`, and `Details` actions.
Setting Up Basic Security Options

Security groups and the grant security model

Figure 3–3 provides an illustration of how security groups work in the grant security model.

![Diagram of security groups and the grant security model]

Figure 3–3: Grant model example

In this grant model example, as illustrated in Figure 3–3, Groups A and C are consolidated into Group AC. Groups AC and B are consolidated into Group ACB.

The following scenarios describe how this example grant security model works:

- A user belonging to the Default Security Group and Group C has access to:

  - The Login screen, Exit button, Default menu, Field \texttt{user\_login\_name} (Hidden), Action Delete, and data security customer.

  - All actions and fields not set up in the General Security Manager (GSM) \texttt{gsm\_token} and \texttt{gsm\_field} tables.

- A user belonging to the Default Security Group and Group AC has access to:

  - The Login screen, Exit button, default menu, \texttt{user\_login\_name} field (read-only), Action Add, Action Details, Action Delete, and data security customer.

  - All actions and fields not set up in the \texttt{gsm\_token} and \texttt{gsm\_field} tables.

- A user belonging to only Group ACB has access to:

  - Menu Item Product Control, Action Modify, data range Customer, \texttt{user\_login\_name} field (read-only), Action Add, Action Details, Action Delete, and data security customer.

  - All tokens and fields not set up in the \texttt{gsm\_token} and \texttt{gsm\_field} tables.
In this example, this group affiliation would not be of much use, as the user cannot access the login screen. To resolve this problem, you could instead link the user to security group A and allocate field security directly against the user record: field user_login_name – Full Access. The user now has access to:

- User_login_name field (full access), Action Add, Action Details.
- All tokens and fields not set up in the gsm_token and gsm_field tables.

Creating a new security group

To determine how to set up a security group for your application, identify which functions must be secured routinely for users performing the same function. Then create a security group and secure the applicable objects in that security group. For example, you might create a group for Sales Managers and another group for Sales Representatives.

Avoid trying to set up security based on how you anticipate a security group is going to interact with other security groups. Instead, regard each security group as a totally independent unit, and leave it to the system to accumulate and resolve conflicting security.

To set up a new security group:


2. Click Add record . The fields in the Details tab become enabled.

3. Enter the name and the description of the group.

4. Select the Default security group toggle box if you want all new users (that is, those you create after you save this toggle box setting) to be linked to this security group.

5. Click Save. The new security group appears in the browse at the top of the Security Groups Maintenance frame.
Creating a consolidated group

If you can identify security groups that are all going to be assigned to users performing the same role on a regular basis, consolidate the set of security groups into one security group. Then assign the one consolidated security group to your users.

To set up a consolidated security group:

1. Create a group.
2. Do not specify any allocations against the group.
3. Under the This group linked to groups tab, specify the groups you want to consolidate as subgroups of this group.

Creating a security group based on an existing user

You can convert an existing user into a security group.

Note: A user cannot log in as a security group.

To create a new security group based on an existing user:

1. Choose Security Control→Security Processing→Group Processing. The Create security group from user frame appears, as shown:

   ![Create security group from user](image_url)
2. In the User field, specify the user on whom you want to base the new security group. The utility will move the security allocations from the user you specify to the new group.

   If the user that you specify is a profile user, then the utility moves (to the new group) only those security allocations that the profile user and all users based on the profile user share in common. The utility leaves alone any allocations that are not common. The utility then links the profile user, and all users based on the profile user, to the new group.

   If you specify a user who is not a profile user, then the utility moves all security allocations from the user to the new security group and then links the user to this new group.

3. Type in the New security group name.

4. Click Process.

Specifying default security groups

You can specify default security groups. Determine the default functionality to which every user in your system needs access (for example, the login screen). Allocate this security to a security group, and save it as a default security group. All users in your system will automatically have access to the functionality defined in the default group. Also, when you add a new user to the system, the framework automatically links the new user to any default groups.

To create a default security group:


   2. Select an existing group or click Add record to create a new group.

   3. In the Details tab, select the Default security group toggle box, then click Save.

      Whenever you create a user, the framework automatically links the new user to this (and any other) default security group.
Setting Up Basic Security Options

Linking a company to a security group

When you create a group, you can link the group to a specific login company. In addition, when you link users to groups, you can specify that a security group only applies when the user logs into a certain company. This functionality lets you specify what functions the user fulfills in different companies. Alternately, you can specify that a security group applies application-wide.

For all security groups you have created, decide if the security group applies to only certain login companies in your application, or all. If only to certain login companies, link the applicable security groups to those companies.

Of the security groups allocated to your users, check if certain security groups only apply to that user when logging into a specific company. Update the security group allocation to indicate which security groups apply to which companies for which user. By default, the security groups allocated to a user will apply for all companies the user logs into.

Linking users to a security group

Decide which security groups apply to which users, then link them. If you want to override security set up in the security group for a single specific user, allocate the security against the user directly. Remember, for security allocated directly to a user, the security set up against the user’s security groups is not checked.

When you link security groups to a profile user, the users based on that profile user will also be linked to the security group.
Creating and maintaining users

Once you have defined user categories, login companies, and security groups, you can create and maintain users via the Users node of the Security Control window. Through this window, you can set and review various types of profile data and security restrictions that are in effect for a given user. You can also cascade certain profile and security data associated with one user profile to other user profiles that are based on the initial user profile.

To create or review user records:

1. Choose Security Control→ Security Maintenance→ Users. The User Maintenance frame appears, as shown:

2. Click Add record on the toolbar.

3. For the User login name, type the name you want the user to enter when logging into a session. For example, type lthomas. (The login name is not case sensitive.)

   For User full name, type the user’s first and last name. For example, type Liam Thomas.

4. Specify a User category.
5. Assign any of the following categories by selecting the appropriate toggle boxes:

- **Profile user** — When checked, you can use this user’s profile as a base for creating other user profiles. If you check this toggle box and then click **Save**, this user’s name will appear in the **Based on profile** lookup dialog box. Any user whose profile is based on this profile can automatically inherit certain profile and security settings. To implement this type of inheritance, you initiate a cascade of the data from the profile user by clicking **Cascade** on the **Cascade** tab. See the “Cascading information from a profile user to individual users” section on page 3–20.

- **Development user** — When checked, this user can access system development functions.

- **Maintain system data** — When checked, this user can maintain system control data.

6. If you want to base the new user’s profile and security settings on an existing profile user’s settings, click **Lookup** for **Based on profile** and select a profile user.

7. Select a **Language**, such as **EN-US**.

8. Specify a **Login Company**. For example, click **Lookup** and select **Default Co**.

9. Leave the other fields at their default values or change them as needed. For more information on all the fields in this window, press **F1** to see the online help topic.

10. Click **Save**. The new user appears in the browse at the top of the **User Maintenance** frame, as shown:

![User Maintenance Frame](image)

To make sure that the new user was saved properly:

1. Exit the **Security Control** window.

2. From the **Administration** window, choose **File** → **Re-Logon**.

3. In the **Application Login** dialog box, enter the name of the new user, then click **OK**.

Verify that you are now logged in as the new user by checking the name in the status bar of the **Administration** window.
Creating and maintaining users

Setting a user’s password

Change passwords with the Security Maintenance node.

To set or change a user’s login password:


2. In the browse of the User Maintenance frame, select the user whose password you want to change.

3. In the Details tab, click the Blank buttons next to the User password and Confirm Password fields to clear them, as shown:

4. Enter the new password in the User password and Confirm Password fields, then click Save.

Viewing a user’s password change history

Progress Dynamics maintains a history of password changes in the `gst_password_history` table (entity mnemonic GSTPH). You can review this history for each user to see the date and time a password was changed, as well as the user who changed it.

To see information about changes to a user’s password, choose the Password History tab in the User Maintenance frame.

Defining a user as a profile user

In addition to security information, each user has associated session profile data that is maintained in the `gsm_profile_data` table (entity mnemonic GSMPF). This includes such information as window sizes and positions, filter criteria for database queries, and any other information that you want maintained for users during application sessions. You define the types of profile data maintained for your application using the Profile Control utility available from the Administration window’s Session menu.
For more information on how to maintain profile data types, see Chapter 2, “Defining and Managing Sessions.” For information on managing profile data in your application, see *OpenEdge Development: Progress Dynamics Basic Development*.

To define a user as a profile user:

1. Choose **Security Control**→**Security Maintenance**→**Users**.
2. In the **Details** tab, select the **Profile user** toggle box, as shown:

![Profile user toggle box](image)

3. Click **Save** in the toolbar.

4. To verify that **Liam** is now considered to be a profile user, click **Lookup** for the **Based on profile** field. The **Lookup Profile User** dialog box appears. Notice that **Liam Thomas** is listed as one of the users in the browse, as shown:

![Lookup Profile User dialog box](image)

**Cascading information from a profile user to individual users**

When you update a profile user’s security options, you can specify to also update the security options for all users based on that profile user. When you update a profile user, you can specify which security settings you want to cascade down to users based on the profile user.

For example, because you have defined Liam’s profile to be based on the admin account, the next thing might be to pass certain common user settings to Liam based on the admin account.
To cascade information from a profile user to individual users:


2. Select a profile user in the browse whose security or profile data you want to cascade down to linked users, then choose the Cascade tab, as shown:

3. In the Cascade tab’s browse, select the rows for the settings you want to cascade. (Hold the CTRL key to select more than one.)

4. Click Cascade to allow all users based on the current profile user to inherit the selected access restrictions and profile data. A confirmation box appears, as shown:

5. Click Yes to cascade the settings.

The Cascade operation passes the selected access restrictions and profile data to all users that are based on the current profile user. If a user who inherits the cascaded settings is also a profile user, the settings cascade to all users based on that profile user. This process continues through all the profile users that exist in the cascade tree.

**Linking users and security groups**

There are two ways to link users and security groups:

- You can create or update a group and then specify all users that belong to that group.
- You can create or update a user and then specify all the groups to which that user belongs.
Your first step might be to review the security setup as it exists. When setting up user security, you can use the Security Enquiry tool to determine what security is going to be applied to each user.

You can use this tool to determine where user security needs to override group security and only allocate the necessary security allocations to the user. You can query exactly what security would be applicable to a user per login company. Furthermore, you can query all security set up against each object for each security type. For more information on using the Security Enquiry tool, see *OpenEdge Development: Progress Dynamics Basic Development*.

To access the Security Enquiry tool, choose **Security Control**→**Security Enquiry**→**Security Groups**, as shown:
To allocate a specific user to one or more groups:


2. Select a user in the browse of the User Maintenance window in the right frame, then choose the User Linked to Groups tab, as shown:

3. Use the buttons in the toolbar of the Allocated to Groups tab folder to add or modify the groups linked to the current user.

4. Click Save to save any changes you make.
To identify all of the users in a specific security group:


2. Select a group in the browse of the **User Maintenance** window, then choose the **Users/Groups linked to This Group** tab, as shown:

3. Use the buttons in the toolbar of the **User Allocation** tab folder to add or modify the users or groups linked to the current group.

4. Click **Save** to save any changes you make.
Progress Dynamics provides a number of management functions to support application features that are built into the framework. As with the framework in general, these functions reduce the coding effort required to provide the supported features in an application. In some cases, you do not need to provide any extra coding to make the features available, while in others the management functions described in this chapter allow you to define properties or behavior for the features that you can access from your code. In general, these are generic features that you enable for access in all of your application objects, rather than to implement a particular object or function.

The following sections describe:

- Specifying gapless sequences
- Defining languages, countries, nationalities, and translations
- Adding generic database comments and auditing
- Specifying multi-media types
- Defining application categories
- Maintaining user-defined status information
- Exporting data through Print Preview
Specifying gapless sequences

The General Manager provides a generic mechanism for generating reference/sequence numbers for application records without holes in the sequence numbers. ABL sequences cannot be used for this purpose since holes can occur with ABL sequence numbers.

Note: When a sequence number is required during record creation, it should be created at the end of the update as part of the transaction. Such transactions are potential bottlenecks, and locks on the affected table should be kept to an absolute minimum.

Sequence Control window

You use the **Sequence Control** to define any sequences that you reference in your application. As described in the previous section, these sequences are automatically defined in and generated from one of the two Repository databases, depending on your Repository configuration.

To define sequences, choose **System → Sequence Control** from the **Administration** tool’s menu bar. This opens the **Sequence Control** window, as shown in **Figure 4–1**.

![Figure 4–1: Sequence Control window](image)

Like most control windows installed with Progress Dynamics, it contains a single browse that controls access to the records of a query, in this case, records that define gapless sequences and reference numbers for use in your application. You can use the toolbar at the bottom of the control window (a standard TableIO toolbar) to add new records or to delete, copy, edit, or view a currently selected record. Any add, edit, or view function opens the **Sequence Maintenance** window, with fields initialized and displayed according to the selected row and function (default values for an add record).
Sequence Maintenance window

The Sequence Maintenance folder window, shown in Figure 4–2, allows for editing of all the fields for a sequence.

Figure 4–2: Sequence Maintenance window

The Sequence TLA field refers to a unique three-letter-acronym which, in conjunction with the Entity Mnemonic field, forms the composite key. Thus, each mnemonic can have multiple sequences.

The Sequence format field contains a user-defined format mask for the sequence. The format mask must include a numeric format that allows for the maximum value and that conforms to the database format rules (for example: 99999999 = eight-digit number with 0 prefix).

The format can include hard-coded characters (for example PO for purchase order). The format can also include insertion codes to dynamically insert data at run time, as follows:

- %Y = Insert the last digit of the current year
- %YY = Insert the current two-digit year
- %YYYY = Insert the current four-digit year
- %MM = Insert the current two-digit month
- %MMM = Insert the current three-character month
- %DD = Insert the current day of the month
Defining languages, countries, nationalities, and translations

Progress Dynamics provides both a development and a user run-time translation capability for application localization. That is, you can define codes for languages, countries, and nationalities. You can also provide translations for all of the UI widget labels, ToolTips, and even constant data for an application as you develop it. After you have deployed an application, users can modify or create the translations for the UI of any window they happen to be using. Menu translations are easy with a feature exclusive to the Toolbar and Menu Designer. The following sections describe how to use all of these localization options.

Language Control window

To define a language, choose Application → Language Control from the Administration tool’s menu bar. The Language Control window, as shown in Figure 4–3, opens displaying a list of the currently defined languages.

Figure 4–3: Language Control window

To add another language, choose File → Add record. The Language Maintenance window appears.
Language Maintenance window

The Language Maintenance window has two fields that specify a language.

As shown in Figure 4–4, you are adding German to the supported languages, using the English name for the language as the unique Language code, and you are entering the German name (Deutsch) as the Language name for your German users.

![Language Maintenance - New window](image)

Figure 4–4: Language Maintenance - New window

After you save, the new record appears in the Language Control window.

Country Control window

To define a country, choose Application→Country Control from the Administration tool’s menu bar. The Country Control window, as shown in Figure 4–5, opens displaying a list of currently defined countries.

![Country Control window](image)

Figure 4–5: Country Control window

To add another country, choose File→Add record. The Country Maintenance window appears.
Country Maintenance window

The **Country Maintenance** window allows editing of all the fields to specify a country. As shown in Figure 4–6, you are adding German words for the address labels.

![Figure 4–6: Country Maintenance window](image)

After you save, the new record appears in the **Country Control** window.

Nationality Control window

To define a nationality, choose **Application→Nationality Control** from the **Administration** tool’s menu bar. This opens the **Nationality Control** window, as shown in Figure 4–7.

![Figure 4–7: Nationality Control window](image)

To add another nationality, choose **File→Add record**. The **Nationality Maintenance** window appears.
Nationality Maintenance window

The Nationality Maintenance window, as shown in Figure 4–8, has two fields that specify a nationality. In Figure 4–8, you are adding German as a supported nationality.

Figure 4–8: Nationality Maintenance window

After you save, the new record appears in the Nationality Control window.

Setting translation preferences

If your application uses containers with multiple pages and you want to translate their items, check the Initialize all pages when translating option in the Dynamics Preferences dialog box, shown in Figure 4–9.

Figure 4–9: Dynamics Preferences

To access the Dynamics Preferences dialog box from the Administration window, choose File→Preferences.

Set this option before you open the Translation Control window to ensure that all translatable items are shown in the list presented in the Translation Control window.
Supporting Built-in Application Features

Translation Control window

To create language translations for text objects during development, choose Application → Translation Control from the Administration tool menu bar. This opens the Translation Control window, as shown in Figure 4–10.

![Translation Control window](image)

Figure 4–10: Translation Control window

If you do not see all the fields for a container, make sure that you set the Initialize all pages when translating option in the Dynamics Preferences dialog box. See the “Setting translation preferences” section on page 4–7 for more information.

Translation Maintenance window

The Translation Maintenance window, as shown in Figure 4–11, allows for editing of all the fields to specify a translation for a specific widget label. This example shows a translation for the Administration window title.

![Translation Maintenance - Administration window](image)

Figure 4–11: Translation Maintenance - Administration window

The listed valid widget types are Browse Column, Button, Combo Box, DataField, Editor, Fill In, Global translation, Radio Set, Slider, Tab Folder Page, Text, Toggle Box, and Window Title. (You cannot create a translation label for Text widgets in dynamic viewers.) Also notice that the Translation Maintenance window allows for translations of ToolTips as well as widget labels.

**Note:** You cannot specify widget labels longer than 60 characters.

See the online help for information about the fields in the Translation Maintenance window. After you save the result, the new translation appears in the Translation Control window.
User run-time translations with the Translate Window

If the Progress Dynamics installation administrator has enabled translation using the Security Control (see Chapter 1, “Overview of Progress Dynamics Administration”), any users running an application can enter their own translations for text objects if they do not like the ones that they see. Every window container has a Translate item on the File menu that opens the Translate Window tool, as shown in Figure 4–12.

![Translate Window](image1)

**Figure 4–12:** Translate Window for user run-time translations

This tool is a Progress Dynamics folder window with a static updateable browse. This browse shows all the translatable widgets that are in the window from which the user opened the Translate Window tool. Most of the fields are read only. Those fields that the user can change take effect only if translation is enabled for the installation. Otherwise, any attempts to change them are ignored.

**Figure 4–13** shows the user changing the existing valid translation to a nonsensical one.

![Translate Window with new translation](image2)

**Figure 4–13:** Translate Window with new translation
The next instantiation of the Administration window opens with the new translation, as in Figure 4–14.

![Figure 4–14: Administration window with run-time translation](image)

**Menu translations**

To translate menu items, you use the Toolbar and Menu Designer tool.

To translate a menu item:

1. From the AppBuilder main window or from the Development window, choose Build → Toolbar and Menu Designer, as shown:

![Toolbar and Menu Designer](image)

2. Choose the Item Category that you want to translate.
3. In the Toolbar and Menu designer, click Translate Menu Item. The Menu Item Translation window appears, as shown:

4. Select the From language, which is called the 'source language'. The source language lets you specify the default language of a menu item. Due to the global nature of Progress Dynamics, the language in which an application is developed is the source language.

5. Select a row in the browser for the text element you want to translate.

6. For a short translation, type the text directly in the updateable browse. Alternatively, for a longer translation, enter the text in the text editors below the browse.

7. Click Save.

Entity translations

Translations in the previous sections apply primarily to field labels associated with specified visual objects at run time (widget translations), such as browser columns and widget objects on viewers. You can also specify translations (entity translations) at the entity object (DataField) level of an entity, no matter what visual object displays them.
Progress Dynamics makes entity translations available to dynamic browser (DynBrow) and dynamic viewer (DynView) objects that are linked to dynamic Progress SmartDataObjects™ (DynSDO), and also to DynView objects linked to a static SDO. Entity translations also apply to the field labels displayed in the standard Progress Dynamics Lookup or Filter browser. If DataField objects with entity translations are used by visual objects that have widget translations, the widget translations override any entity translations when the fields are displayed using these visual objects.

**Note:** Automatic resizing and positioning of widgets to accommodate translated labels does not occur when using entity translations. When using entity translations, you must provide enough layout space to display the translated labels to avoid overlapping fields.

You can specify entity translations using these tools:

- Translation Maintenance tool
- Migrate Widget Translation tool

**Using Translation Maintenance**

The Translation Maintenance window allows you to manually specify entity translations for individual fields similar to widget translations. (See the “Translation Maintenance window” section on page 4–8.) Specify the field values in this window as you do for widget translations, except for the following fields:

- **Object name** — The name of the entity where the translated field resides

  **Note:** Be careful not to select a field name in the lookup. Select only the name of an entity. You can eliminate field names from the selection by using the lookup filter with the **Object type code From** and **To** values set to **Entity**, along with other filter settings, such as appropriate **Object filename** values.

- **Widget type** — DataField

  **Note:** The value, **Global translation**, specifies a single widget translation that applies to all visual objects that display values for the specified field.

- **Widget entry** — 1 specifies to translate the field label; 2 specifies to translate the field column label

- **Original tooltip** — Not used (blank)

- **Translation tooltip** — Not used (blank)
Using Migrate Widget Translation

The Migrate Widget Translation tool allows you to automatically convert existing widget translations to entity translations for specified entities in specified databases. You also have the option to remove any existing widget translations and to skip entity translation for any fields that have multiple widget translations.

The Migrate Widget Translation tool is separate from the AppBuilder tools. To use this tool, run the afmigtrnw container with the Dynamic Launcher (Compile → Dynamic Launcher from the AppBuilder window).

Testing the new translation

You can test a new translation immediately after you have saved it.

To test the translation from the previous example:

1. Choose File → Re-Logon from the Administration window. The Application Login dialog box appears, as shown:

2. Select the language that you specified for the translation, and log in as before.

3. Open a new instance of the Administration window using either the Tools menu on the AppBuilder window or the Links menu on the existing Administration window. The new window opens, as shown:

Note: Because Progress Dynamics caches data on several levels, you might need to close and restart your session to refresh all the cached data and see your translations.
Adding generic database comments and auditing

Progress Dynamics provides built-in support for generic commenting and auditing on database records and transactions. Both the **Generic Comments** and **Auditing** features are available to any user, by default, on the Progress Dynamics browser toolbar (and control window **File** menu). Using the **Comments** feature, users can add their own comments to any record that they select in a browse, and specify additional options for how their comments are handled by Progress Dynamics. Using the **Auditing** feature, users can display any audit records that have been generated from transactions on the selected browse record. As with any Progress Dynamics application function, you can create security restrictions to prevent certain users from accessing either feature.

The following sections provide more information on these features of the Progress Dynamics UI, including how to use them and make them available to application users.

**Generic comments**

Throughout an application, the ability to attach memos or comments to various data records in the application might be required. As this functionality can be required on one or many of the tables in an application, a generic method is available to accomplish the storing of additional information against a record, such as comments or memos. Using the **Generic Comments** feature, this functionality is available on all tables in an application without any application database or code changes.

The **Comments** functionality is added to the standard ADM2 and is therefore generically available throughout any application built using the framework. For more information, see *OpenEdge Development: ADM Reference*. The use of **Generic Comments** on a table requires that one or more fields in a unique index uniquely identify a record.

**Adding comments to a record**

Comments provide an invaluable record for future reference.

To add comments to a record:

1. Open a control window with a browse containing the record you want to comment, For example, from the **Application** menu, open the **Language Control** window, as shown:
2. Click **Comments** in the browser toolbar or choose **File→Comments** from the menu bar. The **Comments Control** window appears, as shown:

![Comments Control](image)

3. Click **Add record** on the toolbar. The fields in the viewer are enabled.

4. Fill in the fields, using the online help for descriptions of each field.

5. Click **Save**. The new comment appears in the **Comments Control** browse, as shown:

![Comments Control](image)
Accessing a commented record

When you select a record with comments, the Comments icon changes to include a red checkmark. You view the comment in the Comments Control window. If you set the Auto Display property, the comment displays in an information box whenever someone accesses that record.

To trigger the Auto Display of a comment on a record:

1. Select the record in the browse, as shown:

   ![Image 1](image1.png)

   Note: The Comments button on the browse toolbar displays with a red check mark when you select a record with a comment.

2. If you open the record for viewing a Comment information box appears, as shown:

   ![Image 2](image2.png)

3. After dismissing the Comment information box, the viewer appears displaying the record, as shown:

   ![Image 3](image3.png)
Adding generic database comments and auditing

If you modify the record in the viewer, the same comment box appears when you save the changes.

**Generic auditing**

Throughout an application, various data entries can be added, modified, or deleted. For security and other auditing-related reasons, there must be a way to track these changes by keeping a history of them. As auditing can be required on one or many tables in an application, Progress Dynamics provides a generic method to acquire and store the information.

Progress Dynamics includes a generic auditing procedure as a standard component of each database trigger. If auditing is enabled for the relevant table, Progress Dynamics automatically launches the audit procedure as part of trigger execution for a transaction on that table. Any application user can then review the audit history on a selected record by accessing the **Audit** function available on the browse toolbar (or **File** menu) of an control window.

---

**Note:** You can also run the auditing procedure manually from within your application business logic. For more information, see *OpenEdge Development: Progress Dynamics Basic Development*.

---

**Enabling auditing on a table**

You must activate a toggle box on the Progress Dynamics entity definition for the table.

To enable auditing on a table:

1. Choose **System→Entity Control** from the **Administration** menu bar. The **Entity Control** window opens, as shown:

   ![Entity Control Window](image)

2. In the browse, select the entity record for the table where you want auditing enabled and open it for update by choosing the **Modify** record function on the toolbar (or **File** menu). The **Entity Maintenance** folder window opens.
3. Activate the **Auditing Enabled** toggle box and save the record. From this moment, the audit procedure will execute for any transaction on the `gsc_language` table. The following example shows the `gsc_language` table enabled for auditing:

![Entity Maintenance - GSCLG](image)

**Triggering an audit entry**

Now that you have activated auditing for a table, you can test it.

To trigger an audit entry:

1. Choose **Application→Language Control** from the **Administration** menu bar. The **Language Control** window appears.
2. Select and open the **English** record for update.
3. Click **Modify record**, then make a change to the **Language name** field, for example append (Default) to the end, as shown:

![Language Maintenance - EN-US](image)

4. Save the record.
5. Close the **Language Maintenance** and **Language Control** windows.
Viewing an audit

You can view audits in the Audit Control window.

To view the audit on the record:

1. Choose Application→ Language Control from the Administration menu bar. The Language Control window opens.

2. Choose File→ Audit. The Audit Control window opens, as shown:

   ![Audit Control Window](image1)

3. Open the audit record for viewing. The Audit Details window opens, as shown:

   ![Audit Details Window](image2)

This is a view-only function, because audit records cannot generally be changed in a typical audit situation (whether for legal or other reasons). The Audit Action field is a code that indicates the trigger for the audit:

- **CRE** — CREATE trigger
- **AME** — WRITE (AMEnd) trigger
- **DEL** — DELETE trigger
Specifying multi-media types

Progress Dynamics provides a mechanism to define multi-media files that can be generically linked to any entity. These multi-media files can be of a specific multi-media type, such as bitmap, wave, audio/visual, and so on.

The Multi Media Type Maintenance suite of programs to define these types consists of a control window and a folder window in typical Progress Dynamics style.

Multi Media Type Control window

To specify multi-media types, choose Application→Multi Media Type Control from the Administration tool menu bar. This opens the Multi Media Type Control window, as shown in Figure 4–15. This example adds a multi-media type.

![Multi Media Type Control window](image)

Figure 4–15: Multi Media Type Control window

Like most control windows installed with Progress Dynamics, it contains a single browse that controls access to the records of a query, in this case, records that specify multi-media file types and the programs that create them. You can use the toolbar at the bottom of the control window (a standard TableIO toolbar) to add new records or to delete, copy, edit, or view a currently selected record. Any add, edit, or view function opens the Multi Media Maintenance window, with fields initialized and displayed according to the selected row and function (default values for an add record).

Multi Media Type Maintenance window

The Multi Media Type Maintenance folder window, as shown in Figure 4–16, allows for editing of all the fields for a multi-media type, in this case, for MS Word documents.

![Multi Media Type Maintenance window](image)

Figure 4–16: Multi Media Type Maintenance window
Once the type is saved in the **Multi Media Type Maintenance** window, it appears in the **Multi Media Type Control** window, as shown in Figure 4–17.

**Figure 4–17:** Multi Media Type Control window with new media type
Defining application categories

Progress Dynamics includes a generic mechanism for splitting any type of data into categories using a multi-purpose category table. It is often a common requirement to categorize data to multiple levels for filtering and reporting. This category table facilitates this, along with a mechanism to define valid value lists for use in an application.

Category definition structure

To define a category of data for a table, the related entity mnemonic of the category is assigned the entity mnemonic code for the table, which is the unique key to identify the table. For example, to define a category of comments from the gsm_comment table, the related entity mnemonic would be set to GSMCM, which is the unique code for the comment table. To define a category for valid value lists, the related entity mnemonic is assigned to SYSYS to indicate that it is not data related to a specific table. The SYSYS code is a system code that points to no particular entity.

Understanding category grouping levels

The category table supports the following three levels of grouping for data in a related table:

- Category type
- Group
- Subgroup

Subgroups can be logically sequenced within a group using an integer sequence number. The number of grouping levels used for a category and their meaning is dependant on the data being categorized. Categories that are required in order for an application to function can be defined as system owned.

Using an owning entity for the categorized table

There is another entity mnemonic in the category table called an owning entity mnemonic. This is only relevant if the table to which the category applies is generically joined to a second table using an owning object field. In this case, the owning entity mnemonic defines the table referenced by the owning object field.

An example of this use can be described with status codes. Progress Dynamics supports the definition of user-defined status codes to allow users to set up customized process flows. The category table is used to define the categories of statuses that are used in the application and defined by the gsm_status table. For example, categories can be set up for the available statuses for an account, such as open or closed.

When allocating a particular status to a record, the generic table gsm_status_history is used as the related table, which records the current status for a particular record in another table. This other table is referenced by a generic join on an owning_obj field. In order to identify what table this object field references related to this particular status, the owning entity mnemonic of the category (status) is defined. In this example, the owning entity mnemonic is the entity mnemonic for the account table, as these open and closed statuses pertain to records in the account table.
Categories used in and supported by Progress Dynamics

Progress Dynamics makes use of categories to facilitate the Generic Comments feature, multi-media file types (TreeView images), Status support, user profiles, custom procedures, and language text. For more information on Status support, see the “Maintaining user-defined status information” section on page 4–25.

The Category Maintenance suite of programs consists of a control window and a maintenance window in typical Progress Dynamics style.

Category Control window

To défining application categories, choose Application→Category Control from the Administration tool menu bar. This opens the Category Control window, as shown in Figure 4–18.

![Category Control window](image)

**Figure 4–18: Category Control window**

Like most control window installed with Progress Dynamics, it contains a single browse that controls access to the records of a query, in this case, records that define application categories that you can use to reference and organize related data in an application. You can use the toolbar at the bottom of the control window (a standard TableIO toolbar) to add new records, or to delete, copy, edit, or view a currently selected record. Any add, edit, or view function opens the Category Maintenance window, with fields initialized and displayed according to the selected row and function (default values for an add record).
Category Maintenance window

The **Category Maintenance** folder window, as shown in Figure 4–19, allows for editing of all the fields for a category.

![Category Maintenance window](image)

**Figure 4–19:** Category Maintenance window
Maintaining user-defined status information

Progress Dynamics supports a mechanism that allows you to organize the flow of data or processes in an application according to a system of status codes that you define. The General Manager provides an API for referencing this status information as part of an internal status tracking system that you can design and implement for your applications.

Progress Dynamics' status mechanism

Status information is organized into categories that are implemented using the Category Maintenance suite of programs. The actual valid status codes are set up in the category table, in part, thus:

- **Related entity mnemonic** — GSMST for gsm_status
- **Category type** — STS for Status
- **Category group** — HST for History
- **Category subgroup** — COD for Code

In this case, the category subgroup is the actual status. The categories of status are always system-owned and mandatory. The category mandatory flag is used to indicate whether an object at this status can be modified. For more information and a description of a status tracking example, see the “Defining application categories” section on page 4–22.

Information on adding status tracking

For more information on designing and implementing the internals of status tracking, see OpenEdge Development: Progress Dynamics Basic Development and the relevant General Manager API calls in OpenEdge Development: Progress Dynamics Managers API Reference.

The following sections describe how to define and maintain status codes for any status tracking system that you might devise. Progress Dynamics also provides a Status button on the browser toolbar for application users to view status indications on a selected record.

The Status Maintenance suite of programs for defining and maintaining status codes and histories consists of a control window and a maintenance window in typical Progress Dynamics style.
Status Control window

To maintain entity status codes and histories, choose Application→Status Control from the Administration tool menu bar. This opens the Status Control window, as shown in Figure 4–20.

Figure 4–20: Status Control window

Like most control windows, it contains a single browse that controls access to the records of a query, in this case, records that maintain status and status histories for selected entities in your application. You can use the toolbar at the bottom of the control window (a standard TableIO toolbar) to add new records or to delete, copy, edit, or view a currently selected record. Any add, edit, or view function opens the Status Maintenance window, with fields initialized and displayed according to the selected row and function (default values for an add record).

Status Maintenance window

The Status Maintenance window, shown in Figure 4–21, lets you edit the status fields.

Figure 4–21: Status Maintenance window
Exporting data through Print Preview

The standard Browse Toolbar includes a Print Preview button. This function allows you to export the displayed data as one of the following formats:

- XML (default)
- HTML
- Crystal Reports

Setting session properties

You must set this option in advance through session properties. Table 4–1 lists the session properties that control this function.

Table 4–1: Print Preview session properties

<table>
<thead>
<tr>
<th>Session property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>print_preview_preference</td>
<td>The format for the exported data. Valid values are the following: XML (default) HTML Crystal</td>
</tr>
<tr>
<td>print_preview_stylesheet</td>
<td>An XML or HTML style sheet to apply to the exported data. Progress Dynamics supplies the following default style sheets: src\dynamics\af\rep\xmlreport.xsl src\dynamics\af\rep\htmlreport.css</td>
</tr>
</tbody>
</table>
The default settings are specified in the Dynamics session type, as shown in Figure 4–22. The defaults are inherited by any session type that extends the Dynamics session type.

![Figure 4–22: Default Print Preview settings](image)

For more information on session type maintenance, see Chapter 2, “Defining and Managing Sessions.”

You can override the default setting for certain session types by adding the session property directly to the session type and assigning it a different value, as shown in Figure 4–23.

![Figure 4–23: Overriding Print Preview settings](image)
Using Print Preview

Suppose you are using the default session settings and you want to view the information for a logical service. The following procedure describes how you can do this.

To view logical service information using Print Preview:

1. Open the Logical Service Control window by choosing Session → Logical Service Control in the Administration tool.

2. Click Print Preview, as shown:

The Print Preview dialog box opens, as shown:

Note that the title bar indicates the type of output you are generating for Print Preview, in this example, XML. You can choose to view only the fields that are visible in the browser or all the fields that the browser contains.
3. If you want to view all fields, click **All Fields**, and the result (for XML) displays in your default Web browser, as shown:
Extending the Progress Dynamics Configuration Utility

As your Progress Dynamics application evolves, you have to deploy updates to your users. The first deployment is usually the easiest, since you do not have to protect any existing data. With any subsequent deployment, you are faced with the challenges of making the upgrade as quick and easy as possible while protecting your users’ existing data.

Each deployment has its own unique challenges. The Progress Dynamics framework provides some tools and techniques to aid you in managing your particular deployment issues. This chapter discusses the following aspects of deployment:

- Planning ahead
- Progress Dynamics Configuration Utility overview
- Deployment stages
- DCU XML files
- DCU API
- Creating a customized DCU deployment
- Running the DCU in batch mode
- Dumping and loading site-specific data
Planning ahead

Because deployment comes at the end of the production cycle, it is often not considered until the application is nearing its final version. However, this increases the risk of critical upgrade, integration, and quality control issues. If you want to make your applications easier to deploy, you should think about deployment at the beginning of the design process. For example, Progress Dynamics works best in configurations that use the AppServer. You should familiarize yourself with the best practices for distributing applications in an AppServer environment and use them while designing your applications.

Each deployment has its unique elements. Often, you must make trade-offs between competing factors. Which trade-offs you find acceptable might depend on what type of application you are designing. For example, a financial application would not want to reduce security to gain a little more performance.

A good practice to adopt is to create regular builds of an application throughout the development cycle. You can then test deploying the application throughout the development cycle. This allows you to notice issues and take corrective steps while your application design is more flexible.

The design of your application and the requirements of your deployment strategy impact each other. You might find that the design of a particular module of your application increases the complexity of your deployment. By redesigning the module, you might ease the deployment problems. For example, when calculated fields support was added to the Progress Dynamics framework, it had a significant impact on deployment. After seeing the deployment issues the new feature caused, the design of the feature was changed to take that into consideration.

Application design and deployment strategy are interlinked. For complex applications, a developer who understands the deployment process should be a lead contributor in the application design process. That developer would monitor the deployment aspects of all the application modules.

As Figure 5–1 shows, designing the application and designing the deployment strategy should be an iterative process.

Figure 5–1: Application design cycle
Development databases often contain test objects and other extraneous data. However, you only want to deploy the data necessary to run your application. You can simplify your deployment process by eliminating this extraneous data before you begin building a deployment.

To accomplish this, you can set up central Repository and application databases that are only used to build deployment files. Developers only promote data to this central Repository when it has been tested and is ready to deploy. With this arrangement, you do not need to spend as much time figuring out which data needs to be deployed while building your deployment files.
Progress Dynamics Configuration Utility overview

You saw the Progress Dynamics Configuration Utility (DCU) when you first installed Progress Dynamics. When you upgraded to another version of Progress Dynamics, the DCU ran again to upgrade your Repository. The DCU is the framework’s deployment tool. You can customize and extend it to deploy your applications as well.

The DCU presents upgrading Progress Dynamics applications as a wizard-style installation process. Its main task is to upgrade the Progress Dynamics Repository. However, the DCU is an ABL application. It has places where you can hook in other procedures to perform other upgrade tasks for your application.

Advantages of the DCU

The following sections briefly outline the advantages of the DCU.

Developed in ABL

The DCU is written in ABL and runs using the ABL Virtual Machine (AVM). This supports easy access to OpenEdge databases, especially the Repository, and makes upgrade programs easy to invoke.

Script-driven, customizable, and extensible

To enable you to create your own installs, the DCU is a framework in its own right. You can add more libraries to it, add or remove wizard pages, and change the display order of wizard pages. At the end of the wizard process, the data that is prompted for is available so that it can be used to drive the upgrade process.

Requires no database connection

Due to the complexity associated with installing a database, the DCU does not require any database connection to begin its functions. The DCU does connect to the databases you are upgrading or creating as required.

Does not require most managers

Just as it does not require any database connection, the DCU runs independently of framework managers such as the Session Manager, Profile Manager, or General Manager. The managers require database connections at run time to perform their tasks, so the DCU cannot rely on API calls to those managers.

Can be invoked from the command line

The DCU is invoked as the last part of the installation process. Since it runs outside the Progress Dynamics framework, you can invoke it from the command line.

Creates and updates databases

As part of setting up a new database or upgrading an existing one, the DCU applies schema changes to the database. The DCU applies these changes using the standard dictionary schema load program. When you create a new OpenEdge database, the DCU loads the initial data to populate the database from OpenEdge dump files created from the central Repository.
Can run update programs

Data in one version of an application must be altered to match schema changes in a newer version of the application. These alterations are often performed through update programs. The DCU is designed to support the running of update programs.

Writes list of updates to Repository

When you use the DCU to apply updates to databases, the DCU writes details of the updates to the Repository. There are two reasons for this:

- It provides the data required to continue the update process when you next connect to a Repository after running the DCU.
- It allows you to determine what updates have been applied to a Repository and any application databases.

Invokes load of Progress Dynamics datasets automatically

Once all the necessary changes have been applied to a Repository, the DCU automatically loads the application data into the Repository. This data is deployed using datasets (ADOs). The DCU automates the process for loading ADOs to avoid user error. Since the deployment dataset API requires the Progress Dynamics framework, this process runs when you next log into the environment after running the DCU.

Invokes post-login updates automatically

Beyond the dataset load, you might have other update programs that must run within the Progress Dynamics environment so that schema triggers can fire and calls can be made to the managers. The DCU can automatically initiate update programs both before and after loading ADOs.

Can be run unattended in batch mode

If an end-user site you want to update is maintained with limited on-site technical support, you might prefer to have the DCU perform its updates in a completely unattended fashion. You can do this by configuring the DCU to run in batch mode.

Can retain site-specific data during Repository updates

You might need to update a site that contains site-specific or nonstandard application definitions. Depending on your application update, it might well unintentionally remove or modify these site-specific definitions in the process of updating other components of your application. Progress Dynamics provides a set of utilities that you can run manually, or modify the DCU to run automatically, to save your site-specific data before the DCU performs its update, then to restore the site-specific data after the DCU update completes.

How the DCU differs from a Progress Dynamics session

In essence, the DCU is a minimal Progress Dynamics session running without most of the normal framework managers (such as Session, General, Profile, and Referential Integrity). The startup procedure starts only the Configuration File Manager and the Connection Manager. The startup procedure then runs the Configuration File Manager's initializeSession procedure. This means that the DCU has access to the Configuration File Manager APIs, such as getManagerHandle, getSessionParam, and setSessionParam. The DCU can also use the Configuration File Manager's XML parsing facility to establish the initial environment.
Beyond the Configuration File and Connection Managers, the DCU also loads two special managers that contain the DCU’s API, the Installation User Interface, and ICFDB Install Managers. You can add other custom managers and APIs to what the DCU loads. You can then access them for your own upgrade processes.

Because the DCU uses the Configuration File Manager, parameters supported by the Configuration File Manager on the command line are also supported for the DCU. You can, for example, override the standard configuration file by specifying the ICFCONFIG parameter.

**DCU interface**

The DCU is driven from one window that contains several component sections. Every aspect of the user interface can be customized, but the main DCU window must remain the same size. The components displayed on each page are defined in the deployment’s DCU driver file.

Figure 5–2 shows the sections of the main DCU window.

![Figure 5–2: DCU interface](image)

The DCU’s component frames are as follows:

- **Bitmap frame** — Contains a bitmap that is specified in the DCU driver file.

- **Page frame** — Contains an ABL frame that has been derived from the DCU’s template frame. The pages that are displayed in this frame are derived from DCU driver file.

- **Button frame** — Contains the buttons that are defined within the DCU driver file for each page of the DCU wizard.

Each page displayed by the DCU is a frame that has been defined using the template `src/install/intmplframe.w`. There is little code inside the frame definition, because the behavior for all the controls is defined inside the DCU’s API and XML files. When a page is displayed, the actions defined in the XML file are associated with the appropriate event on the controls. Then, any necessary processing is activated.

Users can even customize attributes of the individual controls that appear in the frame from within XML files by associating the attribute with the object’s variable name. During the process of displaying the page, the DCU API determines the name of each control and associates attributes with the control as necessary.
While you can build new pages for the DCU wizard using the template, `src/install/intmplframe.w`, the existing pages can be adapted for most of your needs. If an existing page has an object that you do no need, you can hide it by adding a `<Hidden>` node to the corresponding XML control description.

The DCU has two trigger procedures that work with objects on the Wizard pages. The trigger code for a button’s CHOOSE event runs the btnChoose API, as follows:

```plaintext
DO:
  RUN btnChoose IN THIS-PROCEDURE.
END.
```

For any other event for any object, there is a single API, `eventProc`. It takes two parameters, the name of the UI event and the name of the object the event. The following example shows the code for LEAVE event on a fill-in field:

```plaintext
DO:
  RUN eventProc IN THIS-PROCEDURE ("LEAVE":U,"{&SELF-NAME}":U) NO-ERROR.
  IF ERROR-STATUS:ERROR THEN
    RETURN NO-APPLY.
  END.
END.
```

To code any UI event on a page, you would add this code to the object’s trigger section, substituting the appropriate parameter values. The existing pages are stored in the `src\dynamics\install\obj` directory.

Table 5–1 describes the existing frames.

**Table 5–1: DCU standard pages and their objects**

<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
<th>Objects</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>indbconn</code></td>
<td>Page for gathering database connection information.</td>
<td><code>edComment (Editor)</code> <code>lCreate (Toggle-box)</code> <code>lBuild (Toggle-box)</code> <code>fiPath1 (Fill-in)</code> <code>buPath1 (Button)</code> <code>fiPath2 (Fill-in)</code> <code>buPath2 (Button)</code> <code>fiConnect (Fill-in)</code> <code>edConnect (Editor)</code></td>
</tr>
<tr>
<td><code>indbinfo</code></td>
<td>This page is no longer used by the DCU.</td>
<td><code>edComment (Editor)</code> <code>lICFDB (Toggle-box)</code> <code>lRVDB (Toggle-box)</code> <code>fiPath4 (Fill-in)</code> <code>buPath4 (Button)</code></td>
</tr>
</tbody>
</table>
### Table 5–1: DCU standard pages and their objects

<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
<th>Objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>inpath</td>
<td>Page for gathering paths.</td>
<td>edComment (Editor)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>fiPath1 (Fill-in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>buPath1 (Button)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>fiPath2 (Fill-in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>buPath2 (Button)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>fiPath3 (Fill-in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>buPath3 (Button)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>fiPath4 (Fill-in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>buPath4 (Button)</td>
</tr>
<tr>
<td>inselect</td>
<td>Page with editor and a selection list.</td>
<td>edComment (Editor)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>seList (Selection-list)</td>
</tr>
<tr>
<td>insite</td>
<td>Page for gathering site and sequence</td>
<td>edComment (Editor)</td>
</tr>
<tr>
<td></td>
<td>information.</td>
<td>fiNumber (Fill-in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>fiSiteSeq1 (Fill-in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>fiSiteSeq2 (Fill-in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>fiSessionID (Fill-in)</td>
</tr>
<tr>
<td>instatus</td>
<td>Page with two editors.</td>
<td>edComment (Editor)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>edStatus (Editor)</td>
</tr>
<tr>
<td>inwelcome</td>
<td>Page with one editor.</td>
<td>edEditor (Editor)</td>
</tr>
</tbody>
</table>
Deployment stages

The DCU provides a simple mechanism for applying various upgrade programs to a database in a scripted, effective way. Upgrade programs can provide virtually any needed function. Upgrade programs can be invoked at several stages during the process.

Phase 1 of the DCU process uses a specialized subset of the entire Progress Dynamics framework. In general, you should only run programs during Phase 1 that do schema updates and associated tasks on your databases. During this first phase, the DCU writes details of the entire upgrade process to the Repository’s update table.

Whenever the framework starts a new session with a direct database connection for a user who has permission to modify system data, it checks whether there are any outstanding updates. If there are, the second phase of the DCU is invoked when the session starts, and the remaining upgrades are applied. Phase 2 upgrade programs have all the standard Progress Dynamics managers available. However, the environment caches might not have been built yet. ADOs should usually be loaded before the caches are built.

**Note:** Phase 2 processing does not occur unless both conditions are met. The user must have permission to modify system data, and the new session must have a direct database connection. For example, this means that you cannot initiate Phase 2 processing through an AppServer or WebSpeed connection.

The state of the various caches might affect when you need to run certain upgrade programs. You might also encounter stale data in caches. If an earlier upgrade program changed the data in the Repository, any cache that uses that data is stale. You might want to force the refresh of any needed cached data as the first step in an upgrade program.
Phase 1 and Phase 2 processing stages

Table 5–2 describes the deployment stages of the DCU process.

Table 5–2: DCU deployment stages

<table>
<thead>
<tr>
<th>Phase 1–Apply schema updates (DCU session)</th>
<th>Stage Order</th>
<th>Stage Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PreDelta</td>
<td>Use this stage for processing that became necessary after the last schema update was applied and that needs to occur before the new schema update is loaded.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Delta</td>
<td>Use this stage to specify the name of the delta file for upgrading the schema to the new version.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>PostDelta</td>
<td>Use this stage to specify any upgrade programs that must take place before data is loaded into the schema. This is where most schema conversion programs are inserted.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>PreDataLoad</td>
<td>This stage is rarely used. Use it to perform any processing that might be needed before data is loaded.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>DataLoad</td>
<td>Use this stage to specify the list of .d files to be loaded after a schema update has been completed. For new databases, loading all the data from .d files is recommended, rather than using the ADO load mechanism.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>PostDataLoad</td>
<td>This stage is rarely used. Use it to perform any processing that should take place after data is loaded into the database.</td>
<td></td>
</tr>
</tbody>
</table>
Logging for Phase 1 and Phase 2

The DCU provides logging for both the Phase 1 and Phase 2 stages, and by default it writes the log information to a file named `dcu.log` in the initial session’s PROPATH. Note that if you change the path specified for the log file during Phase 1 to a path outside of the initial session’s PROPATH or you change the name of the file from `dcu.log`, Phase 2 of the DCU cannot find the file and creates a second file named `dcu.log` in the session Start in directory. However, if more than one file named `dcu.log` appears in the session PROPATH, the DCU appends updated log information only to the first `dcu.log` file found in the PROPATH.

DCU processing sequence

When you design deployment programs, you must consider the sequence in which the DCU applies your programs. Deploying a single version of your application might require several passes through the DCU’s processing stages. A patch level is all the programs that run during one pass.

The DCU processing sequence runs as follows:

1. The DCU parses all the XML files, loading the data into a temp table, and writing it to the Repository.
2. It sorts the temp table records by patch level and stage.
3. It processes Stages 1–6 for the first patch level.
4. It repeats the process for the remaining patch levels in ascending order.
5. The DCU stops when it reaches one of the following end conditions:
   - A mandatory patch returns an error.
   - The DCU completes Stage 6 processing for the final patch level.

6. The DCU writes the status of the upgrade process and a list of patches that still must be completed to the Repository.

7. When the next user who can change system data starts a Progress Dynamics session that has a direct database connection, the framework checks for information on unfinished upgrades in the Repository.

8. If there are unfinished upgrades to apply, the framework starts the DCU.

9. Beginning with the first unapplied patch level, the DCU works its way through Stages 7–9 for each patch level in ascending order.

**Picking the correct processing stage**

Plan your upgrades carefully. Think about the order in which to perform tasks in each patch level. For example, assume you are moving a field from one table to another. To save any existing data in that field, you have to spread the process over three upgrade programs as follows:

1. Add the field to the new table during Stage 2 of the current patch level.

2. Copy the data from the old field to the new field in either Stage 3 of the current patch level or in Stage 1 of the next patch level.

3. Drop the field from the old table during Stage 2 of the next patch level.

You should also think about how previous upgrade programs will be impacted each time you design a new patch level. Remember that the DCU runs through Stages 1–6 for all patch levels in Phase 1 and then completes Stages 7–9 for each patch level in Phase 2. Because of the break between the phases, the changes for a later upgrade could cause problems for an earlier upgrade. For example, Stage 2 of a later upgrade changes the format of the field into which the earlier upgrade loads data during Stage 7. The data in the earlier upgrade is now in the wrong format according to the database schema when the DCU begins Phase 2 processing.

In general, you should design future upgrades to avoid this sort of problem. If you cannot avoid such a problem, you must run two different DCU sessions to complete the deployment. In the first DCU session, you apply all the patches levels before the level that would cause the conflict. Then, you design the second DCU session using the minimum version attribute so it only runs on databases that have all the previous patch levels applied.
DCU XML files

The DCU is driven by the data stored in a collection of XML files. The main file is the configuration file, `icfsetup.xml` by default. This file is a custom version of the standard Progress Dynamics configuration file, `icfconfig.xml`. The DCU uses the Configuration File Manager to parse the file. The configuration file contains details of the properties required to drive the session and the managers that need to be loaded.

Because the DCU is driven by the contents of XML files, you should not need to modify the DCU procedures themselves. By modifying the XML files, you can use the DCU to deploy your application databases as well as the Progress Dynamics Repository. You can design extra pages for the DCU using the page template, and hook them into the DCU process by adding some trigger code to the pages and some XML statements to the DCU driver file.

The DCU’s standard configuration file looks like the following:

icfsetup.xml

```
<?xml version="1.0" encoding="UTF-8"?>
<sessions>
  <session SessionType="ProgressSetup">
    <properties>
      <ICFCM_Database>DatabaseConnectionManager</ICFCM_Database>
      <physical_session_list>GUI, WBC</physical_session_list>
      <session_date_format>mdy</session_date_format>
      <session_year_offset>1950</session_year_offset>
      <session_numeric_format>,.</session_numeric_format>
      <window_title>Progress Dynamics Configuration Utility</window_title>
      <valid_os_list>WIN32</valid_os_list>
      <setup_type_file>db/icf/dfd/setup1000B.xml</setup_type_file>
    </properties>
    <managers>
      <manager>
        <cManagerName>ConnectionManager</cManagerName>
        <cFileName>af/app/afconmgrp.p</cFileName>
        <cHandleName>NON</cHandleName>
      </manager>
      <manager>
        <cManagerName>DatabaseConnectionManager</cManagerName>
        <cFileName>af/app/afdbconmgrp.p</cFileName>
        <cHandleName>NON</cHandleName>
      </manager>
      <manager>
        <cManagerName>InstallUIManager</cManagerName>
        <cFileName>install/prc/inuimngrp.p</cFileName>
        <cHandleName>NON</cHandleName>
      </manager>
      <manager>
        <cManagerName>ICFDBInstallManager</cManagerName>
        <cFileName>install/prc/inicfdbmgrp.p</cFileName>
        <cHandleName>NON</cHandleName>
      </manager>
    </managers>
  </session>
</sessions>
```
For your own deployments, you can add custom managers to the list in this file. The listed managers are started by the Connection Manager at the start of the DCU session. It is recommended that you do not alter the Install UI or the ICFDB Install Managers. Instead, use them as examples for building custom managers for your application databases.

**DCU driver files**

The configuration file specifies another file, the DCU driver file. That file contains the information needed to set up the DCU’s wizard interface. You cannot use more than one DCU driver file during a DCU session.

Examine the default DCU driver file, setup10008.xml. To customize the DCU for your own deployments, you can use the existing file as a template to add your own messages and other data. The beginning of the file contains basic information including messages and system information that will be useful gathering information during setup, as shown in the following example:

### setup1000B.xml

```xml
<?xml version="1.0" encoding="UTF-8"?>
<Setups>
  <setup SetupType="ProgressSetup">
    <ImageLowRes>install/img/imglores.bmp</ImageLowRes>
    <ImageHiRes>install/img/imghires.bmp</ImageHiRes>
    <IconFile>install/img/icfdcu.ico</IconFile>
    <StartPage>Welcome</StartPage>
    <SkipButtons>Close,Cancel,Quit,Finish,Check</SkipButtons>
    <VersionNo>10.0B1P</VersionNo>
    ...
    <message>
      <MessageCode>MSG_blank_path</MessageCode>
      <MessageDesc>The %1 path may not be left blank.</MessageDesc>
    </message>
    ...
    <registrykey>
      <KeyName>reg_install_path</KeyName>
      <KeyValue>::Startup:DLC</KeyValue>
      <ExpandTokens>YES</ExpandTokens>
    </registrykey>
    ...
    <path>
      <PathName>path_progress</PathName>
      <PathValue>\%\Startup\DLC#</PathValue>
      <ExpandTokens>YES</ExpandTokens>
    </path>
  </setup>
</Setups>
```

The `<registrykey>` nodes point the DCU to the Windows Registry for needed information. As shown by the `<path>` node, the information can then be used to derive other needed values. The Configuration File Manager parses the XML in a single pass. Therefore, the order of the nodes is important. The parser cannot expand a token if a node uses that token before the node that supplies the data is parsed.
Page nodes

The DCU driver file also contains the description of each page that the DCU displays and defines the actions that can occur on those pages. The following excerpt describes the DCU’s Installation Paths page:

Page example from setup1000B.xml

```xml
<page Name="GetInstallPaths">
  <Title>Installation Paths</Title>
  <Group>Path</Group>
  <Proc>install/obj/inpath.w</Proc>
  <control>
    <Type>Editor</Type>
    <Name>edComment</Name>
    <DefaultValue>For this utility to set up the environment, it needs to know the installation path that you chose during the first part of the installation. It has attempted to derive the path from the install.

As the upgrade takes place, a log file will be written that contains details of what occurred during the upgrade.

Please confirm that the Progress Dynamics Installation Path and Log File Name below is correct.</DefaultValue>
  </control>
</page>
```

Note that the page is named and belongs to a named group. All the pages that cover a certain task should belong to the same group. The DCU uses the page name to target the correct page when an action is invoked. Because the pages are called by name, their nodes do not need to be listed in any order. This flexibility makes it easier for you to reuse individual pages in different sequences for different setup types. The `<Proc>` node gives the filename for the page. Each DCU page is created from the template, `src/install/intmplframe.w`.

Action nodes

Each `<control>` node describes an object on the page and how it behaves. The previous excerpt shows the description of the editor that appears in the page frame. The following excerpt shows the description of a Cancel button:

Cancel button from setup1000B.xml

```xml
<control>
  <Type>Button</Type>
  <Panel>Yes</Panel>
  <Label>&amp;Cancel</Label>
  <Name>Quit</Name>
  <Justify>Right</Justify>
  <action>
    <Event>CHOOSE</Event>
    <Action>QUIT</Action>
  </action>
</control>
```

The `<action>` node describes how a control reacts to one of the standard ABL events, which is listed in the `<Event>` subnode. The `<Action>` subnode can only contain a single character string, the name of the API that is launched by the event. The DCU assumes that the API is in the Install UI Manager by default. If you want to run an API from another manager, you can specify the manager using an `<ActionTarget>` node. The value in `<ActionTarget>` must match the named assigned to the manager in the `<cManagerName>` node in the DCU configuration file.
The DCU recognizes two special keywords in addition to any APIs in the managers: QUIT and FINISH. QUIT ends the DCU session without completing the upgrade. FINISH ends the DCU and signals that the upgrade completed successfully. The difference is important for release versioning.

While most actions are linked to events for specific controls, you can also attach actions directly to a page. The following excerpt shows an event linked directly to the GetICFDBParams page:

**Action linked to a page from setup1000B.xml**

```
<page Name="GetICFDBParams">
  <Title>ICFDB Parameters</Title>
  <Group>ICFDB</Group>
  <Proc>install/obj/indbconn.w</Proc>
  <action>
    <Event>INITIALIZE</Event>
    <Action>checkForDB</Action>
    <ActionParam>ICFDB</ActionParam>
  </action>
</page>
```

**Action parameters**

The following excerpt shows the description for the Back button on the Installation Paths page, and its two actions are processed in the order in which they are listed:

**Back button from setup1000B.xml**

```
<control>
  <Type>Button</Type>
  <Panel>Yes</Panel>
  <Label>&amp;Back</Label>
  <Name>Back</Name>
  <Justify>Right</Justify>
  <action>
    <Event>CHOOSE</Event>
    <Action>restoreProperties</Action>
  </action>
  <action>
    <Event>CHOOSE</Event>
    <Action>gotoPage</Action>
    <ActionParam>Welcome</ActionParam>
  </action>
</control>
```

The second action shows an example of passing a parameter. In this excerpt, it is the name of the page that the DCU will display when the Back button is chosen. An action can only take a single parameter, which must be a character string.
However, the DCU recognizes two special strings for passing conditional parameters. These strings allow you to embed \texttt{IF...THEN...ELSE} and \texttt{CASE} expressions in the XML. Table 5–3 lists the operators that you can use in the expressions.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>&amp;&amp;</td>
</tr>
<tr>
<td>OR</td>
<td>::</td>
</tr>
<tr>
<td>Equals</td>
<td>=</td>
</tr>
<tr>
<td>Greater than or equal</td>
<td>&gt;=</td>
</tr>
<tr>
<td>Less than or equal</td>
<td>&lt;=</td>
</tr>
<tr>
<td>Not equal</td>
<td>&lt;&gt;</td>
</tr>
</tbody>
</table>

The following is an example of the syntax for an \texttt{IF} expression is shown in this excerpt from the \texttt{GetICFDBParams} page:

\texttt{IF . . . THEN . . . ELSE} conditional expression

\begin{verbatim}
<action>
  <Event>CHOOSE</Event>
  <Action>gotoPage</Action>
  <ActionParam>?db_build_icfdb=YES;GetICFSiteData;GetICFDBPatches
</ActionParam>
</action>
\end{verbatim}

The \texttt{IF} expression begins with a question mark (?) followed by the expression the DCU evaluates. Semicolons (;) separate the results. The value after the first semicolon is the \texttt{THEN} result, and the value after the second semicolon is the \texttt{ELSE} result. So, the expression above reads, \texttt{“If the value of db\_build\_icfdb is YES, then go to the GetICFSiteData page, else go to the GetICFDBPatches page.”}

\textbf{Note:} While you can create complex \texttt{IF} expressions using the available operators, you cannot nest \texttt{IF} expressions. The results must be single-character strings, as with normal parameters.

An example of the syntax for a \texttt{CASE} expression is shown below:

\texttt{CASE} conditional expression

\begin{verbatim}
<action>
  <Event>CHOOSE</Event>
  <Action>gotoPage</Action>
</ActionParam>
</action>
\end{verbatim}
The CASE expression begins with a colon (:) and the name of the property to evaluate. Each result begins with a colon followed by a pipe (|) delimited value pair. The DCU uses the first value pair that matches the evaluated property in the list of results. So, the expression above reads, “Check the session_date_format property. If the value is dmy, go to page1. If the value is mdy, go to page2. If the value is ymd, go to page3. If none of the conditions are met, go to page9.”

Data capture nodes

The DCU captures data from its wizard interface with a screen scrape procedure. How the data is stored is controlled through the use of two nodes: <StoreTo> and <TableVariable>. The following excerpt shows a fill-in field description that employs both methods:

Fill-in field from setup1000B.xml

```
- <control>
  <Name>fiPath2</Name>
  <DefaultValue>\_start_in_directory\dcu.log</DefaultValue>
  <ExpandTokens>YES</ExpandTokens>
  <StoreTo>path_log</StoreTo>
  <Label>Log File</Label>
  <TableVariable>LogFile</TableVariable>
</control>
```

Which method you use to capture the data depends on when you want to have the data available. The DCU stores the data from a <StoreTo> node in a session parameter. The parameter can be defined in either the Configuration File Manager or in the DCU driver file. The data is then available to the DCU while the user steps through the rest of the wizard pages. The DCU stores the data from a <TableVariable> node in a temp-table. The data in the temp-table is used after the DCU has finished collecting data and starts processing. As the example shows, you can store the data in both places if you need it both before and after the DCU begins processing.

Database nodes

The last section of the standard DCU driver file describes the databases to upgrade. Each database has its own node. The DCU works through the databases in the order they are listed here. A database node specifies the information needed to connect to the database and lists a set of XML files that contain descriptions of the upgrades and datasets to be applied to the database.
The following excerpt shows the contents of a database node:

**Database example from setup1000B.xml**

```xml
<database>
  <DBName>ICFDB</DBName>
  <VersionSeq>seq_icfdb_dbversion</VersionSeq>
  <MinimumVersion>020021</MinimumVersion>
  <ConnectParams>-1</ConnectParams>
  <DBDir>#{path_db#}\icf\icfdb.db</DBDir>
  <DBDump>#{path_src#}\#dynamics_rootname#\db\icf\dump</DBDump>
  <patch PatchLevel="0" DBuild="Yes" NodeURL="/icf/dfd/icfdbbuild.xml"/>
  <patch PatchLevel="020022" NodeURL="/icf/dfd/icfdb020022adolist.xml"/>
  <patch PatchLevel="020022" NodeURL="/icf/dfd/icfdb020022patch.xml"/>
  <patch PatchLevel="020023" NodeURL="/icf/dfd/icfdb020023patch.xml"/>
  <patch PatchLevel="020024" NodeURL="/icf/dfd/icfdb020024patch.xml"/>
  <patch PatchLevel="020025" NodeURL="/icf/dfd/icfdb020025patch.xml"/>
  <patch PatchLevel="020025" NodeURL="/icf/dfd/icfdb020025adolist.xml"/>
  <patch PatchLevel="020026" NodeURL="/icf/dfd/icfdb020026patch.xml"/>
  <patch PatchLevel="100001" NodeURL="/icf/dfd/icfdb100001patch.xml"/>
  <patch PatchLevel="100002" NodeURL="/icf/dfd/icfdb100002patch.xml"/>
  <patch PatchLevel="100002" NodeURL="/icf/dfd/icfdb100002adolist.xml"/>
</database>
```

This example shows the information for setting up the Repository. It is recommended that you use the same technique for tracking the database version for your application databases. To enable identification of the current version of a database, each database requires a sequence with a name in the following format:

```
seq_logicaldbname_DBVersion
```

Where `logicaldbname` is the logical database name for the database.

This sequence tracks the version of the database as a six-digit integer. The first two digits are the version. The next two digits are the revision level. The final two digits are the patch level.

The current value of the sequence is not used, but the DCU reads the sequence maximum value to determine the current database version. The DCU uses this value to decide which patches must be applied to the target database to complete the upgrade. When an incremental data definition file is loaded, a schema change should update the sequence definition to its new maximum value. The `<MinimumVersion>` node contains the minimum version of the database on which a particular setup can run.

The remaining nodes list the patch levels to apply during this upgrade. The associated files detail all the patch programs and ADOs that are part of a particular deployment. Notice that they are listed in ascending order by patch levels. Your files should always be listed in this order. The DCU reads the files in the order they are listed to build the temp-table of patches.
Upgrade files

The XML files that specify the changes the DCU applies to the Repository and application databases are the upgrade files. Each upgrade file is assigned to a patch level that controls when the DCU applies the upgrade. The data in an upgrade file should generally be limited to one of the following categories:

- New database creation data
- A list of all ADOs to load during a given patch level
- Upgrade programs, including:
  - Schema changes
  - Data loads
  - Fix programs

After patch level “0,” the next patch level is the lowest one that can be applied during the upgrade. A patch level can have multiple files associated with it. Upgrade files are listed in a specific order under the database node. All the upgrade files for a given patch file are listed together. The DCU parses the files in the order they are listed under the database node.
Database creation upgrade files

The first patch level listed under the database nodes controls the creation of new databases. The new database creation patch level is always numbered "0." The associated upgrade file provides the details for building a new database, as in the standard Repository build file shown:

icfdbbuild.xml

```xml
<?xml version="1.0" encoding="utf-8" ?>
<SetupInclude>
  <Patch PatchLevel="0">
    <patchstage UpdateStage="Delta">
      <Program>
        <FileType>df</FileType>
        <FileName>db/icf/dfd/icfdbfull.df</FileName>
        <Description>Applying Full DB Schema</Description>
        <Rerunnable>no</Rerunnable>
        <NewDB>yes</NewDB>
        <ExistingDB>no</ExistingDB>
        <UpdateMandatory>yes</UpdateMandatory>
      </Program>
      <patchstage UpdateStage="DataLoad">
        <Program>
          <FileType>d</FileType>
          <Description>Loading database table contents</Description>
          <Rerunnable>no</Rerunnable>
          <NewDB>yes</NewDB>
          <ExistingDB>no</ExistingDB>
          <UpdateMandatory>yes</UpdateMandatory>
        </Program>
        <Program>
          <FileType>s</FileType>
          <Description>Setting site number</Description>
          <Rerunnable>yes</Rerunnable>
          <NewDB>yes</NewDB>
          <ExistingDB>no</ExistingDB>
          <UpdateMandatory>yes</UpdateMandatory>
        </Program>
      </patchstage>
    </Patch>
  </Patch>
</SetupInclude>
```

There are several points to observe in this file. An upgrade file can contain information on several programs that run at different stages. The patch stages must be listed in the correct order. The programs within a patch stage must be listed in the order in which you want them to run.

A peculiarity of this file is that it does not list specific filenames for the programs in the DataLoad stage. The DCU automatically loads all the files of the appropriate type in the target directory.

Note: For an explanation of the program attribute nodes, see the “Upgrade program attributes” section on page 5–33.
After patch level “0,” the other patch levels are listed in ascending order from the lowest one that can be applied during the upgrade. A patch level can have multiple files associated with it. The files are listed in the order the DCU should apply them.

**ADO list upgrade files**

The ADO list upgrade file is usually the largest upgrade file. This file contains a list of all the ADOs that are applied during a patch level. The ADO list upgrade file is created by the release versioning tools. The tools automatically list the ADOs in the order in which they should be applied. For more information on the release versioning tools, see the Progress Dynamics Version 2.1A Application Deployment white paper at the following PSDN Web site:

http://psdn.progress.com/library/white_papers/dynamicswp/index.ssp

**Note:** The release versioning tools build a completely new ADO list file each time. Any edits you made in a previous ADO list are lost, so generally you should not customize the file.

The following excerpt is from an ADO list file:

**icfdb100002adolist.xml**

```xml
<?xml version="1.0" encoding="utf-8" ?>
<SetupInclude>
  <Patch PatchLevel="100002">
    <PatchStage Stage="ADOLoad">
      <Program>
        <FileType>ADO</FileType>
        <FileName>db/icf/dump/gscem.ado</FileName>
        <Description>Loading ADO for db/icf/dump/gscem.ado</Description>
        <Rerunnable>yes</Rerunnable>
        <NewDB>no</NewDB>
        <ExistingDB>yes</ExistingDB>
        <UpdateMandatory>yes</UpdateMandatory>
      </Program>
      <Program>
        <FileType>ADO</FileType>
        <FileName>db/icf/dump/gscer.ado</FileName>
        <Description>Loading ADO for db/icf/dump/gscer.ado</Description>
        <Rerunnable>yes</Rerunnable>
        <NewDB>no</NewDB>
        <ExistingDB>yes</ExistingDB>
        <UpdateMandatory>yes</UpdateMandatory>
      </Program>
    </PatchStage>
  </Patch>
</SetupInclude>
```

**Other upgrade files**

The other upgrade files that might be part of a patch level detail the steps to upgrade an existing database, including schema updates, data loads through ADOs, and programs to fix existing data. A file can include several procedures happening at various stages of the upgrade process.
The following example shows the XML structure for applying a schema change and running a procedure file:

**icfdb020026patch.xml**

```xml
<?xml version="1.0" encoding="utf-8" ?>
<SetupInclude>
  <Patch PatchLevel="020025">
    <PatchStage Stage="Delta">
      <Program>
        <FileType>df</FileType>
        <FileName>db/icf/dfd/icfdb020025delta.df</FileName>
        <Description>Applying 020025 Delta</Description>
        <Rerunnable>no</Rerunnable>
        <NewDB>no</NewDB>
        <ExistingDB>yes</ExistingDB>
        <UpdateMandatory>yes</UpdateMandatory>
      </Program>
    </PatchStage>
    <PatchStage Stage="PreADOLoad">
      <Program>
        <FileType>p</FileType>
        <FileName>db/icf/dfd/fixrmdhtmlattr.p</FileName>
        <Description>Removing old DHTML attribute deletions</Description>
        <Rerunnable>yes</Rerunnable>
        <NewDB>no</NewDB>
        <ExistingDB>yes</ExistingDB>
        <UpdateMandatory>no</UpdateMandatory>
      </Program>
    </PatchStage>
  </Patch>
</SetupInclude>
```
The procedure files that contain most of the code specific to the DCU are located in your OpenEdge\Install\src\dynamics\install\prc directory. Table 5–4 lists the DCU’s main procedure files.

Table 5–4: DCU procedure files

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>inuimngrp.p</td>
<td>Handles the UI events that run the DCU wizard.</td>
</tr>
<tr>
<td>inupgrdapip.p</td>
<td>Handles the data definition and data loads (Phase 1 processing).</td>
</tr>
<tr>
<td>insessupdp.p</td>
<td>Handles the dataset (ADO) loads (Phase 2 processing).</td>
</tr>
<tr>
<td>insaxparserp.p</td>
<td>Reads the XML files.</td>
</tr>
<tr>
<td>inrytupdstatp.p</td>
<td>Stores details of the upgrade process in the Repository.</td>
</tr>
<tr>
<td>inicfbsitep.p</td>
<td>Sets the Repository’s site number.</td>
</tr>
<tr>
<td>inicfbsseqp.p</td>
<td>Increments the database sequences during each upgrade.</td>
</tr>
<tr>
<td>inicfbsqp.p</td>
<td>Increments the database version sequence.</td>
</tr>
<tr>
<td>inicfdbmngrp.p</td>
<td>Creates and updates new repositories.</td>
</tr>
<tr>
<td>inicfbdgetseqp.p</td>
<td>Retrieves the current value of the Repository’s version sequence.</td>
</tr>
</tbody>
</table>

The two manager procedures, inuimngrp.p and inicfdbmngrp.p, can serve as examples for your custom deployment managers. These two managers also contain all the APIs that you should normally need to make calls to. The following sections describe the public APIs.

**analyzeCase**

This function analyzes a CASE expression from an XML <ActionParam> node and returns the appropriate value to use for the parameter.

A CASE expression begins with a colon (:) and the name of the property to evaluate. Each result begins with a colon followed by a pipe (|) delimited value pair. The function stops processing when it reaches the first value pair that matches the evaluated property in the list of results. So, the following expression evaluates to “Check the session_date_format property. If the value is dmy, go to page1. If the value is mdy, go to page2. If the value is ymd, go to page3. If none of the conditions are met, go to page9.”, as shown:

```
:session_date_format:dmy|page1:mdy|page2:ymd|page3:default|page9
```

**Location:** install/prc/inuimngrp.p

**Parameters:**

**INPUT** pcCaseStatement AS CHARACTER

The CASE expression from the XML <ActionParam> node.
analyzelf

This function analyzes an IF expression from an XML <ActionParam> node and returns either the THEN or ELSE value to use for the parameter.

The IF expression begins with a question mark (?) followed by the expression the DCU evaluates. Semicolons (;) separate the results. The value after the first semicolon is the THEN result, and the value after the second semicolon is the ELSE result. So, the following expression evaluates to “If the value of db_build_icfdb is YES, then go to the GetICFSiteData page, else go to the GetICFDBPatches page.”, as shown:

```
?db_build_icfdb=YES;GetICFSiteData;GetICFDBPatches
```

Location:  install\prc\inuimngrp.p
Parameters:

INPUT pcIfStatement AS CHARACTER

The IF expression from the XML <ActionParam> node.

Returns:  None (procedure)
Notes:  While you can create complex IF expressions using the available operators, you cannot nest IF expressions. The results must be single character strings as with standard parameters.

btnChoose

This procedure handles the CHOOSE event for a button on one of the DCU’s wizard pages. It calls the eventProc procedure supplying the proper parameters for a button.

Location:  install\prc\inuimngrp.p
Parameters:  None

Returns:  None (procedure)
Notes:  None

checkForDB

This procedure checks to see if the databases exist. If the databases exist, it sets the following properties:

- `connect_params_dbname` — The connection parameters for the database as derived from the <database> node.
- `dbname_exists` — Indicates if the database exists on disk.
- `dbname_does_not_exist` — Indicates that the database does not exist on disk.
Extending the Progress Dynamics Configuration Utility

Where `dbname` is the name of the specific database.

**Location:** `install\prc\inuimngrp.p`

**Parameters:**

- `pcDBToCheck` `CHARACTER`
  
  The name of the database to check.

**Returns:** None (procedure)

**Notes:** The two opposite properties for whether the database exists are needed because you cannot evaluate `NOT` for a property and have the token expanded.

---

**connectDatabase**

This procedure confirms that the database is available and can be connected. It then registers the connection with the Connection Manager.

**Location:** `install\prc\inuimngrp.p`

**Parameters:**

- `pcDBName` `CHARACTER`
  
  The name of the database to check.

**Returns:** None (procedure)

**Notes:** None

---

**eventProc**

This procedure handles the event processing for objects on the DCU’s wizard pages.

**Location:** `install\prc\inuimngrp.p`

**Parameters:**

- `pcEvent` `CHARACTER`
  
  The ABL event.

- `pcObject` `CHARACTER`
  
  The name of the object.

**Returns:** None (procedure)

**Notes:** None
**getDBFile**

This procedure calls `SYSTEM-DIALOG GET-FILE` to find a database filename.

**Location:** install\prc\inuinmgrp.p

**Parameters:**

INPUT `pcControl` AS CHARACTER

The name of the control.

**Returns:** None (procedure)

**Notes:** None

**getDirectory**

This procedure calls the Microsoft standard dialog box to prompt for a directory.

**Location:** install\prc\inuinmgrp.p

**Parameters:**

INPUT `pcPathField` AS CHARACTER

The name of the fill-in field.

**Returns:** None (procedure)

**Notes:** None

**gotoPage**

This procedure loads a named page into the DCU’s wizard interface.

**Location:** install\prc\inuinmgrp.p

**Parameters:**

INPUT `pcPageName` AS CHARACTER

The name of a page as specified in the XML file.

**Returns:** None (procedure)

**Notes:** The conditional expressions described in the “Action nodes” section on page 5–15 are often used to decide the page to call with this API.
obtainICFSeqVals

This procedure obtains the sequence values for the ICFDB database and populates the UI with the data.

Location: install\prc\inicfdbmngrp.p

Parameters:

INPUT pcInput AS CHARACTER

This parameter is not currently used.

Returns: None (procedure)

Notes: None

obtainPatchList

This procedure obtains the list of upgrade files for a certain database.

Location: install\prc\inuimngrp.p

Parameters:

INPUT pcParams AS CHARACTER

Returns: None (procedure)

Notes: None

processParams

This procedure copies the data from the ttControl records into the ttValue table. It also copies the value of all the database session parameters into the ttDatabase records.

Location: install\prc\inuimngrp.p

Parameters:

INPUT pcParams AS CHARACTER

This parameter is not currently used.

Returns: None (procedure)

Notes: None
**restoreProperties**

This procedure restores cascaded properties to their original values.

**Location:** `install/prc/inuimngrp.p`

**Parameters:**

`INPUT pcInput AS CHARACTER`

This parameter is not currently used.

**Returns:** None (procedure)

**Notes:** None

**screenScrape**

This procedure goes through all the fields in the `ttControl` temp-table for the current page and stores the value from the screen into the `ttControl.cFieldValue` field.

**Location:** `install/prc/inuimngrp.p`

**Parameters:**

`INPUT pcInput AS CHARACTER`

This parameter is not currently used.

**Returns:** None (procedure)

**Notes:** None

**startUpgradeProcess**

This procedure launches the upgrade process using the private upgrade APIs.

**Location:** `install/prc/inuimngrp.p`

**Parameters:**

`INPUT pcEditor AS CHARACTER`

**Returns:** None (procedure)

**Notes:** None
validateDirectory

This procedure validates that the directory exists and can be created if necessary.

**Location:** install\prc\inuimngrp.p

**Parameters:**

INPUT pcParamString AS CHARACTER

A comma-delimited value pair. The first entry is the name of the fill-in field that contains the directory name to validate. The second entry is an optional TRUE/FALSE value that indicates whether a blank filename is permitted. The default for the second entry is FALSE.

**Returns:** None (procedure)

**Notes:** None

validateSiteNumber

This procedure validates that the value for the Progress Dynamics site number field is not zero.

**Location:** install\prc\inicfdbmngroup.p

**Parameters:**

INPUT pcWidget AS CHARACTER

Name of the fill-in field that holds the site number.

**Returns:** None (procedure)

**Notes:** None

verifyDBVersion

This procedure determines whether the database version of the database being upgraded is valid.

**Location:** install\prc\inuimngrp.p

**Parameters:**

INPUT pcParams AS CHARACTER

**Returns:** None (procedure)

**Notes:** None
Creating a customized DCU deployment

The following sections present advice on customizing a DCU session to deploy your own applications. Remember that every deployment is unique. There is not a single correct solution for all deployments.

**Prepare schema and data files**

Every deployment should be able to build the databases from scratch for a new user and also bring existing databases up to the latest version. Therefore, you must prepare the following files from your central Repository and application databases:

- A full data definition (.df) file
- Complete data (.d) files
- Incremental data definition (.df) files
- Dataset (ADO) files

**Note:** For DCU deployments, you should follow the Progress Dynamics naming conventions for .df files as shown in *OpenEdge Development: Progress Dynamics Repository Reference*.

The DCU uses the full .df file and the .d files to create a new database. Because .d files load faster than ADOs, you should use .d files when loading data into a new database. However, the data in ADOs is independent of the database’s session properties. When using .d files, you must take into account those session properties.

The DCU uses the OpenEdge defaults for the session properties listed in **Table 5–5**.

**Table 5–5: DCU session properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATE-FORMAT</td>
<td>MDY</td>
</tr>
<tr>
<td>YEAR-OFFSET</td>
<td>1950</td>
</tr>
<tr>
<td>CODEPAGE</td>
<td>UTF-8</td>
</tr>
</tbody>
</table>

When creating files for your deployment, you should set these properties to the values for the environment for which you are creating the deployment. Then, you should customize a DCU session to use the same values. For more information on setting session properties, see the information on creating session properties in Chapter 2, “Defining and Managing Sessions.”

For more information on creating .df and .d files, see *OpenEdge Data Management: Database Administration*.

Remember that it is best to create these files from a clean copy of your Repository and application databases. Make all the changes you can on your central databases and then deploy those changes to your users through ADOs. In general, you should only run fix programs during a user deployment if absolutely necessary. If the changes can be done on the central databases and the results deployed as ADOs, do it that way.
Designing upgrade programs

Because of how the DCU processes upgrades, all upgrade programs must conform to the following requirements:

- **Runs non-persistent** — An upgrade program runs non-persistently. The DCU acquires a schema lock on the databases it is updating during Phase 1. Persistent procedures with database access code might cause problems when .df files are loaded. If an upgrade program invokes any persistent procedures, especially ones that access the database, the upgrade program must also shut down those procedures.

- **Uses no parameters** — An upgrade program takes no parameters.

- **Runs without user interaction** — Upgrade programs run as background procedures in a noninteractive mode. There can be no user interaction inside an upgrade program.

- **Generates a RETURN at completion** — All upgrade programs should end the main block with either a RETURN or a RETURN ERROR.

- **Upgrade fails on RETURN ERROR** — When an error condition is raised and returned to the DCU, the DCU treats it as a failed condition. The DCU stops processing and quits the upgrade. This is an extreme way to end an upgrade program and should only be used for fatal errors. RETURN ERROR should only be used to end the upgrade process.

- **Writes to the log file** — The log file is the only recording of what took place during a DCU session. Therefore, it is very important that status information is regularly written to the log file. You can update the log file using a PUBLISH statement such as:

  ```sql
  PUBLISH "DCU_WriteLog":U ("Message")
  ```

- **Handle schema triggers** — In general, it is not good practice to override schema triggers. Overriding the triggers can result in data problems. However, there are certain cases where you must override the triggers, such as with upgrade programs that run without the complete Progress Dynamics framework during Phase 1. In these cases, the upgrade program should perform the tasks that the schema triggers would normally perform. You must supply defaults for information that the triggers would normally obtain through calls to managers.

- **Handle cache issues** — During Phase 2, remember that the Progress Dynamics environment caches data in many places. Loading ADOs can invalidate the existing caches. Any of your upgrade procedures that make use of the framework’s cached data should refresh the cache before using it. This should correct problems caused by upgrade procedures that ran before it.
Upgrade program attributes

Every program run by the DCU has several standard attributes. These are set in subnodes under the <program> node. Table 5–6 describes their use.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rerunnable</td>
<td>Indicates whether the program can be rerun on the same database if the DCU processing is interrupted and must be restarted. <strong>Note:</strong> Before you define an upgrade as rerunnable, be sure it will not make changes to data that it changed on previous runs.</td>
</tr>
<tr>
<td>NewDB</td>
<td>Indicates whether the upgrade program should be applied to a newly created database.</td>
</tr>
<tr>
<td>ExistingDB</td>
<td>Indicates whether the upgrade program should be applied to an existing database.</td>
</tr>
<tr>
<td>UpdateMandatory</td>
<td>Indicates whether the upgrade program must complete successfully. If YES and the program returns an error condition, the DCU stops processing and treats the upgrade session as a failure. If NO and the program returns an error condition, the DCU logs a note on the failure of that program and continues processing the other upgrades.</td>
</tr>
</tbody>
</table>

Setting up new databases with the DCU

The main focus of the DCU is setting up the Repository database. Therefore, it is simple to extend a DCU session to also set up your application database as well. Every deployment should be able to create a new database. You can customize a deployment to create a new application database as follows:

1. Create a custom session type and generate a configuration file for it.
2. Create a custom DCU driver file for the new session type.
3. Add a page to the DCU driver file to collect install information.
4. Add a node for the new database in the DCU driver file.
5. Create a database creation upgrade file for your application database.

Creating a custom session type

It is good practice to have a separate session type for each application you deploy. The Session Type Control enables you to extend existing session types to create customized ones.
To create a new DCU session type:

1. In the Session Type Maintenance window, choose Basic→DCU→ProgressSetup.

2. Click Add record to create a new session type. The new session type automatically extends ProgressSetup.

3. Name the new session type and save it. For example, you might specify a session type name for the DynSports sample application as DynSportsSetup.

4. Create overrides for the ProgressSetup session properties under the new session type. For example:

<table>
<thead>
<tr>
<th>Session property</th>
<th>Sample value</th>
</tr>
</thead>
<tbody>
<tr>
<td>setup_type</td>
<td>DynSportsSetup</td>
</tr>
<tr>
<td>setup_type_file</td>
<td>db/dynsports/dfd/DynsportsSetup01.xml</td>
</tr>
<tr>
<td>window_title</td>
<td>DynSports Configuration Utility</td>
</tr>
</tbody>
</table>

5. Generate a configuration file using your new session type. By convention, the filename is application-name-setup.xml. For example, dynsportssetup.xml.

By changing the DCUSETUPTYPE and ICFCONFIG parameters to your new session type and configuration file, you can now override the DCU with your custom deployment.

Creating a custom DCU driver file

Your custom configuration uses the DCU driver file that you named in the setup_type_file session property. Your next step is to create that file. While you could build one from scratch, you can also alter a standard DCU driver file.

To create a custom DCU driver file:

1. Save a copy of the latest standard DCU driver file to the directory and filename specified in the setup_type_file session property of your custom session type.

2. Change the <setup> node to your custom session type. For example:

```xml
<setup SetupType="DynSportsSetup">
```
3. In the Welcome page description, change the contents of the editor control’s `<DefaultValue>` to reflect your application. For example, you might change the standard text to the following for the DynSports application:

```
Welcome to the DynSports Configuration Utility.
This process will set up the databases that are required to run the current version of DynSports.
Choose the Next button to start this process. Choose Cancel to leave without modifying anything.
```

4. You can also alter the settings of the following nodes to change the appearance of the DCU to reflect your own application:

- `<ImageLowRes>`
- `<ImageHiRes>`
- `<IconFile>`

If you run your custom DCU session now, it brings up the altered Welcome page. It cannot install your application database yet. It needs to gather path information on where the database files are located.

**Adding a page to the DCU**

The DCU needs to know where the source files for your application database are. One of the existing DCU pages, the ICFDB Parameters page, captures this type of information for the Repository. You can reuse it to capture the information for your application database.

The page you are reusing supports upgrading existing databases, as well as creating new databases. This section concentrates on those parts of the page that build a new database. Using the DCU for upgrades is discussed in the “Upgrading existing databases with the DCU” section on page 5–38.

**To add a new page to the DCU driver file:**

1. In your DCU driver file, copy the GetICFDBParams page description. It begins with the `<page Name="GetICFDBParams">` node and ends with the next `</page>` node.

2. Paste a copy of the page description before the Status page description.

3. Change the page name, title, and page group to reference your application. For example, the beginning of the DynSports Parameters page description would look like this:

```
<paper Name="GetDynSportsParams">
    <Title>DynSports Parameters</Title>
    <Group>DynSports</Group>
```
4. Change the `checkForDB` action to use the logical name of your application database. For the DynSports example, it would be the following:

```
<action>
  <Event>INITIALIZE</Event>
  <Action>checkForDB</Action>
  <ActionParam>DynSports</ActionParam>
</action>
```

5. Set the **Back** button to go to the ICFDB Parameters page. For the DynSports example, it would be the following:

```
<control>
  <Type>Button</Type>
  <Panel>Yes</Panel>
  <Label>&amp;Back</Label>
  <Name>Back</Name>
  <Justify>Right</Justify>
  <action>
    <Event>CHOOSE</Event>
    <Action>gotoPage</Action>
    <ActionParam>GetICFDBParams</ActionParam>
  </action>
</control>
```

**Note:** There are several paths through the ICFDB pages. With conditional processing, you could have the DCU return to the page from which the user came.

6. Set the **Next** button to go to the Status page in the Wizard sequence.

   You do not need to modify the other actions that occur when the user chooses the **Next** button. The `screenScrape` action records the values from the objects. The `connectDatabase` and `verifyDBVersion` actions are conditional and will not occur during the build of a new database.

7. Change the text in the editor’s default value to describe your application database.

8. Change the remaining ICFDB references to refer to your application database.

Your customized DCU can now gather the information on where to find the build files for your application database. The last thing you need is an upgrade file that tells how to use the files.
Creating a customized DCU deployment

Adding a database node

The DCU driver file needs a node for each database in the deployment.

To add a node for your application database, copy the ICFDB node and modify the values for your application database. For example, a DynSports database node might look like this:

```xml
<database>
  <DBName>DynSports</DBName>
  <VersionSeq>seqDynSports_dbversion</VersionSeq>
  <MinimumVersion>010000</MinimumVersion>
  <ConnectParams>-1</ConnectParams>
  <DDDir>\dyncs\dnc\dnc.db</DDDir>
  <DBDump>\path\src\#dynamics_rootname\db\dyncs\dump</DBDump>
  <patch PatchLevel="0" DBBuild="Yes">
    <NodeURL="dyncs\dfd\dyncsbuild.xml"/>
  </patch>
</database>
```

Creating a database creation upgrade file

As before, the simplest method for creating the upgrade file is to copy and customize the standard file.

To create a database creation upgrade file:

1. Copy and rename the Repository creation upgrade file, icfdbbuild.xml. For example, the DynSports file would be dynsportsbuild.xml.

2. Change the full data definition filename to the one for your application database. For the DynSports example, it might look like the following:

```xml
<patchstage UpdateStage="Delta">
  <Program>
    <FileType>df</FileType>
    <FileName>dynsports/dfd/dynsportsfull.df</FileName>
    <Description>Applying Full DynSports DB Schema</Description>
    <Rerunnable>no</Rerunnable>
    <NewDB>yes</NewDB>
    <ExistingDB>no</ExistingDB>
    <UpdateMandatory>yes</UpdateMandatory>
  </Program>
</patchstage>
```

3. In the next patch stage, remove the program node for the Setting Site Number program. That program is specific to the Repository.

Your custom DCU can now create a new application database in addition to creating and upgrading the Repository.
Upgrading existing databases with the DCU

Deployments must upgrade existing databases as well as create new ones. Modifying the DCU to upgrade your application database is not difficult. The most important part of the process is planning when to apply each upgrade. You can apply incremental data definition files, fix programs, or load ADOs to upgrade existing databases.

Patch levels are tracked using the database sequences described in the “Database nodes” section on page 5–18. Even if you have not changed anything else in the schema, that sequence is incremented for each patch level. The DCU determines the database version by reading the PatchLevel in the configuration file. The DCU then updates the database’s version sequence programmatically.

A deployment can apply several patch levels to a database. The database node for each database specifies a minimum version that sets a lower bound on the existing databases that can be upgraded by a deployment.
To add upgrades to your customized DCU, the general process is as follows:

1. Plan on how to properly apply your upgrades. In particular, consider when the upgrade should happen during the DCU process.

2. Create an upgrade file for the patch level. For example, a DynSports upgrade file might look like this:

```xml
<SetupInclude>
  <Patch PatchLevel="010002">
    <PatchStage Stage="Delta">
      <Program>
        <FileType>df</FileType>
        <FileName>dynsports/dfd/dynsports010002delta.df</FileName>
        <Description>Applying DynSports 010002 Delta</Description>
        <Rerunnable>no</Rerunnable>
        <NewDB>no</NewDB>
        <ExistingDB>yes</ExistingDB>
        <UpdateMandatory>yes</UpdateMandatory>
      </Program>
    </PatchStage>
    <PatchStage Stage="PreADOLoad">
      <Program>
        <FileType>p</FileType>
        <FileName>dynsports/dfd/removeinvalidlinks.p</FileName>
        <Description>Removing invalid links</Description>
        <Rerunnable>yes</Rerunnable>
        <NewDB>no</NewDB>
        <ExistingDB>yes</ExistingDB>
        <UpdateMandatory>yes</UpdateMandatory>
      </Program>
    </PatchStage>
    <PatchStage Stage="ADOLoad">
      <Program>
        <FileType>ADO</FileType>
        <FileName>dynsports/dump/armcu.ado</FileName>
        <Description>Loading ADO for Customer table.</Description>
        <Rerunnable>yes</Rerunnable>
        <NewDB>no</NewDB>
        <ExistingDB>yes</ExistingDB>
        <UpdateMandatory>yes</UpdateMandatory>
      </Program>
    </PatchStage>
  </Patch>
</SetupInclude>
```

3. Use the release versioning tools to create an ADO List upgrade file if any ADOs are being applied for the patch level.
4. Add the patch level description to the DCU driver file. For example, a DynSports patch level description might look like this:

```xml
<database>
  <DBName>DynSports</DBName>
  <VersionSeq>seq_dynsports_dbversion</VersionSeq>
  <MinimumVersion>010000</MinimumVersion>
  <ConnectParams>-1</ConnectParams>
  <DBDir>#path_db#\dysports\dysports.db</DBDir>
  <DBDump>#path_src#\#dynamics_rootname#\db\dysports\dump</DBDump>
  <patch PatchLevel="0" DBBuild="Yes"
    NodeURL="dysports/dfd/dynsportsbuild.xml"/>
  <patch PatchLevel="010002"
    NodeURL="dysports/dfd/dynsports010002patch.xml"/>
</database>
```

5. Test each new patch level to see how it interacts with previous upgrades.

**Tips for customized DCU sessions**

Remember the following points while customizing a DCU session for your deployment:

- Follow the flow of the standard DCU session. Collect all the information you need to complete the deployment first, then start processing. This approach will become mandatory in future versions of the DCU.

- The order in which you make changes is critical. For example, applying datasets can overwrite existing user data. If you must save the existing data, run a program to move the data to a temporary storage area before applying the datasets that would overwrite the data. Then run another program to add the saved data back to the appropriate tables.

- Because the full Progress Dynamics environment is not available during Phase 1, it is impossible to execute schema triggers when data is written. Procedures running during this phase should alter as few records and as little data as possible.

- In general, the only upgrade procedures that should run during Phase 1 are those needed to migrate data from one schema version to another.

- Test how each change to your application affects your deployment. Consider changing the application design to avoid complex fixes during deployment. Designing your application and deployment should be part of the same iterative cycle.

- Examine all the patch levels for a given deployment for potential conflicts. Each time you add a new patch procedure or ADO, you must verify that it does not cause problems for any of the earlier patches.

- In general, you should use ADOs for your deployments. When possible, run all fix programs on a given set of data in your central development Repository. Then generate the ADOs for your deployment. You should avoid using fix programs in deployments whenever possible.
Starting the DCU

The DCU can be started either from a desktop shortcut or from the command line so that it can be run from third-party installations.

The command line used to start the DCU is as follows:

```
%DLC%\prowin32 -p icfg.w -icfparam DCUSETUPTYPE=user-defined-setup-type
```

Where:

- `%DLC%` is the directory that contains the OpenEdge executable.
- `user-defined-setup-type` is a setup type defined in the DCU driver file.

The DCU should be started in the directory that contains the `iccfg.w` procedure (normally `%DLC%\gui\dynamics`). Since the DCU uses components of the Progress Dynamics framework, the `\af\app` and `\install` subdirectories should be available under DCU’s start directory.
Running the DCU in batch mode

You can run the DCU in batch mode and completely unattended. This facility allows you to provide an automated application installation or upgrade procedure for end-user sites where technical knowledge might be limited. This also allows you to install/upgrade applications in environments without access to a GUI client/server license, such as for sites running WebSpeed-only clients.

For creating a batch-mode DCU procedure, Progress Dynamics provides three components:

- **User interface** — This is the standard DCU GUI that you run with additional command-line parameters. The GUI runs exactly like the full-interactive DCU, except instead of configuring Progress Dynamics (updating the Repository), the additional parameters direct the DCU to store all of the configuration data that you enter in XML files that you specify for use with the DCU batch procedure.

- **Phase 1 configuration** — This is the first DCU batch component, consisting of an ABL procedure (dcuphase1.p) that uses the XML files you generate from the user interface component. This batch component updates the Repository schema and executes various fix programs.

- **Phase 2 configuration** — The is the second DCU batch component, consisting of an ABL procedure (dcuphase2.p). This batch component completes the same Repository update procedure that the full-interactive DCU initiates after logging into the Progress Dynamics environment as an admin user.

To create a batch-mode DCU procedure:

1. Run the DCU GUI to generate the batch-mode XML data files.
2. Create a script that executes dcuphase1.p and dcuphase2.p in sequence, and performs any other actions that you require to complete the application installation or upgrade.

The following sections describe these steps.

Generating the batch-mode data

The data required by the DCU batch components consists of two XML files that you generate using the DCU GUI:

- **DCU script file** — Contains all the data related to ADO paths, what patches must be applied, what ADOs must be loaded and any other information needed to complete the Repository update that is not site specific.

- **DCU site data file** — Contains any data that is site specific. This includes such data as the site number, the connection parameters to the databases, and other information that is specific to the end-user site.

These two files allow you to tailor your batch installations and upgrades to individual end-users of an application using a different file for each site, while maintaining a common set of upgrade data in a common file for all users.
To generate the data for use by the DCU batch components:

1. Create a new Windows shortcut from a copy of the standard Dynamics Configuration Utility shortcut.

2. Open the properties window for the new shortcut and modify the Target field by expanding the -icfparam startup parameter to include the DCUSCRIPTFILE and DCUSITEDATAFILE options using the following syntax:

   **Syntax**

   ```
   DCUSCRIPTFILE=script-file[,DCUSITEDATAFILE=site-data-file]
   ```

   The parameters specify:
   
   - *script-file* — The filename of the DCU script file, including the .xml extension.
   - *site-data-file* — The filename of the DCU site data file, including the .xml extension.

   If you do not specify the DCUSITEDATAFILE option, the DCU writes all of the site-specific data to the specified *script-file*.

   For example, the complete -icfparam value might look like the following:

   ```
   -icfparam
   DCUSCRIPTFILE=dcuscript.xml,DCUSITEDATAFILE=site42.xml
   ```

3. Start the DCU GUI with the new shortcut, connecting to your updated deployment Repository.

4. Respond to the prompts as if you were running the DCU to install or upgrade this Repository at a specified end-user site.

   After you click **Process**, the DCU writes out the specified files instead of doing a Repository upgrade. These files are written to the shortcut **Start in** directory, unless you specify a different directory.

**Creating a batch-mode DCU script**

Write a batch command file or script that executes the two DCU batch procedures, dcuphase1.p and dcuphase2.p, in sequence. Progress Dynamics provides a sample batch command file for you to use as a model (see the “Sample batch-mode DCU script” section on page 5–46).

Both procedures start a complete Progress Dynamics session in order to complete the installation or upgrade of the target Repository. They connect to the target site Repository as necessary and write details of their activity to the log file you specify in the DCU GUI. Each procedure returns a value to the calling script indicating success or failure.
Like any Progress Dynamics session, these procedures require configuration files (-icfparam ICFCONFIG) and session types (-icfparam ICFSESSTYPE) to work. You generate the appropriate configuration files, and Progress Dynamics provides a default session type for each procedure that supports batch clients.

You must also use the -ini startup parameter for each procedure, to specify a .ini file that sets the PROPATH for the batch-mode DCU. For example:

```
[Winchar Startup]
PROPATH=.,OpenEdge_Install\tty\dynamics,OpenEdge_Install\src\dynamics,OpenEdge_Install\src\dynamics\af\sup2,OpenEdge_Install\tty,OpenEdge_Install\tty\adedict.pl,OpenEdge_Install\tty\prodict.pl,OpenEdge_Install\tty\oebuild,OpenEdge_Install\oebuild\make
```

**Note:** These procedures are installed in OpenEdge_Install\src\dynamics.

### Starting up dcuphase1.p

The dcuphase1.p procedure updates the Repository schema and runs various fix programs to prepare for loading the installation or upgrade data. To start up dcuphase1.p, use a command line like the following:

```
bpro -p dcuphase1.p -ini dcubatch.ini -pf dcuphase1.pf
```

The dcubatch.ini file is typically an edited copy of your dynamics.ini file that you use to set the PROPATH appropriately for the batch-mode DCU. You must use a .pf file (dcuphase1.pf in the example) to specify the -icfparam options for the Progress Dynamics session. (The batch character process in Windows does not accept the -icfparam startup parameter specified directly on the command line.) For dcuphase1.p, you specify the same DCU XML files for input using the -icfparam options that you specified to generate these files using the DCU GUI (see the “Generating the batch-mode data” section on page 5–42). For example, you might specify this -icfparam setting in a .pf file, as shown:

```
-icfparam DCUSCRIPTFILE=dcuscript.xml,DCUSITEDATAFILE=site42.xml
```

The DCU script file provides all of the environment settings as you specified them in the DCU GUI. If you do not specify the DCUSITEDATAFILE option, the procedure assumes that the necessary site data is included in the DCU script file.

Note also that dcuphase1.p looks for dcuphase1.xml as the default ICFCONFIG setting, which you generate as a configuration file from your central Repository, and it uses dcuphase1 as the default ICFSESSTYPE setting, a session type that supports batch clients.
Starting up dcuphase2.p

Start up this procedure only if dcuphase1.p completes successfully. This procedure makes a connection to the Repository to load the actual installation or upgrade data. To start up dcuphase2.p, use a command line similar to starting up a Progress Dynamics session in the AppServer environment, except you must specify a session type that supports batch clients, and you must use a .pf file to specify the -icfparam settings, like the following:

```
bpro -p dcuphase2.p -ini dcubatch.ini -pf dcuphase2.pf
```

Again, you use a .ini (dcubatch.ini) file to set the PROPATH appropriately for the batch-mode DCU.

The dcuphase2.pf file might contain the following settings:

```
-icfparam ICFCONFIG=icfconfig.xml,ICFSESSTYPE=dcuphase2
```

Progress Dynamics provides the dcuphase2 session type for you to use this procedure.
Sample batch-mode DCU script

This is the sample batch-mode script (\OpenEdge_Install\src\dynamics\install\dcubatch.bat) provided with Progress Dynamics for you to use as a guide for writing your own batch-mode DCU installation or upgrade procedure:

```batch
@echo off
SET DLC=c:\apps\progress\91e
SET PATH=%DLC%;%DLC%\bin;%PATH%

:CHECKPHASE1ERRFILE
    echo Starting DCU Phase 1...
    if exist dcuphase1err.txt goto DELPHASE1ERRFILE
    goto PROCESSPHASE1

:DELPHASE1ERRFILE
    del dcuphase1err.txt

:PROCESSPHASE1
    SET DISPBANNER=no
    call mbpro -b -p dcuphase1.p -ini dcubatch.ini -pf dcuphase1.pf
    if exist dcuphase1err.txt goto PHASE1FAILED
    echo DCU Upgrade Phase 1 Successful.
    goto CHECKPHASE2ERRFILE

:PHASE1FAILED
    echo *** DCU Upgrade Phase 1 Failed. Please see log file for more information.
    type dcuphase1err.txt
    del dcuphase1err.txt
    goto CLEANUP

:CHECKPHASE2ERRFILE
    echo Starting DCU Phase 2...
    if exist dcuphase2err.txt goto DELPHASE2ERRFILE
    goto PROCESSPHASE2

:DELPHASE2ERRFILE
    del dcuphase2err.txt

:PROCESSPHASE2
    SET DISPBANNER=no
    call mbpro -b -p dcuphase2.p -ini dcubatch.ini -pf dcuphase2.pf
    if exist dcuphase2err.txt goto PHASE2FAILED
    echo DCU Upgrade Phase 2 Successful.
    goto CLEANUP

:PHASE2FAILED
    echo *** DCU Upgrade Phase 2 Failed. Please see log file for more information.
    type dcuphase2err.txt
    del dcuphase2err.txt
    goto CLEANUP

:CLEANUP
    set DISPBANNER=

:END
```

The dcubatch.ini, dcuphase1.pf, and dcuphase2.pf files are also sample files provided with dcubatch.bat, which you can modify as appropriate. You must modify dcubatch.bat for the paths in your Windows environment and reworked to run in a UNIX environment.
Dumping and loading site-specific data

When you upgrade an end-user Repository, it is often necessary for end-users to retain data that is specific to their own site. For example, a user might add menu items to existing menus. When an application upgrade takes place, if no other action has been taken to save them, these items are lost and the user must manually re-create them after your upgrade is complete.

The Site Data Dump and Load utilities allow users to retain their own site-specific data. It does this by exporting the Repository data for site-specific tables in OpenEdge dump file format prior to running your upgrade, then by loading that data back into the Repository after the Progress Dynamics deployment datasets have been applied.

These utilities can be run in one of two ways:

- From within the Progress Dynamics Configuration Utility
- From a free-standing GUI window

Site Data Dump and Load utilities architecture

The Site Data Dump and Load utilities are driven by a configuration file (dumpconfig.txt) that is stored in a .d text (OpenEdge dump file) format in the first sitedatadump directory found in the sessions PROPATH. This file defines a list of dump programs, load programs, data files, and site numbers to support the dumping and loading of site-specific data. The sitedatadump directory must exist and must contain a valid dumpconfig.txt file for this tool to work.

The use of these utilities follows this processing sequence:

1. The dump utility (dcusitedatadump.p) reads the configuration file to derive a list of dump programs to run and the site numbers for which data are to be dumped.

2. The dump utility runs the specified dump programs, which export the data to .d files that are to be read during the later import phase.

   Note: You can hook the dump utility into the DCU so the data is automatically dumped during the DCU upgrade process.

3. The load utility (dcusitedataload.p) then reads the configuration file to derive a list of load programs to run.

4. The load utility runs the specified load programs to read the data dumped by the dump utility and import it back into the Repository.

   Note: As with the dump utility, you can hook the load utility into the DCU so the data is automatically loaded during the DCU upgrade process.

The dump and load programs called by these utilities are partly user-defined procedures. These procedures must adhere to a certain standard described in the following sections. Most of the code in these programs comes from standard include files. You must add only the small pieces of information needed to specialize the dump or load program for a particular table.
Three sets of default dump and load programs have been specifically written to support
dumping and loading the contents of the following framework tables:

- `gsm_menu_structure_item`
- `gsm_toolbar_menu_structure`
- `gsm_object_menu_structure`

To run the Site Dump and Load utilities interactively without the DCU, Progress Dynamics
provides a utility program (`sitedatadmpload.w`) that displays a simple GUI for you to invoke
each dump or load utility as you require.

### Setting up the utilities

You must complete several tasks to prepare the Site Data Dump and Load utilities to work in a
particular site environment.

#### To set up the Site Data Dump and Load utilities:

1. Write the dump/export programs.
2. Write the load/import programs.
3. Create the `dumpconfig.txt` file.
4. Invoke the dump and load utilities as appropriate.

All of the code and example code for the utilities resides in `OpenEdge_Install/src/dynamics/db/icf/dfd`. Table 5–7 lists the files that are included in
that directory (relative to the default PROPATH entry, `OpenEdge_Install/src/dynamics`).

#### Table 5–7: Site Data Dump and Load installed files (1 of 2)

<table>
<thead>
<tr>
<th>Path name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>db/icf/dfd/dcusitedata.xml</code></td>
<td>Sample XML file that shows how to hook these utilities into the DCU</td>
</tr>
<tr>
<td><code>db/icf/dfd/dcusitedatadump.p</code></td>
<td>The DCU-callable procedure that calls the dump programs</td>
</tr>
<tr>
<td><code>db/icf/dfd/dcusitedataload.p</code></td>
<td>The DCU-callable procedure that calls the load programs</td>
</tr>
<tr>
<td><code>db/icf/dfd/dumpconfig.txt</code></td>
<td>A sample configuration file that can be used to dump all data in the <code>gsm_menu_structure_item</code>, <code>gsm_toolbar_menu_structure</code>, and <code>gsm_object_menu_structure</code> tables</td>
</tr>
<tr>
<td><code>db/icf/dfd/gsmitin.p</code></td>
<td>Import program for <code>gsm_menu_structure_item</code></td>
</tr>
<tr>
<td><code>db/icf/dfd/gsmitout.p</code></td>
<td>Export program for <code>gsm_menu_structure_item</code></td>
</tr>
<tr>
<td><code>db/icf/dfd/gsmomin.p</code></td>
<td>Import program for <code>gsm_object_menu_structure</code></td>
</tr>
</tbody>
</table>
Writing a dump program

The following is a sample dump program using default code that you can use to export the contents of the gsm_menu_structure_item table:

```c
/* gsmitout.p */
{db/icf/dfd/sitedataprocout.i
 &OutputFile = "gsmitout.d"
 &OutputTable = "gsm_menu_structure_item"
 &ObjField = "menu_structure_item_obj"}
```

This program assumes that the data to be dumped is from a table that has an object ID field of data type decimal (ObjField include file directive). The object ID’s mantissa is used to determine the site number of the data to be dumped. The OutputFile include file directive provides a character string name for the file to be dumped. All dumped data is written to the first directory named sitedatadump that can be found in the PROPATH. The OutputTable directive contains the name of the table to be exported.
Using the default sitedataprocout.i include file to provide all of the code is the easiest way to produce a dump program. This code automatically exports the specified data for all sites listed in the dumpconfig.txt file to the dump files that are later read by a load program.

If you must add any special customizations, you can use code based on the following example to dump the data:

**gsmitout.p sample using customized code**

```plaintext
/* Include the parameters required for this program */
{db/icfdfd/sitedatahdrout.i}

/* Find the record in the ttDumpFileLocation table for the output file */
FIND ttDumpFileLocation
   WHERE ttDumpFileLocation.cDumpFile = {&OutputFile} NO-ERROR.

/* If no record exists, or the path is ?, we do not need to write this file out. Simply return to the caller. */
IF NOT AVAILABLE(ttDumpFileLocation) OR
   ttDumpFileLocation.cDumpFilePath = ? THEN RETURN.

/* Open the stream that we will write the data out on and make sure we APPEND to it. The file may have been created on a previous call to this program. The caller will have ensured that the file was a new file before the first call */
OUTPUT TO VALUE(ttDumpFileLocation.cDumpFilePath) APPEND.

FOR EACH /* table that we need to dump */
   WHERE (Table.ObjID - TRUNCATE(Table.ObjID,0)= pdSiteNo):
      /* This where clause gets us only the records for the site number that was passed into this procedure as a parameter. */
      EXPORT Table.
END.

OUTPUT CLOSE.
```

The comments in the above code describe what must be in the code. Two parameters defined in sitedatahdrout.i are passed to this procedure when it is called. The first is the site number for which data should be dumped in the mantissa of the pdSiteNo decimal field. The second is the table containing the dump file locations. It might be that your dump program requires more than one export file. The dumpconfig.txt file provides for this by allowing you to refer to the export file by the name you specify. For more information, see the “Creating a dumpconfig.txt file” section on page 5–53.
Writing a load program

The load program is slightly more complicated than the dump program because it must verify the referential integrity of the data. The following shows a sample load program using both default and user-supplied code to import the contents of the gsm_menu_structure_item table:

**gsmitin.p sample with user-supplied code for referential integrity**

```plaintext
/* gsmitin.p */
&SCOPED-DEFINE InputTable gsm_menu_structure_item
&SCOPED-DEFINE ObjField menu_structure_item_obj

{db/icf/dfd/sitedataprocini.i &InputFile = "'gsmitout.d'"}
{db/icf/dfd/siteapplyrchdr.i}

IF NOT CAN-FIND(FIRST gsm_menu_structure
   WHERE gsm_menu_structure.menu_structure_obj =
   tt_{&InputTable}.menu_structure_obj) THEN RETURN.

IF tt_{&InputTable}.menu_item_obj <> 0.00 AND
   NOT CAN-FIND(FIRST gsm_menu_item
      WHERE gsm_menu_item.menu_item_obj = tt_{&InputTable}.menu_item_obj) THEN RETURN.

IF tt_{&InputTable}.child_menu_structure_obj <> 0.00 AND
   NOT CAN-FIND(FIRST gsm_menu_structure
      WHERE gsm_menu_structure.menu_structure_obj =
      tt_{&InputTable}.child_menu_structure_obj) THEN RETURN.

/* Duplicate record */
IF CAN-FIND(FIRST gsm_menu_structure_item
   WHERE gsm_menu_structure_item.menu_structure_obj =
   tt_{&InputTable}.menu_structure_obj
   AND gsm_menu_structure_item.menu_item_sequence =
   tt_{&InputTable}.menu_item_sequence) THEN RETURN.

{db/icf/dfd/siteapplyrecftr.i}
```

The **InputTable** compiler directive contains the name of the table for which data is to be imported. The **ObjField** compiler directive specifies the field that is the object ID field for the table. The **InputFile** include file directive specifies the name of the file to be used as the source of the data to be imported.

This load program takes the ttDumpFileLocation table as an input parameter (sitedatadhrin.i from within sitedataprocini.i), and the above default code reads that data into a temp-table that is constructed LIKE the table being imported (sitedataprocini.i). The temp-table is named tt_Table, where Table is the name of the table that is being imported.
Once the code in sitedatprocin.i has imported the code into the temp-table, a buffer to the temp-table is passed to an internal procedure called applyRecord. This is the only piece of code that must be customized. The header for this internal procedure is contained in siteapplyrechdr.i. By default, this code checks to see if a record exists with the object ID of the current record. If it does, the code assumes that the data has been supplied by the ADOs and that it should not be changed.

The footer for the applyRecord procedure is contained in siteapplyrecftr.i and includes the transaction that commits the data in the temp-table to the database.

You (or your end-user) supply all of the code specified between the siteapplyrechdr.i and siteapplyrecftr.i include file references. This code is responsible for verifying the referential integrity of the data being imported. If any of the integrity checks fail, control returns to the caller. This results in the main block importing the next record from the .d file and verifying that it is correct.

You can completely customize the code for the load program, as in the following example:

**gsmitin.p sample with completely customized code**

```plaintext
/* sitedatahdrin contains the parameter definitions for the import program. */
{db/icf/dfd/sitedatahdrin.i}

DEFINE VARIABLE iLineNo AS INTEGER NO-UNDO.
DEFINE TEMP-TABLE tt_{&InputTable} LIKE {&InputTable}.

/* Find the import file name */
FIND ttDumpFileLocation
   WHERE ttDumpFileLocation.cDumpFile = {&InputFile} NO-ERROR.

/* If its not available, ignore it and let the caller call the next import program */
IF NOT AVAILABLE(ttDumpFileLocation) OR
   ttDumpFileLocation.cDumpFilePath = ? THEN RETURN.

/* Look for the dump file on disk. */
IF SEARCH(ttDumpFileLocation.cDumpFilePath) = ? THEN DO:
   PUBLISH "DCU_WriteLog":U ("WARNING: Import file not found: " +
                              ttDumpFileLocation.cDumpFilePath).
   RETURN.
END.
ELSE
   PUBLISH "DCU_WriteLog":U ("Reading data from: " +
                              ttDumpFileLocation.cDumpFilePath).

/* Open the input stream for the dump file */
INPUT FROM VALUE(ttDumpFileLocation.cDumpFilePath).

/* Loop until we have read the whole dump file. */
REPEAT:
   /* Import the data from the .d file */
   CREATE tt_{&InputTable}.
   IMPORT tt_{&InputTable}.
   iLineNo = iLineNo + 1.

   /* Do whatever referential integrity checks here */
   DELETE tt_{&InputTable}.
END.

INPUT CLOSE.
PUBLISH "DCU_WriteLog":U ("Finished reading data from: " +
                               ttDumpFileLocation.cDumpFilePath).```
Creating a dumpconfig.txt file

The dumpconfig.txt file provides the processing directions for the Site Data Dump and Load utilities. This file must exist on the PROPATH as sitetadump/dumpconfig.txt for these utilities to work.

This file is a dump (.d) formatted file that can be imported using the ABL’s IMPORT statement to load a table of instructions to follow. The file can contain multiple lines that specify all of the fields listed in Table 5–8.

Table 5–8: Field options for creating the dumpconfig.txt file

<table>
<thead>
<tr>
<th>Field no.</th>
<th>Name</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Record Type</td>
<td>CHARACTER</td>
<td>The type of record that is being imported. This can be:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• &quot;I&quot; for the load program file to run</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• &quot;D&quot; for the dump file to read or write</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• &quot;O&quot; for the dump program file to run</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• &quot;S&quot; for site number</td>
</tr>
<tr>
<td>2</td>
<td>Group Number</td>
<td>INTEGER</td>
<td>If Record Type is one of &quot;I,&quot; &quot;D,&quot; or &quot;O,&quot; it is used to group the records</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>for a dump and load set together.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If Record Type is &quot;S,&quot; it contains the specific site number of the data to</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>dump and load.</td>
</tr>
<tr>
<td>3</td>
<td>Filename</td>
<td>CHARACTER</td>
<td>Depending on the Record Type, it contains a:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Relative path name of the dump or load program in the PROPATH</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Dump filename</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• A special token or string for the site number</td>
</tr>
</tbody>
</table>

The following shows the default dumpconfig.txt file that ships with the utility software:

```
dumpconfig.txt

"D" 1 "db/icf/dfd/gsmomout.d"
"I" 1 "db/icf/dfd/gsmomin.p"
"D" 2 "gsmomout.d"
"O" 2 "db/icf/dfd/gsmomout.p"
"I" 2 "db/icf/dfd/gsmomin.p"
"D" 2 "gsmomout.d"
"O" 3 "db/icf/dfd/gsmtmout.p"
"I" 3 "db/icf/dfd/gsmtmin.p"
"D" 3 "gsmtmout.d"
"S" 0 "&S"
```

The first three lines of this file contain the default data needed to dump and load the gsm_menu_structure_item table.
Line 1 contains information on the dump program. The Record Type is "O" for output, indicating that the line contains information about the dump program itself. The Group Number is 1, and note that all the first three lines have the same Group Number. This number relates the data file with its corresponding dump and load programs. In other words, a dump program, its corresponding load program, and data files must all have the same Group Number. For the dump program, the Filename field contains the program filename, including its relative path, used to dump the data out.

Line 2 contains information on the load program. The Record Type is "I" for input, indicating that the line contains information about the load program. The Group Number is the same as the group number for the corresponding dump program, and the Filename contains the load program filename, including its relative path.

Line 3 contains information about the data file that is the dump file target. The Record Type is "D" for dump file. The Group Number is the same as for the corresponding dump and load program lines, and the Filename is the name of a file that will be written to and read from the first sitedatadump directory in the PROPATH. Note that you can associate more than one dump file with a dump and load program group. The Filename field is used as the key to retrieve the file information. During the process of reading the dumpconfig.txt file, the utilities determine the full path to this file and verify that it is accessible, storing the result in the ttdDumpFileLocation.cDumpFilePath field. Because this is a verified path name, all INPUT FROM and OUTPUT TO statements should use the value of this field to determine the correct file to read from or write to.

The next six lines of this file contain dump and load information for the gsm_object_menu_structure and gsm_toolbar_menu_structure tables.

The final line of the file contains a site number record. The Record Type is set to "S" for site number. The Group Number is 0 and the Filename is "&S". This line is a special case. If the Group Number is 0 and the Filename is "&S", the dump utility determines the site number of the currently connected Progress Dynamics Repository and uses that number as the site number for data to be dumped.

If you want to specify a specific site number for which to dump and load the data, instead of using 0, set the Group Number to the value of the site number and set the Filename to the empty string ("""). The following line causes the dump program to dump all data for site number 95:

"S" 95 ""

The default dumpconfig.txt file provided in the src/dynamics/db/icf/dfd directory directs these utilities to dump and load data for the gsm_menu_structure_item, gsm_toolbar_menu_structure, and gsm_object_menu_structure tables that were created in a session connected to the current Repository. To make these utilities work, copy the dumpconfig.txt file to a directory named sitedatadump somewhere in the session PROPATH and run the utilities as appropriate.
Using the GUI

To invoke the Site Data Dump and Load utilities using the stand-alone GUI, run the program `OpenEdge_Install/src/dynamics/db/icf/dfd/sitedatadmpload.w`. This program opens a window like the one shown in Figure 5–3.

![Figure 5–3: Stand-alone GUI for Site Data Dump and Load utilities](image)

Choosing the **Start Dump** button invokes the Site Data Dump utility, which exports the data and displays information on the export process in the large editor on the screen. After dumping the data (indicated by the message, “Site data export complete.”), load any ADOs required to update the Repository. After this ADO load is complete, you can invoke the load utility.

Choosing the **Start Load** button invokes the Site Data Load utility, which imports the data that you just exported and displays information on the import process in the large editor on the screen.
Calling the Utility from the DCU

To invoke the Site Data Dump and Load utilities from the DCU, you must add the following data to the last patch file used by the DCU for an upgrade:

```xml
<PatchStage Stage="PreADOLoad">
  <Program>
    <FileType>p</FileType>
    <FileName>db/icf/dfd/dcusitedatadump.p</FileName>
    <Description>Dumping site specific data</Description>
    <Rerunnable>yes</Rerunnable>
    <NewDB>no</NewDB>
    <ExistingDB>yes</ExistingDB>
    <UpdateMandatory>yes</UpdateMandatory>
  </Program>
</PatchStage>

<PatchStage Stage="PostADOLoad">
  <Program>
    <FileType>p</FileType>
    <FileName>db/icf/dfd/dcusitedataload.p</FileName>
    <Description>Loading site specific data</Description>
    <Rerunnable>yes</Rerunnable>
    <NewDB>no</NewDB>
    <ExistingDB>yes</ExistingDB>
    <UpdateMandatory>yes</UpdateMandatory>
  </Program>
</PatchStage>
```

The first `<PatchStage>` node adds the dump utility to the PreADOLoad section of the patch file. This invokes the dump utility to export the site data after the schema updates have been applied to the Repository, but before the ADOs are actually loaded.

The second `<PatchStage>` node adds the load utility to the PostADOLoad section of the patch file. This invokes the load utility to import the site data that was dumped before the ADOs were applied to the Repository, but after the ADOs are actually loaded.
Using OpenEdge DataServers with Progress Dynamics

This appendix describes some of the factors you should consider when using an OpenEdge DataServer™ in the Progress Dynamics environment, as outlined in the following sections:

- Overview
- Connecting the database
- Programming considerations
- Other useful documentation
Overview

When you access a non-OpenEdge database with an OpenEdge DataServer, there are unique considerations in the Progress Dynamics environment. Before using a DataServer with Progress Dynamics, you should be familiar with both the Progress Dynamics framework and integrating a DataServer in a traditional OpenEdge application. The “Other useful documentation” section on page A–7 lists several documents that cover the use of OpenEdge DataServers in detail.

Progress Dynamics support for DataServers

In Progress Dynamics, you can access non-OpenEdge databases that are supported by the OpenEdge DataServers for Oracle and Microsoft SQL Server.

When to use DataServers with Progress Dynamics

The database of choice for the Progress Dynamics framework is the OpenEdge database. The framework and database are highly integrated with each other. This allows you to take advantage of unique features that are not available with non-OpenEdge database solutions. Typically, using an OpenEdge database gives the best performance for any OpenEdge-based application.

In some cases, a non-OpenEdge database provides the best solution in a specific business situation. For example, in a business environment that already uses a non-OpenEdge database, your Progress Dynamics application might need to access the existing database. Using a OpenEdge DataServer, you can take advantage of the powerful features available from the framework and keep legacy applications that access the existing database in production at the same time.

Requirements for DataServers in Progress Dynamics

When you use a DataServer in a Progress Dynamics application, you must plan for it in your application’s design. In general, ABL code that runs against a DataServer can also run against a OpenEdge database. Exceptions are code that makes calls unique to the non-OpenEdge database, such as to access stored procedures.

The framework requires a Repository database. While the data that your application uses can be in a non-OpenEdge database accessed by an OpenEdge DataServer, the Repository must be an OpenEdge database.
Connecting the database

A major difference between Progress Dynamics applications that connect to OpenEdge databases and those that use DataServers is how the database connection is entered. With the DataServer, setting the connection includes making connections for both the schema holder database and the non-OpenEdge database. You create a connection to the schema holder database as normal using the Progress Dynamics tools. For that connection, the area for additional parameters includes the connection information for the non-OpenEdge database. You do not set up a separate database connection for the non-OpenEdge database. The “Schema holder database” section on page A–5 gives details on setting the connection parameters.

You can set up the connection to the schema holder database by creating a new Physical Service using the Administration tool. The connection to the schema holder database is saved in the icfconfig.xml file generated by the Progress Dynamics session tools.

You can also handle the connection programmatically. You can use this method if you do not need the non-OpenEdge database connected at application startup.

Configuring OpenEdge DataServer for MS SQL Server

This section provides an example of setting up the connection with the OpenEdge DataServer for MS SQL Server. You must supply the following connection parameters when you set up the connection to the schema holder database:

- `_progress_schema_holder_name`
- `host`
- `service`
- `TCP`
- `ODBC_DSN_name`
- `SQL_Server_db`
- `user_name`
- `password`
- `broker_host`
- `broker_service`
- `TXN_ISOLATION`

You first supply the startup parameters for the schema holder database (`_progress_schema_holder_name`, etc.). The remaining parameters are used to start the DataServer connection to the non-OpenEdge database (`ODBC_DSN_name`, etc.).

The following example shows how this information is stored in the icfconfig.xml configuration file:

```
<service>
  <cServiceType>Database</cServiceType>
  <cServiceName>MSS</cServiceName>
  <cPhysicalService>MSSn</cPhysicalService>
  <cConnectParams>-db sh_mydb -H localhost -S demo_svc -db mss_dsn_db -ld mss_db -dt MSS -U icftest -P icftest -Dsrv TXN_ISOLATION,1</cConnectParams>
  <lDefaultService>no</lDefaultService>
  <lCanRunLocal>yes</lCanRunLocal>
  <iStartOrder>0</iStartOrder>
</service>
```

Consider the following points:

- For Microsoft SQL Server, the database type is always MSS.
- The DSN name is the configured DSN that you use to access the MS SQL Server database with ODBC. It does not need to be the same name as the SQL Server database. When the DSN is configured, the name of the physical MS SQL Server database is specified.
• The logical name for the database is the name that you use to access the MS SQL Server database with ABL. If a logical name is not specified, the default logical name is used. This is the name of the DSN for MS SQL Server.

• The isolation level is set to one using -Dsrv TXN_ISOLATION,1. This provides OpenEdge-like locking using MS SQL Server’s read uncommitted transaction isolation level.

• The -ld and -dt parameters are optional.

• If the schema holder is on the same machine as the client, then the -H and -S parameters for the schema holder are optional.

• Because this example is for a system using the Personal version of the MS SQL Server DataServer, the -H and -S parameters are not specified for the database broker. If your system uses the enterprise version, the -H and -S parameters are needed if the database broker is located on a machine other than the client. The “Configuring OpenEdge DataServer for Oracle” section on page A–4 provides an example of using these parameters.

### Configuring OpenEdge DataServer for Oracle

This section provides an example of setting up the connection with the OpenEdge Oracle® DataServer. You must supply the following connection parameters when you set up the connection to the schema holder database:

- 
  -db Progress_schema_holder_name -H host -S service -N TCP
  -db Oracle_db_name -ld same_Oracle_name -dt ORACLE
  -U "name/password@Oracle_instance" -H broker_host -S broker_service

You first supply the startup parameters for the schema holder database (Progress_schema_holder_name, etc.). The remaining parameters are used to start the DataServer connection to the non-OpenEdge database (Oracle_db_name, etc.).

The following example shows how this information is stored in the icfconfig.xml configuration file:

```xml
<service>
  <cServiceType>Database</cServiceType>
  <cServiceName>ORA</cServiceName>
  <cPhysicalService>ORAn</cPhysicalService>
  <cConnectParams>-db sh_oratest -N TCP -H client_system -S demo_svc1
                -db ora_db -ld ora_db -dt ORACLE -U "icftest/icftest@test821"
                -H server_system -S demo_svc2</cConnectParams>
  <lDefaultService>no</lDefaultService>
  <lCanRunLocal>yes</lCanRunLocal>
  <iStartOrder>0</iStartOrder>
</service>
```
Consider the following points:

- For Oracle, the database type is always ORA.

- For the Oracle connection, you must use double quotes around the user name and password. If double quotes are not used, Progress Dynamics might incorrectly parse the connection string.

- The -ld and -dt parameters are optional.

- If the schema holder is on the same machine as the client, then the -H and -S parameters for the schema holder are optional.

- In this example, the second set of -H and -S parameters specify the location of the database broker. If the database broker is located on a different machine than where the client is running, you must specify the -H and -S parameters.

**Schema holder database**

A schema holder database is an OpenEdge database that holds information about the schema of the non-OpenEdge database, such as the names of tables and the offsets of where particular fields or columns begin. The DataServer only accesses the schema holder the first time a table on the non-OpenEdge database is accessed. In a run-time environment, new and modified data are not stored in the schema holder database. Instead, the new and modified data are stored in the non-OpenEdge database. Therefore, the schema holder database usually is connected as read-only. Connecting read-only allows you to access the schema holder database slightly faster and improves performance.

**Caution:** In a Progress Dynamics environment, OpenEdge does not support combining into a single OpenEdge database the tables and data for the schema holder and the tables and data for the Repository. The main drawback to that implementation is the loss of both environments if one becomes corrupted. For example, if the schema holder data and the Repository data are stored in one database and there is a problem, such as corruption, then both the schema holder and the Repository must be restored.

**Progress Dynamics configurations with DataServers**

Configuring a Progress Dynamics environment to use a DataServer is similar to configuring Progress Dynamics when using an OpenEdge database. The only difference is in the database connections. For the DataServer connection, there is a connection to both the schema holder database and the non-OpenEdge database.

For more information on possible configurations, see the “Utilizing Progress DataServers with Progress Dynamics” white paper described in the “Other useful documentation” section on page A–7.
Programming considerations

There are special considerations you must take into account when you develop a Progress Dynamics application that uses a DataServer. This section describes these considerations.

Indexes

OpenEdge DataServers allow non-OpenEdge database views to be used in an OpenEdge environment. Generally, a view does not need an index when accessed with ABL. A view is treated as a read-only table.

Progress Dynamics requires that each table have an index. One reason for this requirement is that Progress Dynamics makes extensive use of ROWID. To use a view in Progress Dynamics, you must add an index to the schema holder for the view. If an index is not added to the schema holder, the view can still be used as a table. However, the data from the view is not displayed.

You can also use an OpenEdge DataServer to access a non-OpenEdge database table that does not have an index defined. For the same reason, you would have similar problems accessing this data. To see the data in such a table using Progress Dynamics, you must add an index.

Two-phase commit

Two-phase commit is not supported when using the OpenEdge DataServer to access non-OpenEdge databases. Without two-phase commit, in some cases you cannot guarantee that either all of the database updates or none of the database updates are written at the end of the transaction. This happens when there are updates to several databases within one transaction, and when one or more of those databases are accessed through a DataServer.

The Progress Dynamics environment always has multiple databases connected. This makes the lack of two-phase commit of special interest when you use DataServers in Progress Dynamics. However, the design of the Progress Dynamics framework limits where a single transaction might update more than one database. The main areas of concern are for the auditing and comment support.

The built-in auditing and commenting features of Progress Dynamics are optional. If you use these features and an OpenEdge DataServer, then a failure during a transaction could cause an inconsistent state in the databases. Although the window for this type of failure is small, you might want to avoid using these optional features if you cannot afford a failure of this type.
Other useful documentation

There are few differences between developing a Progress Dynamics application that only uses OpenEdge databases and one that uses a DataServer to access non-OpenEdge databases. Remember that ABL restrictions and performance considerations documented in the OpenEdge DataServer guides and white papers also apply in a Progress Dynamics environment. All those development requirements apply to Progress Dynamics when accessing a DataServer. Success in this environment depends on fully understanding each of the components involved in your application environment.

OpenEdge Documentation

The following guides describe how to use the DataServers to access non-OpenEdge databases and provide instructions for building the DataServer modules, a discussion of programming considerations, and a tutorial:

- *OpenEdge Data Management: DataServer for Oracle*
- *OpenEdge Data Management: DataServer for Microsoft SQL Server*

White papers

OpenEdge white papers can be found in the PSDN library. Select the DataServers tab to see the available white papers on OpenEdge DataServers. The direct link to the white papers is:

http://psdn.progress.com/library/white_papers/index.ssp

You can find the following white papers in either the Progress Dynamics collection or the DataServers collection:

- “Utilizing Progress DataServers with Progress Dynamics”
  This document covers the unique considerations for using DataServers in a Progress Dynamics environment.

- “DataServer Best Practices”
  This document is a guide to help project managers and application developers understand and estimate the work involved in adopting the OpenEdge DataServer technology. This document contains advice for the Oracle, MS SQL Server, and ODBC OpenEdge DataServer products.

- “Building High Performance Applications with the OpenEdge Oracle DataServer”
  This paper helps you create high performance applications with ABL and WebSpeed toolsets to integrate with an Oracle® relational database management system (RDBMS). It explains how the OpenEdge Oracle DataServer supports the development and delivery of high performance applications on an Oracle database.
“Configuration and Coding Techniques for the OpenEdge DataServer for Microsoft SQL Server”

Achieving high performance from your DataServer for Microsoft SQL Server applications involves optimizing the system’s configuration and using the most effective querying and transaction management techniques. This white paper explains how to tune every piece of the DataServer architecture and how to write data-access logic that allows you to take best advantage of OpenEdge and SQL Server resources.
This appendix describes the Progress Dynamics session properties, shown in Table B–1. For information about defining properties for a session, see Chapter 2, “Defining and Managing Sessions.”

### Table B–1: Progress Dynamics session properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AB_compile_into_directory</td>
<td>AppBuilder object code root directory.</td>
</tr>
<tr>
<td>AB_source_code_directory</td>
<td>AppBuilder source code root directory.</td>
</tr>
<tr>
<td>allow_anonymous_login</td>
<td>Determines whether anonymous logins are allowed for WebSpeed.</td>
</tr>
<tr>
<td>anonymous_user_name</td>
<td>Used if allow_anonymous_login is on.</td>
</tr>
<tr>
<td>anonymous_user_password</td>
<td>Password to apply to anonymous_user_name.</td>
</tr>
<tr>
<td>auto_dump_entity_cache</td>
<td>Indicates to Progress Dynamics if it is to dump the entity cache to disk at session shutdown. The default is YES.</td>
</tr>
<tr>
<td>bound_icfdb</td>
<td>Specifies whether a session type is bound or unbound. Set this property on sessions that are connected before Progress Dynamics starts to ensure correct generation of icfconfig.xml.</td>
</tr>
<tr>
<td>ClassIgnoreContainedInstances</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>client_cache_directory</td>
<td>An absolute path where the client cache is generated and accessed.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>configuration_source</td>
<td>Defines how a session type is treated when it is initialized.</td>
</tr>
<tr>
<td>CustomizationTypePriority</td>
<td>Comma-separated list of customization codes in order of priority.</td>
</tr>
<tr>
<td>DCUSETUPTYPE</td>
<td>Derived from DCUSETUPTYPE -icfparam (used only by the DCU).</td>
</tr>
<tr>
<td>display_login_screen</td>
<td>Indicates whether the login screen should be displayed.</td>
</tr>
<tr>
<td>field_cache_options</td>
<td>Specifies what DynCombo and DynLookup SDF classes have their data cached on the client (all or a comma-separated list). If you do not define this property or specify it with a blank value, no SmartDataFields have their data cached.</td>
</tr>
<tr>
<td>ICFCONFIG</td>
<td>Derived from -icfparam ICFCONFIG.</td>
</tr>
<tr>
<td>ICFPATH</td>
<td>Derived from -icfparam ICFPATH.</td>
</tr>
<tr>
<td>ICFPATH1</td>
<td>Derived from -icfparam ICFPATH.</td>
</tr>
<tr>
<td>ICFPATHn</td>
<td>Derived from -icfparam ICFPATH.</td>
</tr>
<tr>
<td>ICFSESTYPE</td>
<td>Derived from -icfparam ICFSESTYPE.</td>
</tr>
<tr>
<td>IDEPalette</td>
<td>Comma-separated list of AppBuilder palette objects. The default is PaletteDynamics.</td>
</tr>
<tr>
<td>IDETemplate</td>
<td>Comma-separated list of master template objects to load for the AppBuilder. The default list is: templateContainer, templateSmartObject, templateProcedure, templateWebIObject.</td>
</tr>
<tr>
<td>image_path</td>
<td>A comma-separated list of relative paths for where the User Interface Managers looks for images like toolbar icons. Images for Web applications might not be stored in the standard directory specified in the Repository. The format is 'old-directory,new-directory'. The default value is 'ry/img,,../img/'.</td>
</tr>
<tr>
<td>keep_old_field_api</td>
<td>Specifies if Progress Dynamics uses the performance-optimized API for dynamic combos and lookups or uses the API that is available in versions prior to 2.1B, without these optimizations.</td>
</tr>
<tr>
<td>login_procedure</td>
<td>Login procedure to be used at session startup.</td>
</tr>
<tr>
<td>MaxHiddenContainers</td>
<td>Specifies the maximum number of dynamic frames that can be kept alive (hidden) for a single dynamic TreeView instance after being closed by the user. The default is 10.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>menu_images</td>
<td>Displays images on menu (TreeView) if set to “enabled”.</td>
</tr>
<tr>
<td>OG_ValidateFrom</td>
<td>Used by the Object Generator to determine validation logic within DLCProc.</td>
</tr>
<tr>
<td>physical_session_list</td>
<td>Automatically inserted into ICFCONFIG from session type.</td>
</tr>
<tr>
<td>print_preview_preference</td>
<td>The format for the data exported by Print Preview, including XML (default), HTML, and Crystal.</td>
</tr>
<tr>
<td>print_preview_stylesheet</td>
<td>An XML (.xsl) or HTML (.css) style sheet to apply to data exported by Print Preview.</td>
</tr>
<tr>
<td>root_directory</td>
<td>Root directory.</td>
</tr>
<tr>
<td>run_local</td>
<td>Specifies to run the session locally.</td>
</tr>
<tr>
<td>session_appl_alert_boxes</td>
<td>SESSION:APPL-ALERT-BOXES setting.</td>
</tr>
<tr>
<td>session_context_help_file</td>
<td>SESSION:CONTEXT-HELP-FILE setting.</td>
</tr>
<tr>
<td>session_data_entry_return</td>
<td>SESSION:DATA-ENTRY-RETURN setting.</td>
</tr>
<tr>
<td>session_date_format</td>
<td>SESSION:DATE-FORMAT setting.</td>
</tr>
<tr>
<td>session_debug_alert</td>
<td>SESSION:DEBUG-ALERT setting.</td>
</tr>
<tr>
<td>session_immediate_display</td>
<td>SESSION:IMMEDIATE-DISPLAY setting.</td>
</tr>
<tr>
<td>session_multitasking_interval</td>
<td>SESSION:MULTITASKING-INTERVAL setting.</td>
</tr>
<tr>
<td>session_numeric_format</td>
<td>SESSION:NUMERIC-FORMAT and SESSION:SET-NUMERIC-FORMAT setting.</td>
</tr>
<tr>
<td>session_propath</td>
<td>PROPATH setting.</td>
</tr>
<tr>
<td>session_suppress_warnings</td>
<td>SESSION:SUPPRESS-WARNINGS setting.</td>
</tr>
<tr>
<td>session_system_alert_boxes</td>
<td>SESSION:SYSTEM-ALERT-BOXES setting.</td>
</tr>
<tr>
<td>session_time_format</td>
<td>Time format used as a format mask.</td>
</tr>
<tr>
<td>session_time_source</td>
<td>SESSION:TIME-SOURCE setting.</td>
</tr>
<tr>
<td>session_tooltips</td>
<td>Session ToolTips.</td>
</tr>
<tr>
<td>session_v6display</td>
<td>SESSION:V6DISPLAY setting.</td>
</tr>
<tr>
<td>session_year_offset</td>
<td>Session year offset attribute.</td>
</tr>
<tr>
<td>setup_type</td>
<td>Name of a custom session type for setting up an application with the DCU.</td>
</tr>
<tr>
<td>setup_type_file</td>
<td>Relative pathname of the custom DCU driver file used to run a custom DCU session type.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>StartupCacheClasses</td>
<td>Comma-separated list of the names of classes that are to be cached when the session starts.</td>
</tr>
<tr>
<td>StartupCacheMenusForObjects</td>
<td>A comma-delimited list of logical names for Repository containers whose menus are to be precached at session startup.</td>
</tr>
<tr>
<td>StartupCacheToolbars</td>
<td>A comma-delimited list of logical names for toolbars to precache at session startup.</td>
</tr>
<tr>
<td>startup_procedure</td>
<td>Startup Procedure.</td>
</tr>
<tr>
<td>startup_procedure10</td>
<td>Startup Procedure 10.</td>
</tr>
<tr>
<td>startup_procedure20</td>
<td>Startup Procedure 20.</td>
</tr>
<tr>
<td>UseThinRendering</td>
<td>Specifies if Progress Dynamics uses a defined thin rendering procedure to render a given object at run time.</td>
</tr>
<tr>
<td>valid_os_list</td>
<td>Automatically inserted into ICFCONFIG from session type.</td>
</tr>
<tr>
<td>window_title</td>
<td>Title to use for the DCU window when running with a custom session type for application setup.</td>
</tr>
<tr>
<td>_debug_tools_on</td>
<td>Switches on special tools in the framework for diagnostics.</td>
</tr>
<tr>
<td>_framework_code_directory</td>
<td>Framework directory containing code that is currently being run.</td>
</tr>
<tr>
<td>_framework_directory</td>
<td>Directory from which the framework is running.</td>
</tr>
<tr>
<td>_framework_drive_letter</td>
<td>Drive letter from which the framework is running.</td>
</tr>
<tr>
<td>_framework_gui_directory</td>
<td>Framework directory containing GUI code.</td>
</tr>
<tr>
<td>_framework_root_directory</td>
<td>Framework directory excluding /src, /gui, or /tty.</td>
</tr>
<tr>
<td>_framework_source_directory</td>
<td>Framework directory containing source code.</td>
</tr>
<tr>
<td>_framework_tty_directory</td>
<td>Framework directory containing ChUI code.</td>
</tr>
<tr>
<td>_startup_proc</td>
<td>Name of procedure used to start Progress Dynamics session.</td>
</tr>
<tr>
<td>_start_in_directory</td>
<td><strong>Start in</strong> directory.</td>
</tr>
</tbody>
</table>
Inside the Progress Dynamics Configuration File

When you install Progress Dynamics, it includes a default configuration file (icfconfig.xml) located in the OpenEdge.Install\src\dynamics directory.

You should never manually edit the configuration file. You should only use the Administration window tools to generate and edit it. If you do manually edit the file, you could introduce errors and cause problems when you upgrade from one release of Progress Dynamics to the next.

This appendix describes the contents of the default configuration file to help you gain an understanding of what this XML file does.

Note: After you start Progress Dynamics for the first time, you should create your own session types that work with your application databases. You should then generate a new configuration file that is saved into your working directory. You can add new session services and types and then regenerate this file to use with your own applications. For more information on generating your own configuration file, see Chapter 2, “Defining and Managing Sessions.”
Session configuration nodes

The icfconfig.xml file is managed by the Configuration File Manager and is structured in a specific way. The configuration file consists of a single <sessions> node that contains a separate <session> node for each different session type. The <session> node has a SessionType attribute set that maps to the session type specified by the ICFSESSTYPE attribute for the -icfparam startup parameter.

Thus, an icfconfig.xml file is generated with a <session> node for each of the SessionTypes supported for a session. The default icfconfig.xml file contains entries for seven distinct session types.

Each <session> node has three subordinate nodes:

- <properties> node
- <services> node
- <managers> node

<properties> node

The <properties> node contains a separate node for each parameter that is set and available to the entire session. Any parameters that are set inside the <properties> node are available to the session through a call to getSessionParam in the Configuration File Manager. Certain of the properties that can be set have a special usage:

- Most properties prefixed by session_ map to attributes of the 4GL SESSION system handle. Thus, session_date_format specifies the SESSION:DATE-FORMAT attribute value. Similarly, session_year_offset specifies the SESSION:YEAR-OFFSET session attribute value.

Note: The session_propath is the one special case that specifies the value of the session PROPATH environment variable.

- The startup_procedure property specifies non-persistent procedures that are executed in alphabetical order after the managers and service connections have been established.

- Properties prefixed by ICFCM_ point at an entry in the <managers> node that contains the name of a specific Service Type Manager. For example, in the icfconfig.xml file, the ICFCM_AppServer property specifies a value of AppServerConnectionManager. In the services node, the cServiceType property indicates the type of service (AppServer or Database in this example). When the session is started, the Configuration File Manager automatically starts the Connection Manager and all Service Type Managers that are specified by ICFCM_properties so the Connection Manager can connect to all the required startup services. The filename of the Service Type Manager to be started is specified by a cFileName node in a <manager> node that also contains a cManagerName node whose value matches the ICFCM_property value that specifies the Service Type Manager. Thus in the default icfconfig.xml file, the ICFCM_AppServer property specifies the value AppServerConnectionManager, which is also specified by a cManagerName node in the <managers> node for the same session type. For more information, see the “<managers> node” section on page C–4.
• The `run_local` property specifies if the entire environment for the session type runs locally or on an AppServer. If this property is set to `yes`, the local ABL Virtual Machine (AVM) session handles all AppServer calls.

• The `physical_session_list` property provides a list of valid physical session types for a particular Progress Dynamics session (logical session type). Each physical session type identifies an ABL Virtual Machine (AVM) session in which the specified logical session type can run. The enumerated list of supported physical session types appears in Table C–1. In other words, there might be more than one valid physical session type that can run the specified Progress Dynamics session. You can determine the current physical session type by a call to `getPhysicalSessionType` in the Configuration File Manager.

### Table C–1: Physical session types

<table>
<thead>
<tr>
<th>Physical session type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APP</td>
<td>AppServer</td>
</tr>
<tr>
<td>BTC</td>
<td>Batch client</td>
</tr>
<tr>
<td>CUI</td>
<td>Character client</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical client</td>
</tr>
<tr>
<td>WBC</td>
<td>WebClient</td>
</tr>
<tr>
<td>WBS</td>
<td>WebSpeed Transaction Agent</td>
</tr>
</tbody>
</table>

• The `valid_os_list` property lists the operating systems that can run the specified Progress Dynamics session. Thus, this property can contain an enumerated list of operating systems identified by the same values as are returned by the ABL’s `OPSYS` function.

You can also add your own properties to the configuration XML file, making them accessible from inside the Progress Dynamics environment using the Configuration File Manager API. For more information, see *OpenEdge Development: Progress Dynamics Managers API Reference*.

### `<services>` node

The `<services>` node of the `icfconfig.xml` file contains a subordinate `<service>` node for each of the services that must be connected for the session to work. Note that only services that are required to gain access to the Repository must be specified. Once the session has made its connection to the Repository through the Connection Manager, all further information can be derived from the Repository instead of from the `icfconfig.xml` file.

Prior to making the connections to the services, the Configuration File Manager starts the Connection and Service Type managers that are required to make all of the connections. To begin the services connection process, the Configuration File Manager populates a services temp-table (`ttService`) with data contained in the services node. The entire services temp-table is passed to the Connection Manager so that it can establish the appropriate connections. For more information on how the Connection Manager establishes connections, see *OpenEdge Development: Progress Dynamics Managers API Reference*.
Each service node contains the following nodes of its own:

- `<cServiceType>` — This field contains the type of service that is to be connected, defined inside the Repository. For each `cServiceType`, there must be an `ICFCM_` property that points to the appropriate manager name. This field maps to `gsc_service_type.service_type_code`.

- `<cServiceName>` — This field contains the logical name of the service to be connected. This field maps to `gsc_logical_service.logical_service_code`.

- `<cPhysicalService>` — This field contains the physical name of the service that is being used from the Repository. This field maps to `gsm_physical_service.physical_service_code`.

- `<cConnectParams>` — This field contains the connection parameters of the service that is being used. This field maps to `gsm_physical_service.connection_parameters`.

- `<lDefaultService>` — This field contains a logical variable indicating whether or not this is the default service for this service type. This field is derived from `gsc_service_type.default_logical_service_obj`.

- `<lCanRunLocal>` — This field contains a logical variable indicating whether or not this service can be connected to the local session. This field maps to `gsc_logical_service.can_run_locally`.

### `<managers>` node

The `<managers>` node of the `icfconfig.xml` file contains a subordinate `<manager>` node for each of the individual managers that must be started.

A manager is simply a persistent procedure that will be run persistently by the Configuration File Manager. The object code for the manager must be accessible via the `PROPATH` of the session that is running this code.

Each `<manager>` node contains up to three nodes of its own:

- `<cManagerName>` — The name of the manager, derived from one of two places: `gsc_manager_type.manager_type_code` or a concatenation of `gsc_service_type.service_type_code` and the word `ConnectionManager`. If the manager is a Service Type Manager, the latter mechanism is used to derive the manager name; otherwise the former method is used.

- `<cFileName>` — The name of the procedure to be instantiated as a manager. The value of this field is derived from the concatenation of `gsc_object.object_path`, a forward slash, and `gsc_object.object_filename`. 
• `<HandleName>` — A code that indicates a static variable into which the handle of the manager should be stored. Valid values for this field are shown in Table C–2.

**Table C–2: Manager static handle codes**

<table>
<thead>
<tr>
<th>Handle code</th>
<th>Handle definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>NON</td>
<td>No StaticHandle Available (default).</td>
</tr>
<tr>
<td>SM</td>
<td>gshSessionManager — Session manager.</td>
</tr>
<tr>
<td>SEM</td>
<td>gshSecurityManager — Security manager.</td>
</tr>
<tr>
<td>PM</td>
<td>gshProfileManager — Profile manager.</td>
</tr>
<tr>
<td>RM</td>
<td>gshRepositoryManager — Repository manager.</td>
</tr>
<tr>
<td>TM</td>
<td>gshTranslationManager — Localization manager.</td>
</tr>
<tr>
<td>WM</td>
<td>gshWebManager — Web manager.</td>
</tr>
<tr>
<td>GM</td>
<td>gshGenManager — General manager.</td>
</tr>
<tr>
<td>FM</td>
<td>gshFinManager — Reserved for backward compatibility.</td>
</tr>
<tr>
<td>AM</td>
<td>gshAgnManager — Reserved for backward compatibility.</td>
</tr>
<tr>
<td>AU</td>
<td>appSrvUtils — Reserved for backward compatibility.</td>
</tr>
</tbody>
</table>
Deployment Notes

This appendix describes the following deployment tasks for Progress Dynamics applications:

- Deploying multi-transaction sequences
- Generating static-ABL equivalents of dynamic objects
- Deploying Repository objects between versions

For more information on the general tools and techniques available for Progress Dynamics application deployment information, see the deployment white paper posted on the following PSDN Web site:

http://psdn.progress.com/library/white_papers/dynamicswp/index.ssp
Deploying multi-transaction sequences

When you deploy multi-transaction sequences, you can overwrite the current value of a sequence. To avoid this problem, data versioning and reuse of deleted keys is turned off, by default, on the sequence table.

As a result, when you add new sequences to the Repository and use the dataset deployment tools, the new sequences are not automatically deployed. Therefore, in order to deploy new sequences, you must deploy the sequence table by explicitly exporting the GSCSQ dataset.
Generating static-ABL equivalents of dynamic objects

The main concept of Progress Dynamics is the use of a Repository to store abstract definitions for executable objects in an application. This abstraction allows the physical implementation of an object to change without requiring changes to and recompilation of the executable objects themselves. Objects are created and rendered using rendering procedures at run time. These rendering procedures retrieve object definitions from the Repository in the form of data and then manipulate that data in order to create the objects and whatever other objects they might specify.

While this dynamic approach to representing and executing the objects for an application has a number of advantages, there are two primary disadvantages when used for an n-tier distributed application:

- The application (object) definition must be transported across the network. In order for an object to be rendered, the client rendering program must retrieve the object’s definition from the Repository by making an AppServer request that returns the object definition to the client. There is always some expense incurred in the actual retrieval of the object from the Repository, but the main performance bottleneck occurs in moving the data from the AppServer to the client. Once on the client, the definition can be cached for future use. However, the client must always get the definition from the AppServer when it first instantiates the object.

- Even though an object definition can be cached on the client, the rendering program must always transform this definition at run time in order to render a new instance of the object.

Progress Dynamics allows you to avoid these bottlenecks by generating static-ABL objects from the Repository definitions of dynamic objects.

Mechanisms for static object generation

Progress Dynamics allows you to generate a complete ABL representation of an abstract object defined in the Repository. You can then compile and deploy the object in an executable form on the client that does not require Repository access in order to render it. Generating static equivalents of dynamic objects retains your ability to quickly design and prototype an application using the Progress Dynamics Repository and application accelerators. At the same time, it eliminates the performance bottlenecks inherent with rendering these objects from the Repository at run time.
Understanding the two static object generation mechanisms

Progress Dynamics provides two ways to generate static objects from Repository definitions:

- **Saving dynamic objects as static objects from the AppBuilder main window** — This *Dynamics save as static object* mechanism allows you to save a static equivalent of a dynamic SmartDataObject or Progress SmartDataViewer™. (No other dynamic objects can be saved this way.) When you have one of these dynamic objects open in the AppBuilder, the Save Dynamic Object As Static menu item appears on the AppBuilder File menu. You can choose this menu item to save the open dynamic SmartDataObject or SmartDataViewer as a static object. This type of static object works exactly like its dynamic equivalent, including the ADM processing and properties management, except that all of the properties required to render the object at run time are specified in the code and therefore require no Repository access to obtain them. These save as static objects become completely independent of the original dynamic objects from which they are generated.

- **Invoking the 4GL Generator tool from the Administration main window** — The *4GL Generator* mechanism allows you to generate static equivalents of any selection of dynamic objects, except for SmartBusinessObjects and Dynamics Web objects. You can make the selection of one or more objects to generate and generate them by choosing the 4GL Generator menu item in the Deployment menu of the Administration main window. This type of static object works differently from its dynamic or static ADM equivalent. For example, while the object specifies the properties required to render it in ABL, it manages these properties differently from the ADM property management generated for save as static objects, and processes the object in a manner designed to maximize performance. These generated-ABL static objects are essentially static overrides of the original dynamic objects from which they are generated, and they effectively share the same registration status.

Both mechanisms eliminate the need to access the Repository for object rendering information. However, both types of static objects still depend on some access to the Repository in order to participate in the Progress Dynamics security model. Also, while it is possible to modify the code for static objects, you generally modify the original dynamic objects using Progress Dynamics tools and generate new static-ABL objects from the altered Repository definitions. No changes that you make directly to the code for either type of static object can be automatically reflected back in the Repository.

**Choosing Dynamics save as static objects or generated-ABL static objects**

The only two dynamic objects you can generate using both mechanisms are the SmartDataObject and SmartDataViewer. So, you only need to choose a mechanism for generating static objects for these two classes of dynamic objects. Because they work differently, your choice of what mechanism to use depends on your working priorities and requirements.
The save as static object mechanism produces an ADM-compatible ABL procedure that you can edit in the AppBuilder using the properties and section editors, exactly like any static object that you create using the AppBuilder. Because it is an ADM object, it can integrate smoothly with any Progress Dynamics container, static or dynamic. This also means that, as a static object, it performs with the same performance characteristics as any static ADM object of its class. The performance of save as static objects might be better than their dynamic object equivalents, but their primary function is to change the development model of an object from dynamic ABL to static ABL. For more information on the function of Dynamics save as static objects, see *OpenEdge Development: Progress Dynamics Basic Development*.

The 4GL Generator mechanism produces an ABL procedure with no reference to the ADM. You can only edit the code for this type of object in the procedure editor or other text editor.

**Note:** Progress Software Corporation does not support direct modification of the code generated using the 4GL Generator.

A generated-ABL static object functions and interacts with other objects in a similar manner to its static ADM equivalent, but because it does not rely on the same internal ADM property management and processing models, it is likely to perform much more efficiently than the static ADM equivalent. Because of the way dynamic objects are cached on the client after retrieval from the Repository, you can only run generated-ABL static objects in a generated-ABL container object. In general, the code contained in generated-ABL static objects is optimized, as much as possible, for maximum performance, and Progress Dynamics also manages these objects with performance optimization in mind.

Most of this chapter describes how to use the 4GL Generator mechanism. However, the following section describes the basic features of working with the save as static object mechanism.

**Saving dynamic objects as static objects**

The Dynamics save as static object mechanism allows you to save only dynamic SmartDataObjects and SmartDataViewers as static ADM objects. These static objects function exactly like their dynamic equivalents, except all rendering and behavioral properties defined in the Repository for the dynamic equivalents are specified directly in the code for the static objects. The result is an ABL procedure that looks and works like any static SmartDataObject or SmartDataViewer that you create using the AppBuilder.

Because they are independent from their dynamic originals, like any static object, you must explicitly register these static equivalents of dynamic objects in the Repository in order to use them in a Progress Dynamics application.

Progress Dynamics provides certain options and imposes some constraints on the construction and use of these static objects in relation to their original dynamic equivalents. The following procedure describes what these options and constraints are and how to handle them.
To save an existing dynamic SmartDataObject or SmartDataViewer as a static object:

1. Open an existing dynamic SmartDataObject or SmartDataViewer in the AppBuilder.

2. Open the File menu in the AppBuilder, as shown:

3. Choose the Save Dynamic Object As Static item, displaying a Save as dialog box, as shown:

This figure shows a Save as dialog box for a static SmartDataViewer. If the open dynamic object is a SmartDataObject, the title displays as Save as (SDO).
4. Set the following options in this dialog box as you require:

- **File name** — By default, this is the same filename as the open dynamic object. However, note that if you are replacing the existing dynamic object with this static equivalent in a container, the static object cannot have the same name as its dynamic equivalent. Change the name of the static object in this dialog box, then replace the dynamic object in its container with the renamed static equivalent using one of the following windows:

  - **Container Builder** — Accessible from the AppBuilder **Build** menu. For more information, see *OpenEdge Development: Progress Dynamics Basic Development*.

  - **Replace Object Instances** — Accessible from the **Objects** menu of the Development tool main window. For more information, see the Progress Dynamics Development tool help.

- **Register object** — By default, this is a check box that is checked and allows you to register the new static object in the Repository. By default, the **Description**, **Root directory**, and **Product module** fields are set to the values specified for the open dynamic object. You can change these settings for the static equivalent, and the read-only **Save in** and **Full path name** fields update automatically to show you the new values. You can also check boxes to indicate the deployment types and usage for this static object.

5. Click **Save** to complete the saving of the static object.

6. If the open dynamic object contains UI events, the save as static function creates triggers in the static code and writes the **RUN** or **PUBLISH** statements in the triggers to run or publish the specified events. If you want to move the event code from the object super procedure to the static object, itself, you must do this manually.

### Generating ABL for dynamic objects as static objects

With the 4GL Generator mechanism, you can generate static equivalents of all classes of dynamic objects, except for SmartBusinessObjects and Dynamics Web objects. The code for generated-ABL static objects and their run-time handling is specially optimized for performance. These static objects function exactly like their dynamic equivalents, except all rendering and behavioral properties defined in the Repository for the dynamic equivalents are specified directly in the code for the static objects. Because it is optimized for performance, a generated-ABL object procedure looks and works quite differently from a static object that you create using the AppBuilder.

Unlike other static and dynamic objects, Progress Dynamics does not (and you must not) register these generated-ABL static objects in the Repository. They implicitly share their registration status directly with the original dynamic objects (logical objects) from which they are generated. Progress Dynamics handles the security and some execution features for these generated static objects based on the existing registration of the corresponding logical objects. Thus, generated-ABL static objects are true deployment equivalents of their dynamic originals, and you deploy them together wherever you use them.
Progress Dynamics offers several options for generating the code for these static objects and imposes some constraints on the construction and use of these static objects in relation to their original dynamic equivalents. The following procedure describes what these options and constraints are and how to handle them.

**To generate ABL for a static equivalent of a dynamic object:**

1. In the Administration tool main window, choose the **Deployment** menu, as shown:

![Deployment Menu](image)

2. Choose **4GL Generator** in the **Deployment** menu, displaying the **4GL Generator** window, as shown:

![4GL Generator Window](image)
3. Choose the **Selection** tab to specify the selection of dynamic objects that you want to generate as static objects:

   a. Set the **Filter** settings to identify the list of objects you want to generate. You can filter this list by a combination of criteria. Note that the **Object name** field must have a value that can include instances of the general wild-card character (*) anywhere in the value. For example:

   ```
   af*e*w
   ```

   You can also separately include viewers that are link targets of DataField objects and object instances contained in container objects.

   b. After you have specified filter criteria, click **Apply** to display the corresponding list of objects in the browser.

   c. Individually or as a group, select the objects from this list for which you actually want to generate static ABL. You can start by selecting all (**Select All**) or none (**Deselect All**) of the items of the list.

4. Choose the **Options** tab to specify generation options that apply to all of the object selections you want to generate, as shown:
Use **Generate options** to specify if the generated object uses Progress Dynamics security, thin rendering, and how super procedures are generated and invoked for the selected objects. For more information on thin rendering, see the sections on thin SmartObject rendering in Appendix E, “Performance Notes.” The choices for handling custom super procedures include:

- **Constructor** — Invoked as part of the object startup

- **Property** — Set as a property and invoked by the ADM code

DataLogic procedures for SmartDataObjects are handled in the same way as super procedures.

Use the **Customizations** selections to specify the result codes (if any) and the order to apply them for generating the selected objects. The selected result codes form part of the filename for each generated object. The result codes in the filename help Progress Dynamics decide what files to execute for the object. For more information, see the “Generated-ABL object execution and file naming” section on page D–11.

Use the **Translations** selections to specify what language translations (if any) to include in the generated objects. Like all other Repository definitions, the generator includes all selected translations in the generated code for access at run time.

5. Choose the **Paths** tab to specify various file and path names for the generated objects, as shown:

![Path settings in a generator interface](image)

**Note:** For the **Hook procedure**, always accept the default. This setting is reserved for use by Progress Technical Support.
You can click **View log file** to view the contents of the specified log file in a Notepad window. Note that the generator does not check for existing static objects in the specified target location with the same filenames as currently selected objects and replaces any that it finds with the newly generated files for these objects.

Check the **Compile** toggle box to compile the code and store the r-code for the generated object in the specified location.

---

**Note:** While the location you choose to store any r-code you generate might be temporary, Progress Dynamics specifies a location where you must deploy the r-code for generated-ABL static objects on the client. For more information, see the “Deploying generated-ABL static objects” section on page D–13.

---

6. To generate ABL for the static objects using the specified information, click **Go**.

### Generated-ABL object execution and file naming

Progress Dynamics invokes generated-ABL static objects as an automatic component of its protocol for invoking any registered object. A generated-ABL static object is not, itself, registered in the Repository, but is associated with an existing logical object that is registered in the Repository. When a Progress Dynamics application starts up an object, if Progress Dynamics locates an appropriate generated-ABL file for this object, it invokes this generated file to render the object. Otherwise, it invokes the base object using its definition in the Repository.

**Generated filenames**

Progress Dynamics locates generated files according to their filenames and locations. The filenames for generated-ABL static objects derive from the logical object name of the registered object and the customization result codes that you specify for static object generation (see the “Generating ABL for dynamic objects as static objects” section on page D–7).

The general syntax of this generated filename is:

**Syntax**

```
LogicalObjectName[_ResultCodeString].pgen
```

The filename components include:

- `LogicalObjectName`
  
  The logical name of the object as it is registered in the Repository.

- `[_ResultCodeString]`
  
  When you specify customization result codes for object generation, they are appended to the `LogicalObjectName`, as shown in the order that you specify them. For more information, see Table D–1.

- `.pgen`
  
  The extension on the filename for a generated-ABL source code file.
Table D–1 shows how the 4GL Generator determines the filename for a generated static object using these components.

Table D–1: Determining the generated filename for a generated-ABL object

<table>
<thead>
<tr>
<th>Sample result codes used for generation</th>
<th>Object has customizations?</th>
<th>Generated filename components</th>
<th>Sample generated filename for logical object CustWin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default result code only.</td>
<td>No.</td>
<td>LogicalObjectName.pgen</td>
<td>CustWin.pgen</td>
</tr>
<tr>
<td>Result codes specified in this order:</td>
<td>Yes—even if the object is only customized by one of the generation result codes, the whole object is considered customized</td>
<td>LogicalObjectName_ResultCodeString.pgen</td>
<td>CustWin_GUICLERKADMIN.pgen</td>
</tr>
<tr>
<td>GUI CLERK ADMIN</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Result codes specified in this order:</td>
<td>No—even if result codes are specified for generation, none are applied to the generated object</td>
<td>LogicalObjectName.pgen</td>
<td>CustWin.pgen</td>
</tr>
<tr>
<td>GUI CLERK ADMIN</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Locating and executing the files

The 4GL Generator stores all the object source files that it generates in the target directory that you specify. After compiling these files, you must deploy the r-code to a specific subdirectory of the session client cache directory to enable Progress Dynamics to locate and execute them (see the “Deploying generated-ABL static objects” section on page D–13).

Note: Progress Dynamics uses this deployment area in the session client cache directory instead of the usual PROPATH search to locate generated-ABL objects for execution as a performance optimization. For more information on the client cache directory, see Appendix E, “Performance Notes.”

When Progress Dynamics executes a logical object, it first looks for the r-code for a generated-ABL static equivalent in the client cache deployment area. It identifies the corresponding r-code according to a generated filename whose LogicalObjectName and ResultCodeString matches the logical object and the current session result code customizations. If an r-code file does not exist with a filename (customized) that matches the session customization settings, Progress Dynamics attempts to execute an r-code file that has the same filename with no ResultCodeString component (not customized). If it cannot locate a matching customized r-code file or one that is not customized, or it cannot locate any generated-ABL r-code for the logical object, Progress Dynamics executes the object according to its definition in the Repository.
Deploying generated-ABL static objects

The main complication in the deployment of generated-ABL static objects is that you must also consider deployment of the dynamic equivalents in the process. You must also take care to deploy the r-code for generated-ABL objects in a directory specified by Progress Dynamics. There are also guidelines on when it is necessary to regenerate and redeploy these objects. This section describe all of these issues.

What to deploy

Table D–2 shows the minimum files that you need to deploy to the client for a given object, depending on the state of the object. As minimum files, ADO indicates the deployment datasets for the abstract definitions in the Repository. PGEN indicates the source and r-code files for the generated-ABL static object equivalents.

<table>
<thead>
<tr>
<th>Object state</th>
<th>Minimum files to deploy</th>
</tr>
</thead>
<tbody>
<tr>
<td>New object</td>
<td>ADO, PGEN</td>
</tr>
<tr>
<td>Modified object, including properties or contained instances, but excluding changes to the object path</td>
<td>PGEN</td>
</tr>
<tr>
<td>Modified object, including properties, contained instances, and changes to the object path</td>
<td>ADO, PGEN</td>
</tr>
</tbody>
</table>

While, under some circumstances, you can deploy only the PGEN files for generated-ABL objects, Progress Software Corporation recommends that you always deploy both the ADO and PGEN files. Otherwise, you risk losing track of the differences between them. If you find it expedient to deploy only the PGEN files in order to provide a fast and temporary fix or patch, deploy the ADO to the client as soon as possible to maintain consistency between the dynamic and generated equivalents of the object.

Where to deploy

Typically, you deploy the source code files for generated-ABL objects to directories as specified by the object path, per object. You must deploy the r-code for these objects into the gen subdirectory of the client cache directory (typically, OpenEdge_Install\src\dynamics\ry\c1\). Progress Dynamics ignores the PROPATH and looks only in the client cache deployment area for any generated-ABL object r-code that it needs to execute.
When to deploy

After the initial deployment, you must regenerate and redeploy generated-ABL static objects when one or more of the following changes occur:

• Information about the object itself, such as its object path.

• Changes to super procedures, depending on how you generate the object’s super procedures (invoked by the object constructor, generated in-line, or generated as an ADM property).

• Properties of the object itself.

• Information about the object’s pages and links (any addition, modification, or removal of the links).

• Information about the contained instances, including names, attributes, and UI events.

• For dynamic viewers, any information about the contained objects’ master objects. (The DataField and local widgets (not SmartDataFields) are not procedure based. So, all master information must be generated into the viewer. This is also true of class information for the contained widgets. Classes affected include the DataField class and all its subclasses, and the ProgressWidget class and all its subclasses.)

Development impact using generated-ABL objects

The primary development constraint with using generated-ABL static objects in your application is that you can run most such objects only within a generated-ABL container object. So, with one exception, if you decide to deploy a contained instance as a generated-ABL static object, you must also deploy the container as a generated-ABL static object.

The exception to deploying dynamic containers as generated-ABL objects is for dynamic TreeView windows. Because the detail frame objects (run by clicking the nodes of a TreeView) run as master objects, they receive none of their rendering properties from their parent container objects (the dynamic TreeView windows). So, you can run generated-ABL detail frame objects within either dynamic or generated-ABL TreeView windows.

The 4GL Generator mechanism is primarily designed as a performance-enhanced deployment feature. However, if you use generated-ABL static objects in your application, some Progress Dynamics APIs play a particular role in executing these objects that you might need to manage.
Table D–3 lists the APIs that play a particular role and describes how they work with generated-ABL static objects.

### Table D–3: APIs for running generated-ABL static objects

<table>
<thead>
<tr>
<th>Name</th>
<th>Manager or class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>menuItemSecurityCheck</td>
<td>Security manager</td>
<td>Checks the security settings for a specified menu item.</td>
</tr>
<tr>
<td>menuStructureSecurityCheck</td>
<td>Security manager</td>
<td>Checks the security settings for a specified menu structure.</td>
</tr>
<tr>
<td>launchContainer</td>
<td>Session manager</td>
<td>Launches containers. This is the primary point for launching top-level containers, such as menu controller, TreeView, and other windows. It is the API that searches for the generated-ABL for this type of object before attempting to retrieve and render its dynamic equivalent from the Repository.</td>
</tr>
<tr>
<td>startDataObject</td>
<td>Repository manager</td>
<td>Starts SmartDataObjects. It is the API that searches for the generated-ABL SmartDataObject before attempting to retrieve and render its dynamic equivalent from the Repository.</td>
</tr>
<tr>
<td>retrieveBandsAndActions</td>
<td>ADM toolbar</td>
<td>Encapsulates the retrieval and population of the toolbar temp-tables. This call includes the current call to rygetmensp.p and also attempts to populate the menu temp-tables using the generated adm-loadSmartToolbar() call both in the toolbar’s container (for object menus) and in itself (for toolbar menus).</td>
</tr>
<tr>
<td>constructObject</td>
<td>ADM container</td>
<td>Launches contained objects. This API starts the object and sets up Page (if relevant) and Container links. It searches for the generated-ABL for the object before attempting to retrieve and render its dynamic equivalent from the Repository.</td>
</tr>
<tr>
<td>getMappedFileName</td>
<td>Repository manager</td>
<td>Returns the full pathname for a given logical object name. This API uses the map file concept to determine the filename. If it cannot find a physical file, the API returns the Unknown value (?).</td>
</tr>
</tbody>
</table>

For more information on the manager APIs that interact with generated-ABL objects, see *OpenEdge Development: Progress Dynamics Managers API Reference*. For information on the ADM APIs, see *OpenEdge Development: ADM Reference*. 
Deploying Repository objects between versions

With the release of both the OpenEdge Release 10 and Progress Dynamics Version 2.1 release families, both you and Progress Software Corporation might find it necessary to fix bugs and add features to both development streams at the same time. When a bug fix results in a source code change, the task is no different than for any other development environment. However, when the bug fix affects data in the Repository, the situation is more complicated, because Repository objects must be deployed between different versions of the Repository (Release 10 and Version 2).

To address this situation, Progress Software Corporation provides deployment tools that manage the differences in Repository versions and recommends a specific set of ordered tasks to manage the deployment of objects between them.

Cross-version deployment situations

You might well be maintaining an application running in both Progress Dynamics release families at the same time. Two main categories of development might need to be deployed between these application versions:

- New objects built in the development Repository
- Existing objects maintained in either Repository

If you add new functionality to the application in one release family, you often add the same functionality to the application in the other family. If the implementation is identical in both families, it is simply a matter of developing it in one release Repository and exporting it to the other release Repository. Complications arise where you implement different application features or use different implementation techniques between the versions.

When you maintain existing objects between versions, aside from adding features to an object in one version that do not exist in another, you might use implementation techniques in one version that do not exist in another.

Any cross-version deployment must account for all of these scenarios.

Support for cross-version deployments

The Progress Dynamics deployment tools provide the following features to support cross-version deployments between the OpenEdge 10 and Progress Dynamics 2.1 release families:

- The export and import functions of the deployment tools recognize deployment datasets (ADOs) from both release families.
- The dataset import functions ignore unknown tables (tables in the ADOs that do not exist in the target Repository).
The dataset import functions ignore unknown fields (fields in import tables that do not exist in the same tables of the target Repository).

The dataset import functions ignore unknown data types. That is, if a field in an import table has a data type not supported in the target Repository, the import functions ignore those fields.

**Recommended procedure for deploying across versions**

The procedure that Progress Software Corporation recommends for deploying objects across versions is not much different from deploying an object to a central Repository. For more information on Repository object deployment and the tools described in this procedure, see the deployment white papers posted on the following PSDN Web site:

http://psdn.progress.com/library/white_papers/dynamicswp/index.ssp

To deploy Repository objects across versions:

1. Before undertaking any work that needs to be deployed across versions, determine what objects will be affected and what those objects look like in each version. If you plan to create a new object, you can create it in either version (see Step 2). If you plan to change an existing object, determine what additional functionality can be lost in either version.

2. Once you understand the affected objects, decide the version where you will do the work. Typically, it is better to do the development work in the later version, where you are likely to add more features. It is always easier to remove functionality from an object than to add it. The version where you do the initial development work is your source version, and the version where you deploy this initial development work is your target version.

3. Before doing any work in the source version, reset the data modified status for your source development Repository (using Deployment→Reset Data Modified Status from the Administration tool) so you can easily determine what changes you have made.

4. Implement your changes.

5. Dump all the data you have modified using the dataset export tool (Deployment→Dataset Export). The exported ADOs contain the changes that you made.

6. Load the ADOs that you exported in Step 5 into the central Repository of your source version using the dataset import tool (Deployment→Dataset Import).

7. Before doing any work in the target version, reset the data modified status for your target development Repository (using Deployment→Reset Data Modified Status from the Administration tool) so you can easily identify the affected objects.

8. Load the ADOs that you exported in Step 5 into the development Repository of your target version using the dataset import tool (Deployment→Dataset Import). In Dataset Import, be sure to check the Set modified status toggle box so these objects can be easily identifiable after they have been loaded.
9. Test the objects you have loaded and redo any work that has been lost during the import.

10. Complete any additional functionality required to finish the objects for the target version.

11. Dump all the data you have modified in the target development Repository using the dataset export tool (Deployment→Dataset Export). The exported ADOs contain the objects you imported from the source version plus any additional changes that you have made.

12. Load the ADOs that you exported in Step 11 into the central Repository of your target version using the dataset import tool (Deployment→Dataset Import).

Your cross-version deployment should be complete.
Performance Notes

This appendix provides information that can help you to tune your Progress Dynamics applications for optimum performance.

Although most of the performance improvements implemented in the current release are generally applicable and therefore automatically delivered to an application, there are additional improvements where your application knowledge is required to make the best choice of where to balance trade-offs. These optimizations are therefore optional and enabled through configuration decisions that you make. This appendix describes these configurable optimizations in the following sections:

- Configuring server and client startup options
- Using static-ABL equivalents of dynamic objects
- Keeping SmartDataObjects alive on the server
- Progress Dynamics lookup/combo (SmartDataField) cache
- Dynamic lookup mapped fields
- Class and entity cache
- Toolbar Image Optimization Using PicClip Images
- Caching toolbars and container menus at session startup
- Thin SmartObject rendering
- Dynamic TreeView optimizations
- SmartDataObject data definition and schema location
Performance Notes

- SuperProcedureMode attribute
- Dynamic call wrapper (dynlaunch.i)
- Creating customized login windows

For more information on performance features available in Progress Dynamics, see the performance white papers posted on the following PSDN Web site:

http://psdn.progress.com/library/white_papers/dynamicswp/index.ssp
Configuring server and client startup options

Table E–1 lists recommended startup parameter settings for both server and client that can improve both performance and overall execution.

Table E–1: Optimal settings for server or client startup parameters

<table>
<thead>
<tr>
<th>Startup parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-baseADE</td>
<td>&quot;&quot;</td>
<td>Procedure libraries added to the PROPATH in the initialization (.ini) file (on the client)</td>
</tr>
<tr>
<td>-Bt</td>
<td>512</td>
<td>Buffer size for temp-tables</td>
</tr>
<tr>
<td>-D</td>
<td>500</td>
<td>Directory size</td>
</tr>
<tr>
<td>-l</td>
<td>1000</td>
<td>Local buffer size</td>
</tr>
<tr>
<td>-mmax</td>
<td>65534</td>
<td>Maximum memory</td>
</tr>
<tr>
<td>-nb</td>
<td>150</td>
<td>Nested blocks</td>
</tr>
<tr>
<td>-s</td>
<td>128</td>
<td>Stack size</td>
</tr>
<tr>
<td>-T</td>
<td>/tmp</td>
<td>Directory to store temporary files</td>
</tr>
<tr>
<td>-TB</td>
<td>31</td>
<td>Speed sort</td>
</tr>
<tr>
<td>-TM</td>
<td>32</td>
<td>Merge number</td>
</tr>
</tbody>
</table>

For more information on these startup parameters, see *OpenEdge Deployment: Startup Command and Parameter Reference*. You can also find this information online at the following Web site:


You can also improve performance by taking these actions:

- If your databases reside on the same machine as the AppServer, use direct database connections instead of networked connections on the server process. For example, in the server icfconfig.xml file, use:

  ```xml
  <cConnectParams>-db /apps/database/icfdb/icfdb.db</cConnectParams>
  ```

  instead of using:

  ```xml
  <cConnectParams>-db icfdb -H localhost -S icfdb</cConnectParams>
  ```

- For any procedure libraries in the PROPATH, put them in the optimum order.
- Do not put src on the PROPATH of the server or the client. Put only gui or tty and the procedure libraries on the PROPATH. You can set the PROPATH in the .ini file on the client and in the ubroker.properties file on the server (using the Progress Explorer tool).

For example, on the client you might specify this PROPATH in dynamics.ini:

```text
```

On the server, you might specify this PROPATH in ubroker.properties:

```text
PROPATH=.,/dyn21a/tty/dynamics,./dyn21a/tty/,./dyn21a/tty/adecomm.pl,./dyn21a/tty/adecomp.pl,./dyn21a/tty/adedict.pl,./dyn21a/tty/adeedit.pl,./dyn21a/tty/adeshar.pl,./dyn21a/tty/prodict.pl
```
Using static-ABL equivalents of dynamic objects

Dynamic objects incur two major performance hits:

- Retrieving their abstract definitions over the network when the first instance starts up.
- Transforming the abstract definition into a physical object when it first starts up.

Progress Dynamics allows you to eliminate most of these performance hits by deploying any selection of dynamic objects in your application as static-ABL objects. You can generate and deploy these static object equivalents for all dynamic objects except for most container objects that contain them, all SmartBusinessObjects, and Dynamics Web objects.

When you deploy static equivalents of dynamic objects, you typically maintain them in dynamic form for ongoing development and regenerate the static equivalents in order to deploy the updated objects that you release.

For more information, see the sections on generating and deploying static ABL for dynamic objects in Appendix D, “Deployment Notes.”
Keeping SmartDataObjects alive on the server

When running over a stateless AppServer, dynamic SmartDataObjects (SDOs) must be retrieved, constructed, and initialized on the server for every client request. In terms of performance, this process can sometimes be more expensive than fetching the data itself. To eliminate this overhead, you can configure SDOs to remain in server-side memory (keep alive) for reuse by subsequent client requests.

Note: In the current release, you cannot keep alive static SDOs running in static containers.

Configuring SDOs to remain alive

You can configure the server-side life time of an SDO using the SDO property, DestroyStateless. This property is defined in the Data class with a default value of TRUE. This means that the server-side SDO is destroyed after every client request. By setting this property to FALSE, you configure the corresponding SDO to remain in AppServer memory after the completion of a client request. You can set DestroyStateless at the Class level (affecting all SDOs throughout the application), at the Master object level (affecting all instances of a particular SDO), or at the Instance level (affecting a particular occurrence of an SDO in a container).

Using SDOs kept alive on the server

When you evaluate whether to deploy SDOs to stay alive on the server, consider these guidelines:

- Once started, an SDO remains in memory until the host process is terminated. This effectively means that to clear SDOs, you must either trim agents or stop and restart the broker. This applies to both AppServer and WebSpeed agents.

- Because each client request can be directed to a different agent, the same SDO will most probably be started and remain in memory in multiple agents. Each such SDO takes up more server memory resources. However, each SDO memory footprint is relatively small.

- When processing a client request, if a required SDO is in memory (as determined by its LogicalObjectName), the server re-uses it regardless of the DestroyStateless property value. This property is only used to decide the fate of the SDO upon request completion.

- Although you can set DestroyStateless at the instance level, a kept-alive SDO has no knowledge of the particular instance that starts it. An SDO is only recognizable and retrievable by its LogicalObjectName. So, many kept-alive SDOs can be started after setting this property for a single instance.
• The most time-consuming task when starting an SDO is setting up any required dynamic elements such as dynamic queries, dynamic RowObject and RowObjUpd tables, dynamic buffers, and so on. Therefore, dynamic SDOs benefit the most from being kept alive, especially those with many fields.

• Datasets created as part of a client request are destroyed upon request completion. However, custom data structures that are created, such as temp-tables, remain as part of the SDO. To change this behavior, you can override destroyObject in the SDO (or its DataLogic procedure, if one is used) to specify any custom cleanup between requests.
Progress Dynamics lookup/combo (SmartDataField) cache

Progress Dynamics provides a client-side cache manager that supports the optional caching of data for use by dynamic combos and lookups. This cache for dynamic SmartDataFields (SDFs) reduces network traffic and improves overall performance.

By reducing the amount of data and having the data in a preprocessed and ready-to-consume form on the client, the data-gathering time and any AppServer requests to fetch the data are eliminated, thus improving the overall performance of the application. This is especially noticeable over a slow network.

This SDF cache is a great benefit for performance. However, it might lead to the display of incorrect values if the data in the cache becomes stale. To force retrieval of the latest information with the correct values, you can clear the cache at any time.

SDF caching is optional and configurable, as described in the following sections:

- **Cache operation**
- **When the SmartDataField cache is not used**
- **Enabling and disabling the SmartDataField cache**
- **Clearing the SmartDataField cache**
- **Disabling cache usage for a specified SDF**

For more information on the impact of using the SDF cache for development, see *OpenEdge Development: Progress Dynamics Basic Development*.

**Cache operation**

The SmartDataField cache is dynamically built at run time; therefore, the benefits of having the cache increase with use of the application. Whenever a container runs with dynamic lookups or combos on a viewer, a record is created in a temp-table on the client machine where data retrieved from the server is stored. Whenever the same container reruns, it reuses this cached data when other containers having the same type of SDF also run. The cache therefore provides benefit only on subsequent uses of the same data.

For a practical example of where the SDF cache benefits an application, suppose there is a container with a SmartToolbar, dynamic SDO, dynamic browser, and dynamic viewer, and that these objects operate on the Customer table in the Sports2000 database with the SDF cache configured for use.
This viewer contains a dynamic lookup on the State field and a dynamic combo on the SalesRep field. The first time the container runs, the application makes an extra AppServer request to populate the value for the lookup’s displayed field as well as for populating the list-items for the SalesRep combo. If the user clicks on the next record, the application will make an AppServer request to get the displayed field information for the State lookup only if the state of the second selected record is different from that of the previously selected record. If the user selects the previously selected record again, there is no AppServer request, because the lookup data is retrieved from the SDF cache. If this viewer only had a dynamic combo, there would not be another AppServer request when the second record was selected, because the combo’s data were cached on the first AppServer request. If the user closes the container and reruns it, no AppServer request is required, because the data is already cached. As the user selects records in the browser where the data is not yet cached from the first run, the application makes an AppServer request to retrieve the data and caches it. After values have been cached for all query states, no more AppServer requests are required.

If another container that also has a dynamic combo for the SalesRep field runs, and the base query of the dynamic combo is the same as the base query used to build the list items of the SalesRep combo used in the initial Customer maintenance viewer, the cached information for the first combo is reused for this other combo also.

**When the SmartDataField cache is not used**

Progress Dynamics does not use the SmartDataField cache for dynamic lookups or combos in certain situations, even if the cache is enabled for use.

**Cache not used for dynamic lookups**

Progress Dynamics does not use the cache for dynamic lookups in the following circumstances:

- When the dynamic lookup has a parent filter query where the values of the parent filter fields do not match the values of the data already in the cache.

- When the Lookup button is chosen or the F4 key is pressed to launch the lookup browser, the data to be displayed in the browser is still retrieved directly from the server as in previous releases.

- When a value is entered in the lookup field and the user leaves the field, either by tabbing off the field or using any other mouse or keyboard event that causes the lookup field to lose focus.

- When the base query string in the lookup does not exactly match the base query string of the data already in the cache.
Cache not used for dynamic combos

Progress Dynamics does not use the cache for dynamic combos in the following circumstances:

- When the dynamic combo has a parent filter query where the values of the parent filter fields do not match the values of already cached data in the cache.
- When the base query string in the combo does not exactly match the base query string of that cached in the client cache.

Enabling and disabling the SmartDataField cache

SmartDataField caching is optional for any session and can be enabled for any client session. The SDF cache is only available for client-side sessions.

For any upgrade from a previous version without SDF caching, the SDF cache manager is added to application Repository databases during the upgrade process. To enable SDF caching for a specified session type, add SDFCacheManager as a Required Manager using Session Type Maintenance (Session → Session Type Control from the Administration tool) and generate a new Progress Dynamics configuration.xml file. The result creates the following entries in your icfconfig.xml file:

```xml
<manager>
  <cManagerName>SDFCacheManager</cManagerName>
  <cFileName>ry/prc/rysdfcmngr.p</cFileName>
  <cHandleName>NON</cHandleName>
</manager>
```

To disable SDF caching from the same session type, remove SDFCacheManager as a Required Manager from the specified session type using Session Type Maintenance and regenerate the icfconfig.xml file.

Clearing the SmartDataField cache

You can clear the SmartDataField client cache at any time by launching the Preferences window available from the File menu available on any Progress Dynamics menu controller window.
To clear the SmartDataField cache from the Administration tool:

1. Choose File→Preferences, as shown:

2. In the Dynamics Preferences window, click Clear SDF Cache, as shown:

3. Click Yes for the confirmation message.

Disabling cache usage for a specified SDF

In some cases, you know at design time that an SDF should not make use of this caching mechanism and will want to disable caching for the specified SDF.

A SmartDataField property, UseCache, indicates if the specified SDF uses any cached information during execution. The default value for this property is TRUE for the DynLookup and DynCombo class, but you can also change this value at the class level.
You can set this value with the **Use cache** toggle box in the SmartDataField Maintenance tool, available from the AppBuilder or Development tool **Build** menu, as shown in Figure E–1. You can set this value on the master or instance levels for dynamic viewers and only at the instance level for static viewers.

Figure E–1: Disabling the cache for a specified SDF
Dynamic lookup mapped fields

By default, the dynamic lookup uses its own query-management and data-retrieval mechanism, instead of using SmartDataObjects. Using this mechanism the dynamic lookup requires a separate AppServer request to retrieve lookup data as part of rendering a container and displaying the current record.

To minimize the need for the AppServer request, the dynamic lookup can check if the fields required to display the lookup values for the current record are also available in the viewer SDO. If corresponding SDO fields are available, the dynamic lookup can use these fields instead of making a separate and duplicate AppServer request. If the fields are not available in the SDO, the lookup must make its own AppServer request to populate it with data.

In cases where the fields used on the viewer for a dynamic lookup are not the actual fields contained in the SDO, the affected lookup must make its own AppServer request. To solve this issue and to provide a more specific way to map the lookup fields used on the viewer to the fields in the SDO that contain their data (if applicable), the concept of field mapping was introduced.

To allow dynamic lookups to check the SDO for the required fields, Progress Dynamics supports a field mapping mechanism for use by dynamic lookups on both static and dynamic viewers. Field mapping provides an ability to explicitly state what fields on a viewer are linked to specified fields in an SDO. The need for you to explicitly map the fields is only required if the fields on the viewer do not directly map to the fields in the SDO based on their names.

Benefits and constraints on mapping fields

The most common reason for mapping fields is to enable Progress Dynamics to link the correct field from the SDO with a linked field on the viewer required for dynamic lookups. You can have the fields mapped automatically by specifying fields from the data source on the viewer as the linked fields in the lookup. In cases where you cannot do this, you can explicitly map the fields to ensure that the linked fields are populated with the correct value.

For field mapping to work, you must map all of the fields in the dynamic lookup to the viewer SDO. For more information, see the “Using mapped fields” section on page E–14.

Progress Dynamics does not support field mapping for viewers using a SmartBusinessObject (SBO) as their data source.

Note:  Adding joins to an SDO in order to make fields available for a dynamic lookup as part of the standard SDO data retrieval does not always provide a performance benefit. The expense of the extra join, plus the extra data returned, might cancel any benefit that might be gained were the fields already available in the SDO without the join. You must assess the trade-off individually for each case.
Using mapped fields

You can use the mapped field feature when there is a dynamic lookup on a viewer and you must display extra information on the viewer for the selected or displayed lookup record. In this case, you can add a field to the viewer and link this field to a selected field in the lookup browser that displays when a selection is made.

For example, you can modify the **CustomerCodeLookup** in the order viewer that you build as part of the Progress Dynamics tutorial using the dynsports database. (For more information on this tutorial, see *OpenEdge Development: Progress Dynamics Getting Started.*) For the tutorial, you create this lookup on the fill-in for the customer object field (customer_obj) that you generate as part of the dynamic viewer (artorview) for art_order. For a given order, this lookup displays the customer name that you select from the lookup browser with a query on arm_customer. The lookup browser displays both customer_code and customer_name for each arm_customer, and the lookup also contains a link from customer_balance to a fill-in (fiCustBalance) that you create on the viewer so the balance can be displayed for the selected customer.

**Preparing the lookup for field mapping**

In the tutorial example, **CustomerCodeLookup** uses three fields from the query on arm_customer:

- customer_balance
- customer_code
- customer_name

In order to avoid AppServer requests when displaying the fields used by a lookup, you must map all of the fields used in the lookup query to the viewer data source (SDO), including the displayed field, all fields specified for the lookup browser sequence, and any specified linked fields. For this example, you must map the three lookup fields to corresponding fields in the SDO for art_order (artorfullo). Because the tutorial generates the artorfullo SDO as a data source for art_order only, you must explicitly add the arm_customer fields for the lookup to this SDO.

**To add the arm_customer fields to the lookup:**

1. Modify the SDO to join art_order to arm_customer (on customer_obj, by default).
2. Add the fields from arm customer to the SDO like this:
   - `customer_balance` — Not updateable.
   - `customer_code` — Not updateable.
   - `customer_name` — Updateable.
Mapping lookup fields to the SDO

You can map the lookup fields in the following ways:

1. Linking lookup fields directly to SDO fields on the viewer.
2. Mapping lookup fields to SDO fields through viewer widgets.

These two options essentially provide the same results at run time. However, for cases where you cannot use the first option, you can use the second option to get the lookup data from the SDO.

In the example from the tutorial, you can use either option. However, the first option produces a less practical result, with an extra (and redundant) field on the viewer.

**Note:** Progress Dynamics only uses the field mapping mechanism when records are being displayed from the data source. If the user changes a lookup’s value, the default behavior for retrieving these values (from the AppServer) executes. However, the mechanism still improves performance and reduces AppServer requests.

Linking lookup fields directly to SDO fields on the viewer

Linking the lookup fields directly to the SDO fields is the most direct way to map them, depending on how the lookup is defined in relation to the SDO.

To link the fields from the tutorial CustomerCodeLookup directly to the SDO fields:

1. Ensure that you have created a join from art_order to arm_customer in the art_order SDO (artorfullo) and added the following fields for the lookup from arm_customer to the SDO:
   - customer_balance
   - customer_code
   - customer_name

   For more information, see the “Preparing the lookup for field mapping” section on page E–14.

2. After you have saved the updated SDO, open the art_order viewer (artorviewv) in the AppBuilder.

3. Drop the SDO fields for the lookup on the viewer using the DB Fields object from the Palette. The Multi-Field Selector for DB Fields lists the newly added SDO fields for you to select and add to the viewer.

   **Note:** After you drop the fields onto the viewer, one of them, the **customer_name** object, has the same label (Customer Name) as the **CustomerCodeLookup**.

4. Right-click on the CustomerCodeLookup and choose Instance Properties from the pop-up menu. This displays the SmartDataField Maintenance (Instance Properties) window.
5. In the query field browser, select the row for each of the lookup fields and type the column values as shown in Table E–2.

Table E–2: Column values for lookup field mapping directly to SDO

<table>
<thead>
<tr>
<th>For Field name . . .</th>
<th>Set Link field to . . .</th>
<th>Set Linked widget to . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>arm_customer.customer_balance</td>
<td>YES</td>
<td>customer_balance</td>
</tr>
<tr>
<td>arm_customer.customer_code</td>
<td>YES</td>
<td>customer_code</td>
</tr>
<tr>
<td>arm_customer.customer_name</td>
<td>YES</td>
<td>customer_name</td>
</tr>
</tbody>
</table>

This is the SmartDataField Maintenance (Instance Properties) window as it appears after you have finished the field links (with customer_name scrolled out of view):

6. Save the instance properties to complete the field linkage.

As noted in Step 3, using this option to map the lookup fields creates two redundant field objects on the viewer labeled Customer Name:

- The CustomerCodeLookup on the customer_obj field from the SDO (art_order).
- The customer_name fill-in from the SDO (joined to arm_customer).

Both of these fields display the same value of customer_name as displayed or selected in the lookup. There is no way to complete the mapping of all lookup fields using this option without duplicating the display of that same field mapped from the SDO.
Thus, this option linking lookup fields directly to SDO fields works best if the SDO field displayed in the lookup is the same as the viewer field on which the lookup is created. For example, you might use this option to map the fields of a lookup on the tutorial viewer for arm_customer (armcuview), where the lookup is created on the customer_code field, which already provides the value from the SDO for display in the lookup.

For the CustomerCodeLookup example created on customer_obj, you can fix the redundancy for the user by permanently hiding the customer_name fill-in object used to map the lookup display field to the corresponding SDO field. However, you might prefer to use the second option for mapping lookup fields through separate viewer widgets mapped to the SDO.

### Mapping lookup fields to SDO fields through viewer widgets

For the CustomerCodeLookup example created on customer_obj, you can fix the redundancy for the user created by linking the lookup fields directly to the SDO by permanently hiding the customer_name fill-in object used to map the lookup display field to the corresponding SDO field. However, you might prefer to map lookup fields through separate viewer widgets mapped to the SDO.

To map the fields from the tutorial CustomerCodeLookup to SDO fields through viewer widgets:

1. Ensure that you have created a join from art_order to arm_customer in the art_order SDO (artorfullo) and added the following fields for the lookup from arm_customer to the SDO:
   - customer_balance
   - customer_code
   - customer_name

   For more information, see the “Preparing the lookup for field mapping” section on page E–14.

2. After you have saved the updated SDO, open the art_order viewer (artorview) in the AppBuilder.

3. Add a new fill-in widget, fiCustCode, to the viewer, formatted to display arm_customer.customer_code.

   **Note:** This example assumes that you have already added the fiCustBalance widget as part of creating CustomerCodeLookup in the tutorial. For more information, see OpenEdge Development: Progress Dynamics Getting Started.

4. Right-click on the CustomerCodeLookup and choose Instance Properties from the pop-up menu. This displays the SmartDataField Maintenance (Instance Properties) window.
5. In the query field browser, select the row for `arm_customer.customer_code` and type the following column values:

- **Link field** — YES
- **Linked widget** — fiCustCode

This is the SmartDataField Maintenance (Instance Properties) window as it appears after you have set these column values:

![SmartDataField Maintenance (Instance Properties) window](image)

**Note:** The corresponding column values for the `arm_customer.customer_balance` row have already been set from the tutorial.

6. Choose the **Map Fields** tab. The left selection list on this tab lists all the fields in the data source (`artorfullo SDO`), and the right selection list lists the linked viewer fields (`fiCustBalance` and `fiCustCode`) for the lookup query.
7. Map these viewer fields to the corresponding SDO fields:

a. Select the `arm_customer.customer_balance` field in the left selection list and the `fiCustBalance` field in the right selection list. The Map button now becomes enabled, as shown:

b. Click Map. The two selected fields disappear from the selection lists and appear in the Mapped fields editor.

c. Repeat Step a and Step b for the `arm_customer.customer_code` field in the left selection list and the `fiCustCode` field in the right selection list.

8. Map the Displayed field for the lookup:

a. Select the `arm_customer.customer_name` field from the left selection list and `<Displayed Field>` from the right selection list.

b. Click Map.
The entire field mapping for the lookup appears in the **Mapped fields** editor, as shown:

9. Save the instance properties to complete the dynamic lookup field mapping.

The field redundancy that the first mapping option creates for this example (see the “Linking lookup fields directly to SDO fields on the viewer” section on page E–15) does not occur using this option. The **Map Fields** tab allows you to specify the mapping of the lookup **Displayed field** to the corresponding SDO field without the need for a linked viewer widget that would otherwise create a redundant field on the viewer mapped to the SDO that displays the same value. Although this mapping option requires more steps to set up, it has the flexibility to accommodate field mappings for any lookup, no matter how it is defined.

**When Dynamics does not use mapped fields**

Even if you have mapped the fields for a dynamic lookup to linked fields on the viewer, Progress Dynamics might not use this field mapping mechanism to retrieve data for the lookup. This happens when a later change is made to the data source that renames or removes one of the mapped fields, or a mapped field on the viewer has been renamed or removed. If this happens, to ensure that the user always gets the correct data, Progress Dynamics does not attempt to get the linked field values from the SDO, but instead makes the extra AppServer request to return all of the correct information to be displayed in the lookup.
Class and entity cache

In Progress Dynamics, a class or object type represents an inheritance mechanism for attributes that defines the behavior of the objects in that class. Entities in Progress Dynamics define a logical schema in the Repository that corresponds to schema tables in the framework and application database. This class and entity information represents a large amount of data that typically does not change often, and, because of the object orientated nature of the framework, this information is expensive to access and organize at run time.

The class and entity cache adds an additional deployment step that precreates the data in a form that is readily usable at run time, and creates the data persistently so it can be deployed onto each client machine. This cache avoids the expense of constructing the information at run time, and it removes the need to transfer the data over the network at run time, thereby improving the overall performance of the application.

Benefits and constraints on the class and entity cache

Note that even without this cache, the construction and retrieval of entity and class data only happens once—the first time a new entity or class is referenced in a session. So, once all entities and classes have been used, the performance with or without the cache is the same. Therefore, the class and entity cache provides a performance gain for cached entities and classes during the session startup and first-use of session objects.

These performance gains and network data reductions come at the cost of some deployment overhead; so, the use of this cache is optional. If you change class attribute defaults, extend the class hierarchy, add new attributes, or change the application database schema, you must regenerate and redeploy the class and entity cache to each client.

Cache architecture

As the name implies, this caching mechanism accommodates two distinct types of data:

- **Class cache** — Containing attribute and other information that defines the class hierarchy
- **Entity cache** — Containing Repository and application database schema information

Class cache

Class information along with its attributes amounts to an average data size of 10KB per class. The class definition does not change frequently and is needed to render each of the ADM2 objects. The class definition in Progress Dynamics maps to the `ADMProps` temp-table definition, which is one of the main data structures in the ADM2 architecture.

Caching the class information in separate procedure files and using the local information at run time significantly reduces the amount of data over the network and AppServer requests required to construct the class hierarchy. The server processing time is also greatly reduced, thereby increasing the availability of AppServer agents for other requests.
**Entity cache**

Dynamic viewers and SDOs are the main consumers of the entity cache, because they rely heavily on the data field information in the Repository. Passing the data field information, such as NAME, DATA-TYPE, FORMAT, LABEL, and COLUMN-LABEL, for each instance of a data field requires expensive server processing (fetching this information from the database frequently) and associated data passed over the network. The data field information cannot be overridden at the instance level, so there is no danger of caching many copies of the same data fields. Therefore, entity information can be easily cached on the client machines to reduce the network data traffic, AppServer requests, and processing time.

The entity information is cached as OpenEdge dump (.d) files containing information from the data field masters.

**How the framework uses the cache**

Each object rendering procedure uses the class and entity information to render the objects in the application. This is how Progress Dynamics checks availability of and fetches the information:

1. If the session property, StartupCacheClasses, is provided with the CVS list classes to cache for the session, Progress Dynamics caches these classes in memory at startup.

2. The client checks if the class or entity information is available in memory, and uses it if found. Any of the previous calls in this client session might have fetched this information.

3. If the requested class or entity information does not exist in memory, the client checks its machine’s local disk for the class or entity information, and uses it if found. The session property, client_cache_directory (absolute path to an existing directory), can specify the search directory.

4. If no cache is generated or information is not found in the cache, the client makes a server request to fetch the information from the server. In an AppServer configuration this represents an extra AppServer request. In a slow network environment, the cost, in time, of a server round trip can be relatively expensive.

5. At session shutdown, Progress Dynamics writes any cached entities out to disk.

**Note:** Progress Dynamics writes only the entity cache out to disk, not the class cache.

If the client_cache_directory session property is specified, the cache is written to that directory. Otherwise, Progress Dynamics writes the entity cache to the directory for the ry-clc product module. The session property, auto_dump_entity_cache, allows you to specify whether to have the shutdown process dump the entity cache to disk. For more information on these session properties, see the “Configuring the class and entity cache” section on page E–25.
Generating the cache

Progress Dynamics provides a tool to generate the class and entity cache for deployment.

To generate the cache:

1. From the Administration tool, choose *Deployment → Generate Client Cache*, displaying the *Generate Client Cache* window, as shown:

![Generate Client Cache Window](image)

2. If you want to generate a class cache, check the **Class Cache** toggle box and choose the **Class** tab. The browser on the **Class** tab displays classes where the `cache_on_client` field in the `gsc_object_type` table is set to `TRUE`. You can multi-select as many object types as you want to cache.

**Note:** If you extend the classes provided with Progress Dynamics, and if you choose to cache those classes on the client, you can set the `cache_on_client` value using the **Cache on client** toggle box from either the Object Type Maintenance tool or the Repository Object Maintenance tool. For more information on these tools, see *OpenEdge Development: Progress Dynamics Basic Development.*
3. If you want to generate an entity cache, check the **Entity Cache** toggle box and choose the **Entity** tab, as shown:

![Generate Client Cache window](image)

The browser on the **Entity** tab displays the entities that have been imported into the Progress Dynamics Repository. You can multi-select as many entities as you want to cache.

4. Once you select the classes and entities you want to cache, you can click **Go** to generate the class and entity cache.

By default, Progress Dynamics generates the class and entity cache in the directory specified for the ry-clc product module. For better control, Progress Software Corporation recommends that you use the `client_cache_directory` session property to specify where the client cache is generated. Using this property keeps all client cache content in one place, allowing you to easily deploy the cache to clients. Setting the `client_cache_directory` property ensures that the specified directory is searched for the class and entity cache. Using this property also eliminates one AppServer request (during AppServer configuration) required to obtain the relative path of the client cache based on the ry-clc product module settings.
Configuring the class and entity cache

Progress Dynamics provides the following session properties that you can use to configure the class and entity cache:

- **client_cache_directory** — An absolute path where the client cache is generated and accessed. Setting this property eliminates one AppServer request (in AppServer configuration) otherwise required to obtain the relative path of the client cache based on the ry-clc product module.

  You can use this property to help separate the development session from your run-time sessions.

- **auto_dump_entity_cache** — Indication telling Progress Dynamics if it is to dump the entity cache to disk at session shutdown. If this property is set to YES, at shutdown, Progress Dynamics writes any entities in memory to disk. This allows you to reuse the entity information from the disk instead of going to the server with additional AppServer requests. The default value is YES.

  This property primarily provides additional control to Progress Dynamics developers, where you typically set it to NO. In development sessions, you do not want entities cached, because you have to repeatedly delete the cache when you make changes to your entity information. However, in a run-time environment, you typically set it to YES to provide the performance benefits for the application.

- **StartupCacheClasses** — A CVS list of classes that you want cached at startup, instead of fetching the class information when needed. Concentrating the caching of classes at startup allows faster rendering for containers during the greater part of the session duration.

  Specify the "*" wild card to have Progress Dynamics precache all the classes from the Repository at startup.

  **Note:** Because a value of "*" results in a large amount of data movement during login, be careful when and how you use this option.

Using the class and entity cache

The major cost of class and entity cache is in the deployment overhead. If you change class attribute defaults, extend the class hierarchy, add new attributes, or change the application database schema, you must regenerate and redeploy the class and entity cache to each client.

If you have generated the cache using the Generate Client Cache tool or you have set the auto_dump_entity_cache session property to YES, any changes you make to the entity (schema tables) and class data (including adding of new properties or changing the defaults for the class data) in design-time sessions require that you update the cache for all clients. If you do not regenerate the cache using the Generate Client Cache tool and deploy the regenerated cache appropriately, none of your changes will be visible on the affected clients.
Toolbar Image Optimization Using PicClip Images

Toolbars support the use of PicClip images. PicClip images are a series of multiple images in a grid format that are stored in a single bitmap (.bmp) file. Figure E–2 shows a PicClip image that contains many of the toolbar images used in the Progress Dynamics toolbars.

![Figure E–2: PicClip file, toolclip.bmp](image)

Progress Dynamics maintains this file in the following location:

```
OpenEdge_Install/src/dynamics/ry/img/toolclip.bmp
```

Benefits and constraints on using PicClip images

In earlier releases of Progress Dynamics, a separate image file was maintained and loaded for each button in a toolbar. By combining all images into a single PicClip image, the time required for loading these images has decreased substantially over loading them as separate images. Along with the name of the image file itself, Progress Dynamics loads an X and Y offset, width, and height that identifies the portion of the PicClip containing a specific image. The performance improvement of using this mechanism is most noticeable the first time a container is launched and the images have not yet been loaded into the operating system cache.

**Note:** Even when not using PicClip images, the Progress Dynamics image-loading process is optimized to minimize the number of searches using the relative path name of the image.

Progress Dynamics only supports the use of PicClip images for the GUI environment.

Using PicClip images for custom toolbars

If you have created your own toolbar images, Progress Software Corporation recommends that you use your own toolbar PicClip image rather than appending your images to the Progress Dynamics-supported PicClip image file (toolclip.bmp). You can specify the PicClip image file, along with the offsets and image size, using the Toolbar and Menu Designer. The Toolbar and Menu Designer allows you to specify images either from a PicClip image file or a single image file, and you can specify primary and alternate versions of each.
To specify a PicClip image:

1. Open the **Toolbar and Menu Designer** and select an item that requires an image, as shown:

![Toolbar and Menu Designer](image)

2. Click the down-arrow button next to the **Image1** (primary image) field and select **PicClip1** from the pop-up menu.

3. In the **PicClip1** field, specify an image file (relative pathname) together with the X and Y offset, the width, and the height (in pixels) in the following comma-delimited format:

   Syntax

   \[
   \text{image-pathname}, X-offset, Y-offset, width, height
   \]

   You can also specify the relative pathname of a separate image file containing a single image (if provided), using the **Image1** field. At run time, Progress Dynamics attempts to load the PicClip image before loading any separate image specified for **Image1**.

4. If you have one, you can repeat Step 3 to specify an alternate image using the **Image2** and **PicClip2** fields.

**Note:** The specified PicClip image file information is stored in the fields `gsm_menu_item.image1_down_filename` and `gsm_menu_item.image2_down_filename` for the primary and alternate images, respectively.
Performance Notes

Caching toolbars and container menus at session startup

Progress Dynamics usually extracts toolbar items and container menus when the container they belong to is extracted from the Repository. These items are then cached on the client and reused as necessary. This client caching mechanism caches the bands and actions against the respective toolbar or container. When the toolbars and menus for a new container are cached, Progress Dynamics always extracts all bands and actions because the server cannot determine what information has already been cached on the client. Where the same bands are used across multiple toolbars or menus, this results in a duplication of work if a band has already been cached for another container. Caching toolbars and menus at session startup (toolbar and menu pre-caching) reduces this duplication of work by ensuring that any bands reused on multiple toolbars or containers are only processed once.

Benefits and constraints on toolbar and menu precaching

When a toolbar or object menu cannot be found in the client cache, the client has to make an AppServer request to retrieve the necessary information. Caching multiple toolbars at session startup results in fewer AppServer requests given that each toolbar cached in the initial request would otherwise have required a later request.

As with any caching at session startup, caching toolbars and container menus at session startup requires a longer Progress Dynamics startup time. An extra AppServer request is also made when the session starts. It is also possible that toolbars and menus cached at session startup might not be used in the session, in which case the caching overhead incurred at startup has been unnecessary.

Configuring toolbar and menu precaching

Progress Dynamics provides two session properties to activate this feature. You must specify the following session properties in the Progress Dynamics configuration .xml file:

- **StartupCacheToolbars** — A comma-delimited list of logical names for toolbars to precache at session startup. Specify the "*" wild card to cache all toolbars.

- **StartupCacheMenusForObjects** — A comma-delimited list of logical names for Repository containers. The menus for these containers will be precached at session startup.

To cache menus for containers against a specific run attribute, specify the name and run attribute code for each container in the list using this syntax:

```
container-name[;run-attribute-code]
```

If the run attribute does not apply to a given container, specify `container-name` only for the specified container.

These properties are not specified by default. Therefore, no toolbar or menu precaching occurs unless you specify them.
To specify the session properties for precaching toolbars and menus:

1. Open the Session Type Maintenance tool by choosing **Session**→**Session Type Control** in the Administration tool.

2. Add the session properties to appropriate client session types, such as DynASClient, as shown:

   ![Session Type Maintenance Tool Screenshot](image)

3. Generate a new Progress Dynamics configuration .xml file by choosing **Session**→**Generate Configuration File** in the Administration tool. This creates entries in the .xml file for the applicable session types, like the following:

   ```xml
   <properties>
   ...
   <startupCacheToolbars>*</startupCacheToolbars>
   <startupCacheMenusForObjects>afallmencw</startupCacheMenusForObjects>
   ...
   </properties>
   ```
Using toolbar and container menu precaching

Note the following guidelines when using this feature:

- The session properties for configuring this feature only have meaning in a client session type; do not set them for AppServer sessions. These properties also do not apply in Dynamics Web sessions.

- Progress Software Corporation recommends that you identify and precache all toolbars that are used extensively in an application.

- Container menus rarely need to be precached. Precache container menus only when the same menu bands are used extensively for different containers.
Thin SmartObject rendering

SmartObject rendering and initialization are expensive. Running SmartObject instances involves method library include files, prototype include files, property include files, extended class include files and logic to set various properties based on static preprocessor values. The existence of this code adds to the size of the compiled r-code and to the cost of execution.

Thin versions of various Progress SmartObjects™ exist that contain less r-code than their full counterparts. The thin versions exclude logic from their compilations that are not required for most dynamic objects, such as prototype and custom include-file inclusion and logic to create ADMProps.

Thin SmartObject rendering procedures exist for the following dynamic objects:

- Dynamic SmartDataObject
- Dynamic lookup
- Dynamic combo
- Dynamic browser
- Dynamic viewer

These thin rendering procedures include their dynamic object and rely on preprocessor definitions to optimize the rendering information. There are two preprocessor definitions specific to thin SmartObject rendering:

- **ADM-EXCLUDE-PROTOTYPES** — Every ADM property include file contains definition checks to exclude the compile of the ADM prototype include file. For example:

```plaintext
&IF DEFINED(ADM-EXCLUDE-PROTOTYPES) = 0 &THEN
&IF "{\&ADMSuper}"::U EQ "":U &THEN
{src/adm2/combprto.i}
&ENDIF
&ENDIF
```
• **ADM-EXCLUDE-STATIC** — Every ADM property include and class include file contains definition checks to exclude the compilation of code only required for static objects. For example:

```plaintext
&IF DEFINED(ADM-EXCLUDE-STATIC) = 0 &THEN
{src/adm2/custom/datacustom.i}
&ENDIF

&IF DEFINED(ADM-EXCLUDE-STATIC) = 0 &THEN
IF NOT {&ADM-LOAD-FROM-REPOSITORY} THEN
&ENDIF

&IF DEFINED(ADM-EXCLUDE-STATIC) = 0 &THEN
IF NOT {&ADM-PROPS-DEFINED} THEN DO:
  &IF "(&ADMSuper)" :U = "":U &THEN
    ghADMProps:ADD-NEW-FIELD('ObjectLayout':U,'CHARACTER':U,0,?,"":U).
    ghADMProps:ADD-NEW-FIELD('LayoutOptions':U,'CHARACTER':U,0,?,"":U).
    ghADMProps:ADD-NEW-FIELD('ObjectEnabled':U,'LOGICAL':U,0,?,no).
    ghADMProps:ADD-NEW-FIELD('LayoutVariable':U,'CHARACTER':U,0,?,"{&LAYOUT-VARIABLE}"U).
    ghADMProps:ADD-NEW-FIELD('DefaultLayout':U,'CHARACTER':U,0,?,"":U).
    ...
```

In addition to defining **ADM-EXCLUDE-PROTOTYPES** and **ADM-EXCLUDE-STATIC**, the thin rendering procedures define exclude-start-super-proc to exclude compilation of the start-super-proc internal procedure. Here is an example of a thin rendering procedure:

```plaintext
&GLOBAL-DEFINE ADM-EXCLUDE-PROTOTYPES
&GLOBAL-DEFINE ADM-EXCLUDE-STATIC
&SCOPED-DEFINE exclude-start-super-proc
{adm2/dynsdo.w}
```

### Configuring thin SmartObject rendering

Progress Dynamics provides the ThinRenderingProcedure attribute to define the thin rendering procedure for a given object. Thin rendering procedures are defined for the following classes:

- **DynS00** — adm2/thinsdo.w
- **DynLookup** — adm2/thinlookup.w
- **DynCombo** — adm2/thincombo.w
- **DynBrow** — ry/obj/rythinbrowb.w
- **DynView** — ry/obj/rythinvieww.w

If this attribute is blank, Progress Dynamics always uses the procedure specified by the RenderingProcedure attribute to render the object.
Progress Dynamics provides the UseThinRendering session property to specify if Progress Dynamics uses a defined (nonblank) thin rendering procedure to render a given object at run time. If this property is FALSE, Progress Dynamics uses the procedure specified by RenderingProcedure to render the object.

UseThinRendering defaults to TRUE for the DynASClient and Default session types and defaults to FALSE for all other session types.

Thin dynamic SDOs cannot run on the server side because they are initialized on the server based on context passed from the client rather than reading the Repository. Thin SmartObjects must be initialized from the Repository.

**Note:** Even if UseThinRendering is set to TRUE for the DynAppServer session types, the RenderingProcedure attribute is used to set the SDOs ServerFileName instead of the ThinRenderingProcedure attribute.

### Using thin rendering

In rare cases where application code relies on logic that has been excluded from the compile of thin objects, re-evaluate the logic and change it, if possible. For example, reliance on prototype definitions requires direct references to functions to change to DYNAMIC-FUNCTION in order to take advantage of thin objects. If dependencies in the excluded logic cannot be resolved, do not use thin rendering.

You can turn off thin rendering for all objects with the UseThinRendering session property, or you can turn it off for a class of objects, for individual object masters, or for object instances by setting the ThinRenderingProcedure attribute to a blank value.

Certain development tools, such as the Container Builder, require the full objects rather than their thin counterparts. You can set UseThinRendering to TRUE in a development session type and thin objects might run in these sessions without a problem. However, some development tools will not always function properly. Therefore, always set UseThinRendering to FALSE for a development session type.
Dynamic TreeView optimizations

The dynamic TreeView makes use of dynamic frames to construct the object on the right-hand side, and this helps it to use the object exactly as it was designed. Unlike previous versions, the dynamic TreeView does not replace the toolbar of your object with a generic toolbar. This change affords far more flexibility than in previous versions. In addition, the dynamic frames used by the TreeView can be kept alive, saving time by not having to destroy and re-create them every time a node associated with the frame is reselected. You can configure how these dynamic frames are kept alive.

The dynamic TreeView also supports a node-batching feature that you can configure. If your TreeView object is likely to return a large result set, you can set a maximum number of records to batch, returning subsets of records at one time. If more records are available following the current batch, a …More node is added as the last node allowing the user to get the next batch of records.

Keeping dynamic frames alive on the client

When a user selects and deselects (opens and closes) the node associated with a dynamic container, Progress Dynamics manages the frame’s resources differently depending on certain session and object settings. So, Progress Dynamics can manage a dynamic frame using one of two mechanisms:

1. Create the dynamic frame each time the user opens it, then destroy the frame each time the user closes it. With this mechanism, Progress Dynamics incurs the performance overhead of creating and destroying the frame with each use, but allocates a minimum of memory to manage all dynamic frames in a session.

2. Create the dynamic frame the first time the user opens it, then hide (keep alive) the frame each time the user closes it. With this mechanism, Progress Dynamics eliminates the performance overhead of creating and destroying the frame with each use, but allocates additional memory with each dynamic frame that it keeps alive.

Properties to manage dynamic frame memory

Progress Dynamics provides the session property, MaxHiddenContainers, for you to specify how you want Progress Dynamics to manage the memory resources for dynamic frames used by a given dynamic TreeView instance. To manage these resources, Progress Dynamics uses this property together with the HideOnClose and HideChildContainersOnClose attributes on dynamic frames and dynamic TreeViews.

If you set MaxHiddenContainers to a value greater than 0 (zero), Progress Dynamics creates a hidden frame list of up to n frames in each TreeView that it runs in a session, then displays and hides these frames each time a user opens and closes them. Any additional frames opened by the user replace the least recently used frame in the list.

If you set the value to 0 (zero), to the Unknown value (?), or you do not specify the property at all for a session type, Progress Dynamics maintains no hidden dynamic frames, but instead creates each frame when the user opens it (selects a TreeView node that displays the frame) and destroys each frame when the user closes it (selects another TreeView node to display a different frame).
Configuring dynamic frame memory use

Starting with Progress Dynamics Version 2.1A, Progress Dynamics predefines the MaxHiddenContainers property for all run-time client sessions with a default value of 10. You can use the Session Type Maintenance tool to change this value for any session type, or add the property to run-time sessions when upgrading from a previous version, then add it to your Progress Dynamics configuration .xml file by generating a new configuration file.

In the configuration file, an entry appears for each session type like this (using the default value):

<MaxHiddenContainers>10</MaxHiddenContainers>

Note: A dynamic TreeView can potentially have many dynamic frames running in a session, which can consume large amounts of memory. Before setting a relatively high value for this property, make sure that each client machine that runs a given session type can handle the specified maximum number of hidden frames.

Configuring the node-batching feature

You can configure the number of nodes to batch for a dynamic TreeView using the RowsToBatch attribute at the DynTree class level or on each dynamic TreeView instance. Setting the RowsToBatch attribute to 0 (zero) at the DynTree class level turns off node batching for all dynamic TreeView objects, and at the instance level turns off node batching for the given instance. This forces all nodes to be read at one time.

Note: When migrating from a Progress Dynamics version earlier than Version 2.1A, Progress Dynamics automatically enables the node-batching feature for all dynamic TreeView objects.

You can configure node batching individually for each TreeView instance by changing the RowsToBatch attribute using the Dynamic TreeView Builder tool.
To change RowsToBatch for a dynamic TreeView instance:

1. Choose **Build → Dynamic TreeView Builder** from the AppBuilder or Development tool to open the **Dynamic TreeView Builder**, and select a TreeView object using the **Object filename Lookup** button, opening the object as shown:

2. Click **Container properties** on the toolbar to open the dynamic property sheet (**Dynamic Properties** dialog box), as shown:
3. Scroll to the **RowsToBatch** attribute and set its value as you require.

**Note:** If you use node batching and also have the **AutoSort** attribute set to **YES** for the TreeView object (intending to sort the nodes), you must ensure that your data source (SDO) is sorting on the same fields specified as the fields to be displayed as the node label. This is required because when you use node batching, Progress Dynamics ignores the **AutoSort** setting in order to ensure that...More is always positioned as the last node in the TreeView. Otherwise, if the batched data does not come properly sorted from your data source, it will not be sorted in the TreeView. If you later turn off node batching (set **RowsToBatch** to **0** (zero)), the TreeView again functions according to the **AutoSort** setting.

---

**Using dynamic TreeViews**

Note the following guidelines when using dynamic TreeViews, especially when upgrading from previous versions:

- The optimized dynamic TreeView released as of Version 2.1A eliminates some private and undocumented APIs that are no longer used, but were present in previous versions of the dynamic TreeView.

- If code in previous versions relies on the dynamic TreeView to be the source container of an object, you must review the logic, because for the optimized TreeView, the object’s source container is the dynamic frame, and the dynamic frame’s source container is the dynamic TreeView.

- When configuring the number of frames to keep alive, you must ensure that the client machine running the given session can handle the maximum number of hidden frames because use of memory increases with an increasing number of running objects.

- If you use node batching and also have the **AutoSort** attribute set to **YES** for the TreeView object (intending to sort the nodes), you must ensure that your data source (SDO) is sorting on the same fields specified as the fields to be displayed as the node label. This is required because when you use node batching, Progress Dynamics ignores the **AutoSort** setting in order to ensure that...More is always positioned as the last node in the TreeView. Otherwise, if the batched data does not come properly sorted from your data source, it will not be sorted in the TreeView. If you later turn off node batching (set **RowsToBatch** to **0** (zero)), the TreeView again functions according to the **AutoSort** setting.
SmartDataObject data definition and schema location

Progress Dynamics maintains the field definitions for data objects in the Repository metaschema recorded in Entity and EntityFields, not from the Data Dictionary. This also applies for static SDOs, except that a field’s initial value is whatever the code specifies during compilation.

Configuring the location for field definitions

You can modify the location of field definitions by setting the SchemaLocation attribute defined for the Data class. These are the possible values and their meanings for where the SDO gets this information:

- **ENT** — Uses the Repository’s entity cache for its field definitions (default value)
- **DLP** — Copies its field definitions from the DataLogic procedure buffer
- **BUF** — Copies its field definitions from the database buffer

Using the SchemaLocation attribute

Change this attribute for performance reasons only very rarely, especially for dynamic SDOs. The entity cache exists to improve performance for all objects that need schema information at run time, both visual objects and data objects, but the actual caching has to happen somewhere. Setting SchemaLocation to **ENT** adds overhead to the SDO startup the first time it is started if the particular entities are not already cached. However, changing the SDO to not use the entity cache, in most cases, moves the responsibility and overhead to some other object. Also note that entities, in most cases, are already cached, either at startup or by startup of another object.

Factors to consider before changing this setting include:

- SDOs that do not use any visual objects and that access entities not used by other objects can get a performance benefit from using the **DLP** setting, because these particular entities do not need to be cached.
- SDOs that do not use the **ENT** setting can be used without importing entities into the Repository.
- The **BUF** setting is currently 50% to 70% slower than the two other settings.
- SDOs that have OpenOnInit set to **TRUE** define the temp-table on the first request to the server; SDOs that have OpenOnInit set to **FALSE** need to define the temp-table on the client, and thus require the cache to be on the client. You cannot use the **BUF** setting on SDOs with OpenOnInit set to **FALSE**.
- The **DLP** setting is static in the sense that the information is not any fresher than the last compilation of the DataLogic procedure.

**Note:** Static SDOs derive a performance benefit from not using the **ENT** setting, because the Entity definition must be added in an additional loop. The **DLP** setting is currently ignored for static SDOs, because both **BUF** and **DLP** make the SDO use the definitions already compiled into them.
SuperProcedureMode attribute

The SuperProcedureMode attribute indicates a mode for how a class or object super procedure is started. Possible valid values include:

- **STATELESS** — The super procedure starts once per session and stays alive after object shutdown. There is only one instance of the super procedure running in any given session.

- **STATEFUL** — One instance of the super procedure starts per object. The super procedure is shut down when the object is destroyed. Multiple instances of the super procedure might run during a session, depending on the number of concurrently running objects.

The default for classes is STATELESS mode and the default for object (viewer, browser, container, SmartDataField, and so on) super procedures is STATEFUL mode.

Using the attribute

To reduce the size of the client footprint, always try to write super procedures so they can be run using STATELESS mode.
Dynamic call wrapper (dynlaunch.i)

Avoiding the use of `dynlaunch.i` and the dynamic call wrapper for AppServer calls reduces the time required to retrieve data from the AppServer and reduces the amount of data transmitted in an AppServer request.

**Impact of dynlaunch.i on performance**

Using the dynamic call wrapper to retrieve data from the AppServer can add overhead in an AppServer call because of the need to construct and pass temp-tables as parameters between the client and the server. Given that the overhead might be small for smaller AppServer calls (at an average of 70 ms), the overhead increases as the number of parameters increases so that a call using the dynamic call wrapper can add as much as 500 ms to an AppServer request in a worst-case scenario.

As of Progress Dynamics Version 2.1A, all uses of `dynlaunch.i` are removed from Progress Dynamics managers in cases where a call is likely to be made often, for example the `getPropertyList` and `setPropertyList` API calls in the Session Manager.

The dynamic call wrapper is still used by the framework, but not in places where the framework would pay a significant and perceptible overhead.

**Using dynlaunch.i**

You can continue to use `dynlaunch.i` for most calls without significant impact on performance. Only in cases where there is a significant benefit to be gained, or data on the network must be reduced to an absolute minimum, should you consider replacing `dynlaunch.i` with a static call. Where a static call is used, take care to ensure that a single, non-persistent procedure is called on the server so that no more that one AppServer request is incurred for the call.
Creating customized login windows

When you create a customized login window, if you use the same layout as the default login window (aftemlognw.w) and include "lognw" in the name of the login window, you will avoid one extra AppServer request.

Using Dynamics support for customized login windows

During the startup of a Progress Dynamics session it is necessary to translate the data on the login window. Unfortunately, the controls on the login window are not known until the data is retrieved by the client.

This means that an AppServer request must be made to retrieve the login window information from the AppServer, and a second AppServer request is then made to retrieve translation information for the window. To avoid the extra AppServer request for translation information, code is added to the cachelogin.p procedure that retrieves the login window information to automatically retrieve the translation information for the default login window—aftemlognw.w.

Many users do customize the login window, though, and to ensure that this is possible, the functionality that retrieves the translation information also supports retrieving the same information for any login window that contains the character string "lognw" in the name of the login window.

Guidelines for customized login windows

If you intend to customize the login window and you want to avoid the extra AppServer request associated with translating the login window, ensure that the customized login window conforms to the following guidelines:

1. The customized login window must include the string "lognw" in the object name of the login window.

2. The customized login window must contain the same objects as the default login window (aftemlognw.w). This means that the objects need to be the same type and name as the default login window.
Index

Numbers
4GL Generator
See also Static-ABL equivalents of dynamic objects

A
ADM-EXCLUDE-PROTOTYPES preprocessor variable E–31
ADM-EXCLUDE-STATIC preprocessor variable E–32
ADO See also Dataset (ADO) files 5–11
AM handle code C–5
analyzeCase function
   Installation User Interface Manager 5–24
analyzeIf function
   Installation User Interface Manager 5–25
APP physical sessions C–3
Application
categories 4–22
   feature support 4–1
   Login dialog box 2–5
   menu overview 1–3
   user-defined status 4–25
AppServer
   connection manager property C–2
AS handle code C–5
AU handle code C–5
Audit Control tool 1–8
Auditing 4–17
   enabling on a table 4–17
   triggering an entry 4–18
   viewing on a record 4–19
auto_dump_entity_cache session property E–25

B
Batch-mode DCU 5–42
   creating the command script 5–43
dcuphase1.p 5–44
dcuphase2.p 5–45
   generating input data 5–42
   -icfparam parameters 5–43
   sample command script 5–46
BTC physical sessions C–3
btnChoose procedure
   Installation User Interface Manager 5–25

C
Caches
   updating during deployment 5–9
Cascading security information 3–20
Categories
   application 4–22, 4–23
   user 3–6
Category Control tool 1–4
cConnectParams XML node C–4
cFileName XML node C–2, C–4

checkForDB procedure
   Installation User Interface Manager 5–25

Class cache E–21

client_cache_directory session property
   E–25

cManagerName XML node C–2, C–4

Combo caching E–8

Comments 4–14
   accessing 4–16
   adding 4–14
   auto-displayed 4–16
   toolbar button 4–16

Companies 1–6, 3–8

Conditional parameters
   using in DCU 5–17

Configuration File Import tool 1–7

Configuration File Manager 2–6
   Connection Manager interface C–3
   getPhysicalSessionType method C–3
   getSessionParam method C–2
   specifying 2–15

Configuration files 2–6
   generating 2–23
   importing 2–28
   minimum XML setting 2–25

Configuration XML file 2–6
   cConnectParams node C–4
   cFileName node C–2, C–4
   cHandleName node C–5
   cManagerName node C–2, C–4
   cPhysicalService node C–4
   cServiceName node C–4
   cServiceType node C–4
   generating 2–23
   importing 2–28
   ICanRunLocalnode C–4
   lDefaultService node C–4
   manager node C–4
   managers node C–4
   properties node C–2
   service node C–4
   services node C–3
   Sessions node C–2
   usage and maintenance C–1

Configurations with DataServers A–5

Connecting to databases 2–5

Connection Manager 2–7, C–3

Connection parameters 2–9

Consolidated groups 3–10
   creating 3–14

Context Help Control tool 1–8

Country Control tool 1–3

cPhysicalService XML node C–4

Creating
   groups based on users 3–14
   security groups 3–13
   session services 2–9
   session types 2–15
   startup shortcut icon 2–26
   users 3–17

Cross-version deployment
   recommended procedure D–17
   tool support D–16

Crystal Reports
   Print Preview output 4–27

cServiceName XML node C–4

cServiceType XML node C–4

CUI physical sessions C–3

Currency Control tool 1–4

Custom configuration properties C–3

Customization
   DCU pages 5–6

Customized login window optimizations
   E–41

D

Data dump (.d) files
   DCU stages 5–10

Databases
   comments 4–14
   connecting 2–5
   connection manager property C–2
   creating with DCU 5–33, 5–37
   stopping 2–6
   upgrading during deployment 5–38
   version sequence 5–19

DataServers
   connecting A–3
   development considerations A–6
   OpenEdge documentation A–7
Progress Dynamics support A–2
schema holder database A–5
two-phase commit A–6

Dataset (ADO) files
DCU stages 5–11

Datasets
Export tool 1–5
Import tool 1–5

DCU
adding pages 5–35
ADO files applied 5–11
APIs 5–24
available Managers 5–5
batch mode 5–42
See also Batch-mode DCU
calling manager APIs 5–15
calling site data dump and load 5–56
capturing data 5–18
conditional parameters 5–17
configuration file 5–13
creating databases 5–37
custom database creation upgrade file
5–37
custom driver files 5–34
custom session type 5–33
customization tips 5–40
customizing DCU sessions 5–31
customizing pages 5–6
Data dump files applied 5–10
database creation 5–21, 5–33
database version sequence 5–19
DCU sessions 5–5
deployment stages 5–9
description 5–4
driver files 5–14
Action node 5–15
ActionParam node 5–16
ActionTarget node 5–15
API calls 5–15
Control node 5–15
Database node 5–18
Event node 5–15
FINISH keyword 5–16
MinimumVersion node 5–19
Page node 5–15
Patch node 5–19
Path node 5–14
Proc node 5–15
QUIT keyword 5–16
RegistryKey node 5–18
StoreTo node 5–18
TableVariable node 5–18
end conditions 5–12
end keywords 5–16
interface components 5–6
logging 5–11
necessary data files 5–31
order of upgrades 5–12
page descriptions 5–15
passing action parameters 5–16
patch levels 5–19
Phase 1 deployment 5–9
Phase 1 stages 5–10
Phase 2 deployment 5–9
processing sequence 5–11
release versioning tools 5–22
Schema definition files applied 5–10
session property impact 5–31
setting minimum version 5–19
specifying ADOs 5–22
standard pages 5–7
starting 5–41
template for pages 5–6
updating cached data 5–9
upgrade
retaining site-specific data 5–47
upgrade file types 5–20
upgrade files 5–20
ADO lists 5–22
database creation 5–21
patch files 5–22
upgrade program attributes 5–33
upgrade program design 5–32
upgrading existing databases 5–38
using events and actions 5–16
using multiple sessions 5–12
wizard interface 5–6
XML files 5–13
dcubatch.bat file 5–46
dcuphase1.p file 5–44
dcuphase2.p file 5–45

DCUSCRIPTFILE parameter
batch DCU Phase 1 5–44
generating batch data 5–43

DCUSITEDATAFILE parameter
batch DCU Phase 1 5–44
generating batch data 5–43

Default security group 3–13, 3–15

Defining
managers 2–15
for a session type 2–18
properties
for a session type 2–19
services
for a session type 2–21
user categories 3–6

Deploy Static Objects tool 1–5

Deployment
adding pages to DCU 5–35
between versions D–16
See also Cross-version deployment
central Repository 5–3
custom database creation upgrade file 5–37
custom DCU session type 5–33
custom driver files 5–34
customizing DCU 5–31
database creation 5–21, 5–33, 5–37
database version sequence 5–19
Dataset Control tool 1–5
DCU APIs 5–24
DCU conditional parameters 5–17
DCU configuration file 5–13
DCU description 5–4
DCU driver files 5–14
DCU end conditions 5–12
DCU Phase 1 5–9
DCU Phase 2 5–9
DCU processing sequence 5–11
DCU stages 5–9
DCU tips 5–40
DCU upgrade files 5–20
Destinations tool 1–5
dynamic objects as static D–3
  See also Static-ABL equivalents of dynamic objects
general information D–1
impact on design 5–2
menu overview 1–4
necessary data files 5–31
order of upgrades 5–12
page descriptions 5–15
patch files 5–22
patch levels 5–19
Phase 1 stages 5–10
planning for 5–2
release versioning tools 1–5, 5–22
sequences D–2
session property impact 5–31
setting minimum version 5–19
specifying ADOs 5–22
specifying databases 5–18
starting the DCU 5–41
updating cached data 5–9
upgrade program attributes 5–33
upgrade program design 5–32
upgrading existing databases 5–38
using multiple DCU sessions 5–12
XML files 5–13

Design
deployment impact 5–2
dumpconfig.txt file
default 5–53
field options 5–53

Dynamic
call wrapper optimizations E–40
lookup mapped fields E–13
TreeView optimizations E–34
dynlaunch.i file E–40

E

Entity
cache E–21
Control tool 1–8
Import tool 1–8
mnemonic
  GSCSC 3–2
  GSCSQ D–2
  GSMLG 3–8
  GSMUC 3–7
  GSTPH 3–19
translations 4–11
  Migrate Widget Translation 4–13
  Translation Maintenance 4–12

Entity mnemonic
  GSMPF 3–19
  GSMUS 3–6

eventProc procedure
  Installation User Interface Manager 5–26

Exporting
data through Print Preview 4–27

F

Filter Set Maintenance tool 1–8
FM handle code C–5
4GL Generator D–4
  window
    using in Administration tool D–7
tool 1–5

G

Gapless sequences
specifying 4–2

Generate
  Client Cache tool 1–5
  Client Cache window E–23
  Configuration File tool 1–6

Generating
  configuration files 2–23
  data for batch-mode DCU 5–42

Generic
  auditing 4–17
  database comments 4–14

getDBFile procedure
  Installation User Interface Manager 5–27

getAddress procedure
  Installation User Interface Manager 5–27
getPhysicalSessionType method C–3
getSessionParam method C–2
Global Control tool 1–7
GM handle code C–5
gotoPage procedure
  Installation User Interface Manager 5–27
Grant security model 3–4, 3–12
Group processing 3–14
Group-based security 3–10
Groups
  based on users 3–14
category 4–22
Groups function, Security Control 1–6
gsc_logical_service table
  cServiceName XML node C–4
  lCanRunLocal XML node C–4
gsc_manager_type table
  cManagerName XML node C–4
gsc_object table
  cFileName XML node C–4
gsc_security_control table 3–2
gsc_service_type table
  cManagerName XML node C–4
cServiceType XML node C–4
gsm_login_company table 3–8
gsm_physical_service table
  cConnectParams XML node C–4
cPhysicalService XML node C–4
gsm_profile_data table 3–19
gsm_service_type table
  IDefaultService XML node C–4
gsm_user table 3–6
gsm_user_category table 3–7
gst_password_history table 3–19
GUI
  site data dump and load 5–55
GUI physical sessions C–3
History
  password 3–19
HTML
  Print Preview output 4–27
I
ICFCM_configuration properties C–2
ICFCONFIG parameter 2–26
icfconfig.xml file 2–6
ICFDB
  database 2–5, 2–6
ICFDB Install Manager 5–6
  obtainICFSeqVals procedure 5–28
  validateSiteNumber procedure 5–30
ICFDev 2–2
  default session 2–5
ICFSESSTYPE parameter 2–2, 2–26
  SessionType attribute value C–2
Importing
  configuration files 2–28
Indexes
  DataServer A–6
Installation User Interface Manager 5–6
  analyzeCase function 5–24
  analyzeIf function 5–25
  btnChoose procedure 5–25
  checkForDB procedure 5–25
  connectDatabase procedure 5–26
  eventProc procedure 5–26
  getDBFile procedure 5–27
  getDirectory procedure 5–27
  gotoPage procedure 5–27
  obtainPatchList procedure 5–28
  processParams procedure 5–28
  restoreProperties procedure 5–29
  screenScrape procedure 5–29
  startUpgradeProcess procedure 5–29
  validateDirectory procedure 5–30
  verifyDBVersion procedure 5–30
Instance Attribute Control tool 1–3
Language
  Control 4–4, 4–5, 4–6
  Control tool 1–3
  Maintenance 4–5, 4–6, 4–7
  translation tools 4–4
lCanRunLocal XML node C–4
Handles
  static manager C–5
IDefaultService XML node C–4
Least restrictive rule 3–10
Levels of categories 4–22
Linking
users and security groups 3–21
Localization
development 4–8
tools 4–4
user run-time 4–9
See also Translation
Logging
DCU 5–11
Logical
service 2–9
creating 2–10
Service Control tool 1–7
Login
companies 3–8
Companies function, Security Control
1–6
filename 3–3
linking to security groups 3–16
Lookup caching E–8

M
Management
global options 3–2
Managers
collection file node C–4
DCU sessions 5–5
defining 2–15
for a session type 2–18
ICFDB Install Manager 5–6
Installation User Interface Manager 5–6
static handles and codes C–5
Type Control tool 1–7
MaxHiddenContainers session property E–34
Menu
 caching at startup E–28
translations 4–10
Message Control tool 1–8
Minimum XML files 2–25
MS SQL Server
OpenEdge DataServer for A–3
Multi Media
Image Control tool 1–4
Type
 Maintenance window 4–20
Type Control
 window 4–20
Type Control tool 1–4

N
Nationality Control tool 1–3
NON handle code C–5

O
Objects, securing 3–2
obtainICFSeqVals procedure
ICFDB Install Manager 5–28
obtainPatchList procedure
Installation User Interface Manager 5–28
Oracle
OpenEdge DataServer for A–4
Owning entities 4–22

P
Passwords
 history 3–19
setting 3–19
unique 3–3
Performance optimization E–1
Class and entity cache E–21
architecture E–21
configuring E–25
framework usage E–22
generating E–23
usage guidelines E–25
customized login windows E–41
usage guidelines E–41
dynamic call wrapper E–40
usage guidelines E–40
dynamic lookup mapped fields E–13
linking directly to SDO fields E–15
mapping through viewer widgets E–17
setup and usage E–14
when not used E–20
Dynamic TreeView E–34
batching nodes E–35
keeping frames alive E–34
usage guidelines E–37
Lookup/combo cache E–8
  clearing E–10
  disabling for particular SmartDataFields E–11
  enabling and disabling E–10
  operation E–8
  when not used E–9
PicClip images E–26
  used in custom toolbars E–26
SDOs kept alive on server E–6
  usage guidelines E–6
SmartDataObject data definition and schema location E–38
  configuring field definition location E–38
  SchemaLocation attribute E–38
startup
  cache for toolbars and menus E–28
  configuring pre-caching E–28
  usage guidelines E–30
  parameter settings E–3
  static-ABL equivalents of dynamic objects E–5
SuperProcedureMode attribute E–39
thin SmartObject rendering E–31
  configuring E–32
  usage guidelines E–33

Physical
  service
    creating 2–12
  Service Control tool 1–7
  session types defined C–3
  session types supported C–3

Physical service 2–9
physical_session_list configuration property C–3
PicClip images E–26
PM handle code C–5
Print Preview
  default settings 4–28
  overriding 4–28
  setting up 4–27
  using 4–29
print_preview_preference session property 4–27
print_preview_style-sheet session property 4–27
processParams procedure
  Installation User Interface Manager 5–28
Product Maintenance tool 1–3
Profile
code defined 2–29
Control tool 1–7
data
  defining 2–29
  in a session 2–29
  defining user 2–30
  defining users 3–19
  types and session types 2–29
  types defined 2–29
  users 3–18
Progress Dynamics
  application categories 4–22
  application status 4–25
  auditing and comments 4–14
  basic security and management 3–2
  DataServers A–2
    See also DataServers
defining profile data 2–29
  multi-media types 4–20
  profile data 2–29
  sequences 4–2
  user authentication 3–6
Progress Dynamics Configuration Utility.
  See DCU
PROPATH
  batch-mode DCU 5–44
PROPATH setting C–2
Properties
class definition file node C–2
creating session 2–14
  custom configuration C–3
  defining
    for a session type 2–19
  ICFCM_ configuration C–2
  physical_session_list configuration C–3
  run_local configuration C–3
  session B–1
  session_ configuration C–2
  startup_procedure configuration C–2
  valid_os_list configuration C–3

R
Redundant ADO Listings tool 1–5
Registering users
  tasks 3–6
  User Control 3–17
Release
  Version Control tool 1–5
Release versioning
  ADO lists in DCU 5–22
Repository
  deployment 5–3
  starting 2–5
  See also ICFDB.

Reset Data Modified Status tool 1–5

restoreProperties procedure
  Installation User Interface Manager 5–29

Revoke security model 3–4, 3–11

RM handle code C–5

run_local configuration property C–3

S

Save Dynamic Object As Static D–4
  using in AppBuilder D–5
  See also Static-ABL equivalents of dynamic objects

Schema
  holder database A–5

Schema definition (.df) files
  DCU stages 5–10

SchemaLocation attribute E–38

screenScrape procedure
  Installation User Interface Manager 5–29

Script
  batch commands for DCU 5–43
  sample DCU batch commands 5–46

Script file
  batch-mode DCU 5–42

Security
  allocations 3–1
  basic settings 3–3
  cascading information 3–20
  clearing allocations 3–5
  Control Maintenance 3–2
  Control tool 1–5
  defining groups 3–10
  defining model 3–3
  enabling 3–3
  global options 3–2
  grant vs. revoke model 3–4
  groups 3–13, 3–16
  hierarchies 3–10
  linking to login companies 3–16
  Maintenance function, Security Control 1–6
  menu overview 1–5
  override rule 3–11
  turning off 3–3
  user authentication 3–6

SEM handle code C–5

Sequences 4–2
  Control 4–2
  Control tool 1–8
  database version 5–19
  deployment D–2
  Maintenance 4–3

Services
  configuration file node C–3
  defining
    for a session type 2–21
  Type Control tool 1–7
  Type Manager 2–7
  types 2–9

Session
  configuration file node C–2
  configuring 2–8
  creating services 2–9
  Manager 2–7
  menu overview 1–6
  properties 2–2
    alphabetical listing B–1
    creating 2–14
    impact on DCU 5–31
  Property Control tool 1–7
  required managers 2–2
  service 2–9
  service types 2–9
  services 2–2
  Type Control Data tool 1–7
  Type Control tool 1–6
  types
    creating 2–15
    descriptions 2–3
    related to profile types 2–29
    See also Session type

SESSION system handle C–2

Session types
  customizing for DCU 5–33
  defining
    managers 2–18
    properties 2–19
    services 2–21
    inheritance 2–2
    predefined 2–2
  session_configuration properties C–2

SessionType attribute C–2

Set Site Number tool 1–8

Setting users passwords 3–19

Shortcut icon for startup 2–26

Site Data Dump and Load utilities 5–47
  architecture 5–47
  calling from the DCU 5–56
Index

coding processing directions 5–53
default dumpconfig.txt file 5–53
dump program
  customized code 5–50
  writing 5–49
GUI for manual execution 5–55
load program
  customized code 5–52
  writing 5–51
setting up 5–48

Site data file
  batch-mode DCU 5–42

Site-specific data
  batch-mode DCU 5–42
  retaining for DCU updates 5–47

SM handle code C–5

SmartDataField caching E–8

SmartDataObject data and schema optimization E–38

SmartDataObjects
  kept alive on server E–6

Starting Progress Dynamics sessions 2–5
  shortcut icon 2–26

Startup
  cache for toolbars and menus E–28
  parameters
    performance optimization E–3
  startup_procedure configuration property C–2
  StartupCacheClasses session property E–25
  StartupCacheMenusForObjects E–28
  StartupCacheToolbars session property E–28
  startUpgradeProcess procedure
    Installation User Interface Manager 5–29

Static-4GL equivalents of dynamic objects
  4GL Generator
    hook procedure D–10
    Options tab D–9
    Paths tab D–10
    Selection tab D–9
    using in Administration tool D–7
  generated-4GL objects
    APIs for executing D–15
    deployment D–13
    development impact D–14
  execution and file naming D–11
  filename rules D–12
  locating for execution D–12
  minimum files to deploy D–13
  when to deploy D–14
  where to deploy D–13
  generation mechanisms D–4
  using save as static D–5

Static-ABL equivalents of dynamic objects
  comparing ABL Generator with Save As Static D–4

Status
  Control
    window 4–26
  Control tool 1–4
  Maintenance
    window 4–26
    tracking internals 4–25

Stopping databases 2–6

Subgroups
  category 4–22

SuperProcedureMode attribute E–39

System menu overview 1–7

T

Thin SmartObject rendering E–31

TM handle code C–5

Toolbar and Menu Designer tool 1–3

Toolbar caching at startup E–28

Transaction menu overview E–28

Translate Window 4–9

Translation
  Control 4–8
  Control tool 1–3
  entities 4–11
  language 4–4
  Maintenance 4–8
  menus 4–10
  testing 4–13
  user run-time 4–9
  widget labels 4–8

Two-phase commit
  DataServer A–6

Types
  category 4–22
Index

U

Upgrade
  file types 5–20
  programs
    DCU requirements 5–32
Upgrade programs
  attributes 5–33
Upgrades
  DCU end conditions 5–12
  retaining site-specific data 5–47
User
  authentication 3–6
  categories 3–6
  Categories function, Security Control 1–6
    defining 1–6
    linking to security groups 3–16
    profile data 2–29
    profile settings 2–29
    profiles
      defining 2–30
      registering 3–17
      status
        Status application 4–25
Users function, Security Control 1–6

V

valid_os_list configuration property C–3
validateDirectory procedure
  Installation User Interface Manager 5–30
ValidateSiteNumber procedure
  ICFDB Install Manager 5–30
verifyDBVersion procedure
  Installation User Interface Manager 5–30

W

WBC physical sessions C–3
WBS physical sessions C–3
Widget translations 4–8
WM handle code C–5

X

XML
  DCU configuration file 5–13
  DCU driver files 5–14
  DCU files 5–13
  DCU upgrade files 5–20
  minimum XML files 2–25
  Print Preview output 4–27